
CORRECTIONS TO THE OWNER'S MANUAL 

The Owner's Manual is for version 2.0. It does not cover 
version 2.04. However, 2.04 does not alter any of the basic 
operations. When you have learned those operations using this 
manual, then tum to the 2.04 addendum that came with the manual. 

Page 1-3, last paragraph. No Quick Start Guide is included. 

Page 3-29, second paragraph, last line. It should read: 
"following the ►, and click Enter:" The caret in the manual should 
point the opposite direction. The illustration at the right of page 3-29 
shows where your preset text should be entered. 

Page 5-49, the chart showing the logic operators that may be 
used as search criteria. The second listing-

= =ABC Exactly to 'ABC', note spaces 

should read 
= :ABC Exactly equal to 'ABC' Including any spaces 

In other words, "=ABC'' will not match "ABCD" or "AB C." 

Page 2-15, instructions for starting your own C•A•T database. 
Toe "Quick Stan" files ref erred to here are no longer included. (The 
"preset repon fonnats" discussed in the final paragraph are now 
included in C•A•T itself.) Whether you are working from a hard disk 
or a 3.5" disk, follow these instructions: 
1. CIiek the CA• T Icon (shown at the right of page 2-15) to select It. 
2. Pull down the FIie menu and select "Open." 

3. When C•A•T presents a menu of flles to load, click "Cancel." 

Toe final paragraph is still accurate if you begin reading at "Regard." 

Page A-1 (in Appendix A), "Via Excel." Other spreadsheets, 
some of them considerably less expensive than Excel, can be used 
for these operations. A good alternative is MacCalc (from Bravo 
Technologies, sold by Chang Labs). The commands in the Owner's 
Manual are Excel commands. The manual of your spreadsheet will 
tell you what to use instead. 

Page A-4. The error is in the list of fonnulas. The second 
formula should read: 

cell C1 contains: :SEARCH{" ",A1,B1+2) 

BLANK SPACE I 
find the 2nd space 
following the comma 

continued on back 



Page A-5. After the first paragraph, add another paragraph that 
reads: 

"• At the left of the leftmost cell of your first row, insert a 
command telling C•A•T which window to o~n. If the 
row contains account data, the command is { l}. If the 
row contains contact data, the command is { 3}. If you 
have several rows of account-window data, put the { l} 
only in the first row. Same with contact data-if you 
have several rows of it, put the { 3} only in the first 
row." 

Appendix A: Import/Export (in general). If you need more 
instruction for this operation than the manual provides, we have a 
booklet called "Importing Data to C•A•T." It illustrates each step 
and discusses the Excel commands used to reorganized data before 
import. 

Page D-1 (in Appendix D). The command "Run Micro" should 
read "Run Macro." 

Please note our new address and phone number below. The 
numbers listed at the front of the manual are no longer in service. 
We no longer have any toll-free numbers for technical support. ('lbe 
registration card in your manual has our old address, but you do not 
need to correct it-the card will be forwarded.) 

Chang Labs 
3350 Scott Blvd., Bldg. 25 

Santa Clara, California 95054 
(408) 727-8096 
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C•A•T Version 2.04 
Addendum to the Owner's Manual 

Throughout this addendum, instructions are indicated by an arrow •· 

I. Mailing Labels and Envelopes on the LaserWrlter 
It is now possible to print mailing labels and envelopes on Apple 

laserwriters. It has always been possible to print labels on an ImageWriter, 
and the instructions for doing so (found in the Owner's Manual) are un-
changed. Here are instructions for printing on laserwriters. 

Printing Mailing Labels 
You can print on strips of labels or on 8-1/2" by 11" sheets of 

them-whatever will go through your laserwriter. Most stationery stores 
have labels designed for copiers and laser writers. An efficient method is 
to use 8-1/2" by 11" sheets which have 33 labels-three across and 11 high. 
Printing to the Edges of the Sheet-The laserwriter normally will not 
print out to the edges of a sheet of paper. It leaves a margin on all sides of 
3/8 inch. You can narrow this margin-to 1/8 inch at the top and bottom, 
and 1/4 inch at the left and right-as follows: 
• Pull down the "File" menu and select "Page Setup." The LaserWriter 

Page Setup dialog box will appear: 

=L=o s=e=r==W==r=i t==e==r==P==a=g=e==S==e==t==u=p=====================-=-======-==s=.2- [( 0 K l 
Paper: ® US Letter O R4 Letter O Tabloid , · 

O US Legal O 85 Letter [ Cnncel ] 

Reduce or IIIIHJ1'7• Enlarge: 
Orientation 

Ill~ 
Printer Effects: 
t8I Font Substitution? 
t8I TeKt Smoothing7 
t8I Graphics Smoothlng7 
t8I Faster Bitmap Printing7 

(Options] 

[ Help ] 

a+ Click the Options button. The LaserWriter Options dialog box will 
appear (see page 2). 
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=L=a=se=r=W=r=it=e=r=O=p=t=io=n=s===================:s=.2==- K OK J 
·r::: D Flip Horizontal [ Concel ] 

D Flip Uerticol -
D lnuert lmoge 
O Precision Bitmap Alignment (4% reduction) 

..................... 181 Lorger Print Area (Fewer Downloadable Fonts) 
D Unlimited Downloadable Fonts In a Document 

i+ Click "Larger Print Area." Then click "OK." 
i+ You will be returned to the Page Setup dialog box. Click "OK." 
Determining What Is Included on the Labels-Here are the steps: 
• Pull down the "Edit" menu and select "Label Options." The Label 

Options dialog box will open. 
i+ Click whatever in-

formation you 
want to include. 
Then click "OK." 
In order to include 

a country name on your 
labels, it was formerly 
necessary to set one of 
the "Preferences" (on 
the "Edit" menu). That 
is no longer necessary. 
Assigning Fonts, Sizes, 

and Styles for Ad-
dresses 
You can assign 

~ Label Options: Check the 
· · lines to include. 

181 First Last Name/Mall Stop 
□ Title 
181 Recount Nome 
181 Rddress 
181 City, State and Zip 
181 Country 

[( OK )] [ Cancel ) 

one font (in any size and style) for the name, mail stop, and title; another 
font for the account name; and a third font for the street address, city, 
state, Zip, and country. 
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.. Pull down the 
"File" menu and 

~ Set Formot: Select the type 
select "Set For- of reports to format. mat." The Set For-
mat dialog box ( Letters/Notes ) ( Reports ) will appear. .. Click "Travel [ Trouel Size ) [ Full Size ) 
Size." The Report (( Cancel 1 Format dialog box 
will appear (see 
below). 
The type for the name, title, and mail stop are controlled by the 

"Body of Report" setting. The account name (i.e., the company name) is 
controlled by the "Company" setting. The rest of the address (street, city, 
state, Zip code, and country) is controlled by the "Address" setting. 

□ 
181 
[83 

□ 
□ 
[83 

□ 

REPORT FORMRT: Select sections to 
change. Set font, size, style. Click 
SET. Click OK to eHit. 

Report Title 
Compa.ny 
AMnss 

Column Header 
Subtitles 
Body oC Report 
Subtotals 

.Alnount 

5,000.00 
5,000.00 

New York 
Seattle 
Storybook 
Symbol 1111 
Time\ ,·. 
Zapf Dingbats jjjjji 

0 9 □ Bold 
@ 1 o D Italics 
O 12 D Underline 
0 14 D Outline 
0 18 D Shadow 
O 24 D Condense 
QCustom LJ 

K Set } ( Cle or ) ( OK ) Left Margin~ Top Margin~ 
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The illustration on page 3 shows all three of these settings being set to 
IO-point Times. That is a good setting to use. Times is the narrowest font 
in general use, and IO-point type is about as small as you'd want to go. 
Using this combination will squeeze five-line addresses on a one-inch-
high label, and very few lines will be truncated. 
• Click the boxes next to "Company," "Address," and "Body of Re-

port." (Note that the boxes are not exactly opposite those words.) 
• Click on "Times" in the list of fonts. Click the button next to "10." 

Then click "Set." Your screen should now look like the illustration on 
page 3. 
Do not use the margin settings at the bottom of the window. The mar-

gins for labels and envelopes are set in the Print Mailing Labels dialog 
box, discussed below. 

• Click "OK." 
Determining Which Addresses Are Printed-This is unchanged. You 
may print labels for a members of a "view" or labels for listings in the 
Events Snapshot window. 

Labels for a View: 

• Display a view in the Account List window. 
• If you want a person's name on each label, look at the contact list for 

each account. At least one contact at each account should be checked. 
Note--Formerly it was necessary to link one contact to each account. Oth-
erwise no label would be printed. (This is still true with regard to other op-
erations, such as using the "Mail Merge" or "Clone Events" commands.) 
Now it is optional with regard to labels. Even if no contact is check-
marked, a label for each account will be printed. 
• When you use the "Print" command on the "File" menu (see page 5), 

click the option "Labels for View." 
Labels for the Listings in an Events Snapshot: 

• Use the button settings to display a list of events. A label will be 
printed for the contact involved in each event. 
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• When you use the "Print" command on the "File" menu (see below), 
click the option "Labels for Snapshot." 

Printing Out the Labels-The Print Dialog Boxes 
When you have completed the setup steps discussed above-

• Choose "Print" on the "File" menu. This dialog box will appear: 

(:\ Checlc oll reports & options: 

Contacts in Current Uiew: 
D Dossier D RII dossiers option 
D Trouel size Dossier 
D Custom Recount # 1 
D Custom Recount #2 

Euent Snapshot: 
D Colendor 
D Custom Euent # 1 
D Custom Euent #2 
D Letter/memo/note 

D Lookup Uolue List 
D Rctiuity List 

I~[ !!!!!!P!!!!!!ri!!!!!!nt!!!!!!!!!!!!ID 

181 Labels for Uiew 
D Custom Recount #3 
D Custom Recount #4 

D Trouel size Colendor 
D Custom Euent #3 
D Custom Euent #4 
D RII Notes 
D Labels for Snapshot 

(To Screen) ( Cancel ) 

• If you are printing from the Account List window, click "Labels for 
View" (as shown above). If you are printing from the Events Snap-
shot, click "Labels for Snapshot." 

• Click "Print." The laserwriter setup dialog box will appear (see page 
6). 
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LoserWriter "LoserWriter 11 NT" s.2 n OK ) 

Copies:111111 Pages:® RII O From: D To: D [ Cnncel ] 

Couer Page: ® No O First Page O Lost Page [ Help ] 

Poper Source: O Poper Cossette ® Manual Feed 

You may want to select "Manual Feed." If your labels are not on 
8-1/2" by 11" sheets, you should select it. 
• Click the button labeled "Manual Feed." Then click "OK." The Print 

Mailing Labels dialog box will appear. 

~ Print Moiling Labels 
Width Height 
I 2.03 11.00 

Left Margin Top Margin I o.oo 10.00 

Labels Rcross 

13 
( Print ) ( Sort ) ( Cancel ) 

This is where the margins are set. The settings above are correct for a 
sheet of labels 8-1/2" by 11" with 33 labels, three across and 11 high. 
Width is measured from the left edge of one label to the left edge of the 
next label-i.e., the width of a single label plus any space between labels. 
If you use strips of labels with only one label across, this measurement is 
irrelevant. 
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Height is measured from the top edge of a label to the top edge of the 
label below-i.e., the height of a single label plus any space between la-
bels. 
Left Margin is measured from the left of the usable print area, not the left 
edge of the sheet. If you selected a larger print area (see "Printing to the 
Edges of the Sheet" on page 1), and you now enter a left margin of 0.00", 
printing will begin 1/4" from the left edge of the sheet. 

If you are using strips (rather than sheets) of labels, setting the left 
margin takes a little thought. Determine whether your laserwriter has plas-
tic guides for narrow paper or envelopes. If not, then set the left margin as 
indicated above. Then, when you insert strips of labels, insert them at the 
left side of the paper-feed slot. 

If your laserwriter has plastic guides (so that narrow strips are insert-
ed in the middle of the paper-feed slot), calculate the left margin using this 
formula: 

Left margin = 8.5 - Label width 
2 

The label width should be the exact width of the label, not including any 
margin between the edge of the label and the edge of the strip. If your la-
bels are 3.5" wide (a standard width for pin-feed strips), then the left mar-
gin setting should be 2.5" (8.5 - 3.5 = 5.0 I 2 = 2.5). 

Top Margin is measured from the top of the usable print area, not the top 
edge of the sheet. If you selected a larger print area (see "Printing to the 
Edges of the Sheet" on page 1), and you now enter a top margin of 0.00", 
printing will begin 1/8" from the top edge of the sheet. 

Labels Across is the number across the sheet. The maximum is 99. 

• Enter the dimensions of your sheet (or strip) of labels. If you are just 
experimenting, enter the dimensions in the illustration on page 6. 

Sorting Labels Alphabetically, by Zip, Etc.-This is a new feature. It is 
available only if you are printing from the Account List window. If you 
print from the Events Snapshot, the Sort button will not be available. Your 
labels will print out in the chronological order of the events. 

• Click the "Sort" button. The Sort dialog box will open (see page 8). 
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To sort by account is to arrange the la-
bels in alphabetical order according to ac-
count name. To sort by city, state, or alias is 
also to arrange the labels alphabetically ac-
cording to those items. To sort by Zip Code 
is to arrange the labels numerically, in Zip 
Code order. 
• Click one of the sorting buttons. Then 

click "OK." 
• You will be returned to the Print Mail-

ing Labels dialog box. Click "Print." 

SORT BY: 
® Recount 
QCity 
O State 
0Zlp 
0 Rlios 

( OK D [ Cancel ) 

• If you clicked "Manual Feed" above (page 6), go to the laserwriter 
and insert a sheet or strip of labels. Use the plastic feeding guides, if 
present. Otherwise, insert the labels at the left side of the feed slot. 

Hints on Saving Labels-(1) Until you become familiar with these steps, 
print out the first page of addresses on paper. Then hold that paper up to a 
sheet of labels and observe whether the two match. This method saves a 
lot of labels. 

(2) After a while, you'll find that you have partial sheets of labels left 
over. Using the margin settings (page 6), you can use these partial sheets. 
For example, say that you have labels l" high, and you've used the top 
four rows. Enter a top margin of 4.00". Printing will begin down 4-1/8" 
(4.00" plus the 1/8" unusable margin), or with the fifth row of labels. 
If Your Addresses Don't Fit on Your Labels-If the lines of your ad-
dresses are too long, enter a smaller type size or different font (see pages 
2-4). If your addresses have too many lines, you can try to remedy this 
with a smaller font or size. But you may have to include fewer options 
(see page 2)-e.g., omit the title, or even the account name. 

Printing Addresses on Envelopes 
The procedures just discussed apply to envelopes as well. This sec-

tion will briefly restate those procedures, focusing on the differences from 
the label procedures. 
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Page Setup-When we printed mailing labels, we used the Page Setup 
command to enlarge the print area. That is not necessary with envelopes. 
However, we still want to use that command: 
• Pull down the "File" menu and select "Page Setup." The LaserWriter 

Page Setup dialog box will appear. 
The dialog box is illustrated on page 1. Note, in the lower left corner, 

the word "Orientation" above two icons. 
• Click the icon on the right. The lines of printing 

will now be parallel to the direction of the paper as 
it passes through the laserwriter. 

• Click "OK." 

Orientation ruma 
• Pull down the "Edit" menu and select "Label Options." When a dia-

log box appears, click next to the information you want to include. 
Then click "OK." 

It If you want to change the type font or size, pull down the "File" menu 
and select "Set Format." When a dialog box appears, click "Travel 
Size." When the Report Format dialog box appears, make any 
changes you wish; then click "Set"; then click "OK." 

* Display a view in the Account List window (or a list of events in the 
Events Snapshot window). 

• Pull down the "File" menu and select "Print." When a dialog box ap-
pears, click to select "Labels for View" (or "Labels for Snapshot"). 
Click "Print." 

• When the laserwriter setup dialog box appears, click the button for 
"Manual Feed." Then click "OK." The Print Mailing Labels dialog 
box will open (see page 10). 
The Width setting is not important for envelopes. It could be 0.00" or 

21.00". 

The Height setting is slightly more important. The exact value doesn't 
matter so long as it is over 3.3". (With values under 3.3" you may get a 
second address printed at the bottom of your envelope.) 
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~ Print Mailing Labels 

Width Height 
j 11.00 la.oo 
Left Margin Top Margin 

, 4.00 ,4.00 

Labels Across 

I • 
( Print ) ( Sort ) ( Cancel ) 

The Left Margin setting should probably be 4.00". This is the dis-
tance between the left edge of the envelope and the left edge of the ad-
dress. In a way, this is the envelope's "left margin." The margin will 
actually be slightly larger-either by 1/4" or 1/8" (as discussed on page 1). 

Here's how to calculate the Top Margin setting. The manual paper 
feed slot on laserwriters is 8-1/2" wide. You will insert envelopes left edge 
first into this slot-therefore, the top of the envelope will be toward the 
right of the feed slot. The Top Margin setting will determine the distance 
between the right hand side of that slot and the top of the address. 

Many laserwriters, particularly older models, have no plastic guides 
for envelopes (or other narrow paper). In this case, envelopes should be in-
serted at the right side of the feed slot. The Top Margin setting will simply 
be the distance between the top edge of the envelope and the top of the ad-
dress-probably 2.00". 

If, however, your laserwriter has sliding plastic guides, the setting 
should be about 4.00", as shown above. Here's why: When the guides are 
adjusted for envelopes, they are close to the center of the feed slot. When 
you feed an envelope into the laserwriter, the top edge of the envelope is 
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about two inches from the right edge of the feed slot. The setting of four 
inches consists of those two inches (to reach the edge of the envelope) 
plus two more inches (to place the address in the center of the envelope). 

It is less expensive to experiment with plain paper. 
a+ If your laserwriter has plastic manual-feed guides, enter the settings 

shown on page 9. If your laserwriter has no such guides, still enter the 
settings on page 9, except enter a Top Margin setting of 2.00". 
Just as with mailing labels, you can sort the order in which addresses 

print out-but only if you are printing from the Account List window. 
(See page 7, "Sorting Labels .... ") 
a+ Click "OK." 
a+ Go to the laserwriter and begin inserting envelopes using the manual 

feed slot. Allow two or three seconds between envelopes. 

General Computer's Personal Printer 
This printer is now supported by C•A•T. 
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II. Expanded Autodial Compatibility 

Setting Up for Autodial 
C•A•T is now compatible with many more modems and with the 

AT&T 7403-D, 7405-D, 7406-D, 7407-D voice terminals. A new dialog 
box has been added for modem settings. 
• Display any account in the Account window (or any contact in the 

Contact window, or any event in the Event window). 
• Pull down the "Action" 

menu and select "Dial." 
The first Dial dialog box 
will appear: 

• Click "Option." Another 
dialog box will appear (see 
below). 
As before, you 

enter your own local 

~ Dial: 
~ 915-245-2548 

[( Dial l ( Option ) ( Cancel ) 

Dial Options: area code in the top 
box. Later, when you 
dial a number, C•A•T 
notes whether the 
number begins with 
the local area code. If 
so, C•A•T will omit it. 

Local Area Code: 408 

The next box is 
for any preamble re-
quired to get an out-
side line. The comma 
represents a 2-second 

Diol for outside line: 9, --------1 
Long distance: 9, 1---------~ 

O Speaker (tone dialing) 
@ Modem (tone dialing) 
O Modem (pulse dialing) 

!#( !!!!!O!!!!!K~D ( Mod em ] (..-c-o-n c-e---1) 

pause. The bottom box is for any preamble required to place a long-dis-
tance call. It should begin with the preamble to get an outside line. 

Below the preamble entry boxes is a column of buttons. These are the 
three dialing options. The "Speaker (tone dialing)" option uses the Macin-
tosh to generate audible tones recognized by some telephones. The 
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"Modem (tone dialing)" and "Modem (pulse dialing)" are for use with 
modems. 
Determining Whether You Can Use Speaker Autodial-The audible 
tones generated by speaker autodial are recognized by analog telephones. 
Typically these phones are used in small businesses or homes. They are 
not used in larger companies that have digital PBX systems. 

You can test compatibility of your phone with speaker autodial by 
holding the mouthpiece of the phone next to the Macintosh speaker. Then 
display a phone number, as detailed above; select "Dial" from the "Ac-
tion" menu; and click "Dial." If the phone responds (i.e., if the dial tone 
stops), then you can buy an inexpensive product, such as Hyper Dialer, 
which connects the speaker jack on the back of your Macintosh to your 
phone. (In effect, the Hyper Dialer is a remote speaker that moves the au-
dible signals closer to the mouthpiece of your phone.) 
Modem Settings-Check your phone system (not your modem) to find 
out which setting is appropriate, pulse or tone. 
• Click either the "Modem (tone dialing)" or "Modem (pulse dialing). 

Then click the button labeled "Modem." The Modem Options dialog 
box will appear: 
Formerly the 

preamble was preset to 
work with Hayes (or 
Hayes-compatible) 
modems. Now you can 
set the preamble to 
work with other 
modems or phone sys-
tems that support digi-
tal terminal equipment 
(DTE). Check the 
owner's manual for 
your modem and/or 
phone system to learn 

Modem Options: 
.--------, 

Diol Preomble: RTSO=ODT 
Dial Preamble/Pulse: RTSO•ODP 
Dial Postamble: ; 

® 1200 Baud 
0 2400 Baud 
O 9600 Boud 

fi~( !!!!!!!!OK~)] ( Cancel ) 

the protocols necessary for autodialing. 
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Preamble--This instructs the modem or phone system to prepare for dial-
ing. Once the preamble is complete, C•A•T will use the dialing sequences 
entered earlier (see the Dial Options dialog box on page 12) to find an out-
side line and dial the number. Then comes the-
Postamble--This is the sequence needed to relinquish control of the 
phone system. (Additional information on pre- and postambles is found 
below.) 
a+ If you have a tone phone system, use the box labeled "Preamble." If 

you have a pulse phone system, use the box labeled 
"Preamble/Pulse." Enter the correct preamble for your modem/phone 
system. 

a+ Use the box labeled "Postamble" to enter the correct postamble for 
your modem/phone system. 

a+ Set the appropriate baud rate for your rnodem-1200, 2400, or 9600. 
a+ Click "OK." 

Miscellaneous Modem Notes 
• C•A•T is preset for no parity. 
• C•A•T will work without change with Hayes (and Hayes-compatible) 

modems. It may be necessary to preset certain modem switches so 
that dialing works properly. 

• Hayes moderns accept the , (comma) character, which sends a two-
second delay during dialing. They also accept the P and T characters 
for mixed mode dialing. These characters may be inserted in the pre-
fix for accessing outside and long-distance lines. 

• Hyphens, parentheses, and spaces may be used within numbers. They 
are ignored when dialing. 

• For most AT&T phone systems, replace both the preamble and the 
postamble with the BREAK character (entered by typing Control L). 
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Ill. Other Enhancements 

International Features 
Several non-English language versions of C•A•T have been created. 

They allow a variety of formats for addresses, monetary amounts, dates, 
and time. Most of these features, however, depend on using the Apple sys-
tem files specific to particular countries. If you do business extensively 
with France, Italy, or the United Kingdom, call Chang Labs and ask for 
details about these special versions of C•A•T. 

Two international features are available to users of the standard En-
glish-language C•A•T-calculating without a dollar sign, and including 
European characters in account or contact names. 

Calculating Not in Dollars 
As it always has, C•A•T performs calculations entered in the Event 

window. For example, if you type "3@$4.50-10%" in the notes area of an 
Event window, C•A•T will understand that you mean "3 items at $4.50 
minus 10%." If you then click the Calculation button, the result ($12.15) 
will be displayed: 

-►~lt•~m~s~◄:111'1~!.---------Calculation !eiiiGl#i•Of■k·.j◄ 
►Shipping ◄ Calculation buuon 

Result of calculation 

(ENTER) 

(CLEAR) 

Formerly this function worked only if the calculation included a dol-
lar sign ($), as shown above. Now the function will operate if-

• the calculation includes a dollar sign ($); or 
• the calculation includes a pound sign (£), entered by holding 
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down the Option key and then typing "3"; or 
• the calculation is preceeded by an equal sign(=). 

Sorting Names With International Characters 
You may include international characters in contact or account 

names, for instance: "Milller A.G." or "Comedie-Fran~aise." C•A•T ig-
nores all inflection marks when alphabetizing. For example, e, e, and e are 
treated as if they were the same. 

Using an Alias to Search for a Contact Name 
Let's assume you have a contact named Joseph Argyle, and his alias 

is "Whizzer." Formerly, when using the heavily outlined search boxes (at 
the top of the Contact window or the top of the Event window), you could 
search for a contact name using the first or last name. 

In other words, to search for Mr. Argyle, you had to type either "Ar-
gyle, Joseph" or "Joseph Argyle." Now C•A•T lets you also use the alias 
in place of the first name. You can search for Mr. Argyle by typing any of 
the following: 

• Argyle, Joseph 
• Joseph Argyle 
• Argyle, Whizzer 
• Whizzer Argyle 

Event Lists Now Include Preset Text 
Now, when you print event lists, each event will include both the pre-

set text and the text unique to that event. Form letters will print out in their 
entirety, and questionnaires will include the questions (preset text) as well 
as the answers (unique to each event). 

Automatic Backup (Partial) 
C•A•T can be used with multifinder. However, experience has shown 

that occasionally multifinder will give you an "UNEXPECTED QUIT" mes-
sage. When this occurs, it not only loses what you 're working on, it also 
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kills one of the two disk files containing your database. The one it destroys 
is the one without the -NOTES suffix. Therefore, every time you save your 
database, C•A•T now automatically creates a backup only of the file in 
jeopardy. If such a crash occurs, you will lose any work done since the last 
save; but you will not lose your most of your database. 

This is not the same as backing up your entire database. To back up 
the entire database, you should also create a backup of the -NOTES file as 
well. 
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Why you should send in your 
registration card today 

1st 
CHANGLABSPRODUCTSUPPORTPROGRAM 
At Chang Labs, support is as important to us as a great product, and we're 
committed to providing a high level of customer service and technical support for our 
registered users. We want you to get the most from C•A•T, and we would like to help 
you. 

If you should have a technical question or a problem, we strongly suggest that you 
consult your manual first. Our experience has shown that it usually contains the 
answers to most of your questions. If you still need assistance, call our Technical 
Support Department from 8:00 A.M. to 5:00 P.M., Pacific Time, Monday through 
Friday (excepting national holidays). The telephone number is (408) 727-8096. 
Please remember to have your Customer I.D. number handy when you call. We will 
send you that number when we receive your registration card. 

The first 90 days of support are free, as long as you are a registered user. To receive 
support after that, you can purchase our Extended Support Policy (see the back of 
this card). 

2nd 
C•A•T PRODUCT UPGRADE PROGRAM 
We're always working to improve our software and to protect your software 
investment. The only way to be certain of learning about upgrades is to return your 
registration card. These notices will give the price of the update, a list of 
enhancements, and ordering instructions. 
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Extended Support Policy 

Use this card to order Extended Support. You can order now and we'll start the policy 
at the end of the first 90 days of free support. Or you can save this card and wait until 
the 90 days is over. We'll send you a notice at that time. 

For the annual fee of $75, you will receive: 

• Technical Assistance on all Chang Labs products, even programs you purchase 
after the policy is in effect. 

• Telephone access to a C•A•T technical expert for one year, for answers to your 
questions. 

• A discount on the replacement cost if your C•A•T master disk is accidentally 
damaged during the 12 months. You pay just a $15 handling charge. 

• 50% off the cost of new versions as they are released. 

Name __________________________ _ 

Company _________________________ _ 

Address. _________________________ _ 

City ________________ State ____ Zip ___ _ 

Method of Payment: 0 Visa O Mastercard O Check (payable to Chang Labs) 
Card number ______________ Expiration Date ____ _ 

Name on card (if different) ___________________ _ 

Authorizing signature _____________________ _ 

Note: Site Licenses for C•A•T are available. 
Call (408) 727-8096 for more information. 



Registration Card 

Please complete and return this card before 
using your new product. You can obtain 
telephone technical support only after 
sending in your registration card. Serial Number 

(from label of the C•A•T Program Disk) 
Please print or type 

Name Title ----------------- ----------
Company name ________________________ _ 

Address __________________________ _ 

City _________________ State _____ Zip ___ _ 

Telephone _________ _ 

Date of Purchase / / ___ Purchased from -~-~ -----------
City ________________ State ____ Zip ___ _ 

Number of employees in your company ____ _ 

How many Macintoshes in your location? _____ in your company? ___ _ 

How many other PC's in your location? _____ in your company? ____ _ 

What general category covers your job (sales, marketing, legal, etc.)? _____ _ 

What sort of work do you actually do? ________________ _ 

How did you learn about C•A•T (store, friend, review, ad, etc.)? _______ _ 

If you learned about C•A•T from an ad, where and when did it appear? ____ _ 

What feature(s) persuaded you to try C•A•T? _____________ _ 

What improvement/problem do you hope to achieve/solve by using C•A•T? __ _ 
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Comments: _______________________ _ 

Fold on dotted line and secure with TAPE ONLY. ------------------1Tnr-- NNE~:~::~~F 
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End User License Agreement 

NOTICE: CHANG LABS PROGRAMS (LICENSED PROGRAMS) ARE 
SOLD ON THE CONDITION THAT THE END USER AGREES TO THE 
FOLLOWING: 

1. This product, both in printed and program form, is protected by 
United States and worldwide copyrights. 

2. Each program license granted under this Agreement authorizes the 
End User to use the Licensed Program in any machine readable form 
on any single computer system. A separate license is required for 
each System on which Licensed Program will be used. 

3. End User may make copies of the Licensed Program for backup 
purposes for designated system only. There shall be no more than 
five (5) backup copies in existence under any license at any one time 
without prior written consent from Chang Labs. Any further 
copying is illegal. 

4. When End User receives this product from supplier, the purchase 
acts as a license to use the Licensed Program. The Licensed 
Program shall remain the property of Chang Labs. This license may 
be revoked by Chang Labs at any time if End User is found to be in 
breach of the copyright laws, any other statutes pertaining to 
software use, or any part of this agreement. 

5. Chang Labs makes no warranties with respect to the Licensed 
Program in the performance or accuracy of data of any kind; nor for 
resulting consequential damages, whether through loss or inaccuracy 
of data of any kind; nor for any consequential damages resulting 
even if Chang Labs has been advised of the possibility of such 
damages. 

6. Chang Labs may, from time to time, revise the performance of its 
products and, in so doing, incur no obligation to furnish such 
revisions to End User. (No update, customer service, or newsletter 
distribution can be provided unless the enclosed Owner Registration 
Card is on file at Chang Labs.) 

7. End Users should obtain customer service from the dealer or 
supplier. It is Chang Labs' customary practice to provide reasonable 
assistance and support in the use of products to its customers when 
the question or problem cannot be resolved by the dealer. 
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Before You Begin 
Welcome to C.A. T., the relational database for managing your 
Contacts, Activities, and Time. 

This chapter provides: 

• A checklist of system requirements. 
• Instructions on how to make a working copy of C.A.T. 
• Instructions on how to install C.A.T. on a hard disk. 
• Instructions on how to make a backup copy of your data. 
• An overview of the manual. 

C.A.T. supports the Macintosh 512E, Plus, SE, and II. The mini-
mum system requirements for using C.A.T. are: 

• Two SOOK drives or a hard disk. 

• Any model of the Image Writer or LaserWriter printers; an 
ImageWriter is required to print mailing labels. 

What You Need 

Before you begin to use C.A.T., make a working copy of the Master Working Copy 
disk. Never work with a Master disk. If your working disk is ever 
damaged, you will have the Master to make another copy. Follow 
the instructions below for your system configuration. 

It is recommended that you set up a working disk that contains both BOOK Drives 
the program and data files. 

• Initialize two blank disks and name the disk icons "C.A. T. 
Work" and "C.A.T. Data Backup." 

• Eject the disks and label them. Write the version and serial 
numbers of the Master disk on your C.A. T. Work disk label. 

• Write-protect and insert the Master disk in the internal drive. 

• Insert the C.A.T. Work disk. 

• Drag all icons from the Master disk to the C.A.T. Work disk. 

• When the copy is complete, store the Master in a safe place. 

Once you set up your own C.A.T. files, you can remove the tutori-
al's Sample files to free up space. 



Hard Disk Setup C.A. T. is not copy-protected and may be used on a hard disk with-
out a key disk. It is recommended that you make an extra copy of 
the program for backup use. 

Backing Up 

• Start up your hard disk as usual. Create a folder to store your 
C.A.T. files. 

• Initialize two blank disks and name the disk icons "C.A. T. 
Program" and "C.A.T. Data Backup." 

• Eject the disks and label them. Write the version and serial 
numbers of the Master disk on the C.A. T. Program disk label. 

• Write-protect and insert the Master disk in the drive. 

• Drag all of the files except the System Folder from the Master 
disk to the hard disk. 

• When the copy is complete, C.A. T. will be installed. Eject the 
Master disk and store it in a safe place. 

• To make a backup copy of the program, insert the C.A.T. 
Program disk and drag the following files from the hard 
disk to the Program disk: C.A.T., Sample C.A.T., and 
Sample C.A.T.-NOTES. 

The Importance of backing up your data cannot be overemphasized. 
The larger the file, the greater the loss If anything should happen to 
corrupt your disk and/or data. Make a habit of backing up regularly, 
perhaps at the end of each day. 

When you finish a C.A. T. session, save your data on disk or on your 
hard disk. Then exit the program and return to the Finder. Next, 
follow the instructions given below to back up your data. 

BOOK Drives • Your C.A.T. Work disk is in your internal drive. 
• Insert your C.A.T. Data Backup disk in the external drive. 
• Drag your C.A.T. Data and C.A.T. Data-NOTES files from the 

C.A.T. Work disk to the C.A.T. Data Backup disk. 
• Once the copy is complete, store the C.A. T. Data Backup disk in 

a safe place. 

Hard Disk • Insert your C.A. T. Data Backup disk. 
• Drag your C.A.T. Data and C.A.T. Data-NOTES files from the 

hard disk to the C.A.T. Data Backup disk. 
• Once the copy is complete, store the C.A.T. Data Backup disk in 

a safe place. 
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In chapter 2. "Leaming C.A.T .• " you learn the basic C.A.T. opera- About this Manual 
tions. You will learn how to load C.A. T., enter data, select and link 
records. use C.A.T. windows, save data, and exit C.A. T. 

Chapter 3, "Using C.A.T.," explains C.A.T.'s advanced operations, 
step-by-step. and including examples. 

Chapter 4 ~s a reference on "Printing Reports." It includes a thor-
ough discussion of all printing options and shows examples. Tips 
on printing problems are also provided. 

Chapter Sis the "Command Reference" which gives a complete 
description of the every command in each of the main menus. 

And there are five appendices: 

• Appendix A explains how to import and export data. C.A. T. 
supports data transfer from C.A.T. to C.A.T. and from C.A.T. to 
other applications such as spreadsheets and word processors. 

• Appendix B lists all of the references available for preset text. 

• Appendix C describes how to print your own logo on reports. 

• Appendix D lists all keyboard commands (for people who prefer 
using the keyboard to using the mouse). 

• Appendix E explains managing C.A.T. files on multiple disks. 

At the end of the manual, there is a glossary of terms and a com-
plete index to help you find the information you need quickly. The 
table of contents is also a good source to locate information quickly. 

If C.A.T. is the first database that you have encountered, start with Where to Begin 
Chapter 2 and use the rest of the manual as a reference manual. 

If you are a knowledgeable database user, start with the Quick Start 
Guide and use this Owner's Manual as your reference. 
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This chapter has three sections: 

• "The Joy of Managing" explains the relational power of C.A. T. If 
you are intrigued by technology and how it helps you to work 
faster and with less restrictions, read this section. If you just want 
to get started, then skip this section. 

• "Quick Clicks Tutorial" is a guided tour through the basic fea-
tures of C.A. T. using the Sample C.A. T. file. 

• "Entering Data" shows you a step-by-step guide for entering 
your data into C.A.T. 



The Joy of Man-aging 
"In six months, I have collected 1,500 names. as well as 2,500 let-
ters, contracts, agreements. and other data -- all of them in C.A.T. 
And I can retrieve any pertinent data in two seconds with a few 
clicks of the mouse. My business life has changed. 

"Writing letters is a snap (or more accurately. a click). 

"Managing a seminar, a committee, a fund-raiser, or an asso-
ciation has become a trivial pursuit. 

"Projects requiring coordination among 10 or 20 people are sim-
ple. I can send data to a spreadsheet or to an associate as easily as 
saying 'do it.'" 

This is what you'll be saying sooner than you think. C.A.T. releases 
the power of relational databases. C.A.T. manages contacts (the 
thousands of people you meet in any year). activities (the hundreds 
of projects you do per year). and time (time for golf, that is). 

Traditional databases and spreadsheets restrict the data you save --
to one sheet of paper per contact. C.A.T. uses relational technology 
to let you link unlimited sheets of paper to every contact. That's 
like having a folder with unlimited capacity for every contact. The 
sheets may be simple notes, appointments, or facts, or substantive 
items such as quotes, letters, invoices, contracts, and agreements --
virtually any data. 

Because C.A.T. is relational, there is no redundancy of data. 
Common addresses, letters, titles, or notes are entered once and 
only once. For example, when you update an address, it is correct-
ed for all items in your file. Relational databases: 

• Save time on data entry, 
• Give you more space for more data, 
• Provide unlimited capacity for data per contact, and 
• Get your work done faster. 

C.A.T. is Relational 

And C.A.T. has proprietary technology to make it fast. A "triple C.A. T. Is Fast 
helix" of links lets you search through even 10,000 records in a few 
seconds. 

After 50 names. you might not notice the difference. But in busi-
ness. our circle of contacts grow naturally. In time, you'll wonder 

,how people can function without C.A.T. and a computer. 
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Relational Records C.A.T. tracks four kinds of records in one database. They are the 
account, contact, event, and activity records. 

Information is hot-linked between records. When you need the 
address of a contact for a letter, C.A.T. gets it, instantly. When you 
change the address, the address is changed on the letter and every-
where else in the database, as well. 

Windows for Records C.A. T. uses a pair of windows to manage each record type -- one 
window shows lists of records and the other allows entry of records 
of that type. 

All windows can be on screen and open at the same time. Similar 
to the Finder, when you close a window, C.A.T. does not close 
down the document. A closed window simply means that you want 
to hide a window from the screen. 

Like pieces of paper on your desk, feel free to open a window (pull 
out a piece of paper), close a window (put a piece of paper away) , 
or manage lots of open windows on screen (a pile of projects on 
your desktop) to suit your own preference. Experience from 
C.A.T. users show that people adjust to the power of working with 
multiple windows -- easily. 

Nonsequentlal And C.A. T. is nonsequential. Because a typical C.A. T. database 
manages multiple projects at the same time, it is difficult to show 
one sequence for using C.A.T. In the sections below, we help you 
to understand the various ways to work with C.A.T.; but your pat-
tern of use depends on the things you need to do on a particular day. 

Relational databases are far more powerful than traditional data-
bases. C.A.T. finally makes that power accessible without pro-
gramming. Read on to see how. 
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Quick Clicks Tutorial 

In this section, we will show you how to: 

• Start and exit C.A.T.; 
• Work with C.A. T. windows; and 
• Click your way through the "Sample C.A.T." file. 

Throughout this section, you will see one or more boldfaced sen-
tences that begin with the symbol t:,,.. The symbol marks an action 
for you to perform. Follow any numbered boldfaced steps in order. 

To get C.A. T. up and running, do the following: 

t:,,. Start C.A. T. 

If you are starting C.A.T. from a hard disk: 

1. CIiek the C.A. T. Icon In the Finder to select It. 
2. Choose Open from the FIie menu. 
3. When C.A. T. presents the choice of files to load, double-click 

the "Sample C.A.T." filename. 

Or double-click the "Sample C.A.T." data icon to open it. 

If you are using C.A. T. with one 800K disk drive. 

1. Insert and open your C.A.T. Work disk. 
2. Double-click the "Sample C.A.T." Icon. 

Quick Clicks Tutorial 

Hard Disk 

BOOK Disk Disk 
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ExltC.A.T. 

C.A.T. Records 

Account Activity 

- Contact 

= Event 

2-4 

To exit C.A. T. at any time, choose Quit from the File menu. The 
Quit command will let you choose whether you wish to save any 
changes you have entered. You should not quit any program by 
simply turning off the computer. 

C.A. T. stores information in four types of records that are linked 
together: 

• Account records are used to track names, addresses, and phone 
numbers for either companies or individuals. Accounts can be 
referred to by account name or by an alias that could be a num-
ber. 

• Contact records are used to track names, titles, and other infor-
mation for individuals within accounts. Contacts are linked to 
an account so that the address, phone, and other information do 
not need to be reentered. There is no limit to the number of con-
tacts that can be linked to an account. 

• Activity records are used to track any subject matter. For exam-
ple, you could use C.A.T. to log phone calls, send letters, sched-
ule meetings, remember birthdays, track orders, or manage pro-
jects. For each subject, you create an Activity record to track all 
the events associated with this activity. There is virtually no 
limit to the number of activities you create. 

(In technical terms, activity records are field names in tradition-
al databases. Because C.A.T. is relational, activities have many 
more features than traditional fields.) 

• Event records are used to track your specific interaction with 
your contacts, by activity, at a particular time. Events are linked 
to a contact and activity and automatically time-stamped. For 
example, when a customer places an order, you log the order as 
an event record. You link the event to the customer's name and 
identify the type of order as an activity. You can track unlimited 
orders from a customer, letters sent to that customer, or any 
other information associated with a contact. 

(In technical terms, events are field values in traditional 
databases.) 

In the tutorial below, you will click through the record types and 
work with the C.A.T. structure using typical data. 
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C.A.T. uses windows to manage each type of record. C.A.T. has 
two kinds of windows: 

• List windows are used to look up or view information. 

• Entry windows are used to enter and view individual records. 
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The table to the right summarizes the names of the primary win-
dows in C.A. T. 

Quick Clicks Tutorial 

Window Types 

Entry List 
Window Window 

Account Account List 
Contact Contact List 
Event Events Snapshot 
Activity Activity List 
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C.A. T. Buttons In C.A.T. windows, you see normal Macintosh graphics such as 
scroll bars, close box, title bar, sizing boxes, radio buttons, check 
boxes, and command buttons. I/you are not familiar with any of 
these terms, please consult your Macintosh Owner's Manual. 

Clicks & Double-Clicks 

Searching 

In addition, C.A.T. defines two new graphics. They are: 

Next button 

Goto arrow 

Show the next or prior record. 

Single-click to go to the List window. 
Double-click to go to the Entry window. 

When you select a record from a list window, the first click 
"selects" and highlights the record. A second single click on the 
highlighted record causes C.A.T. to zoom to the next logical level. 
And a double-click on the highlighted record causes C.A. T. to open 
the entry window for that record. You can experiment with these 
conventions as you work with the tutorial. 

C.A.T. provides many ways to find information. One way is to type 
the name or alias of an account and let C.A.T. search for it. To do 
this: 

tJ. Choose New Account from the Enter menu. 

C.A.T. shows the Account window. 

LJ flllOUIII 

~ I -
Conuot: 

II 
Co~1111: 
Addr.ss: 

Cttlj/St/Zlp: I I 
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( ENTER ) ( CLEAR ) ( DELm ) ( Codes> ) 
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The heavily outlined box at the top is a "clairvoyant" field used to 
search for information by typing the names of accounts, contacts, or 
other data. It is clairvoyant because it gives you the name you're 
searching for before you type all of it. Clairvoyant search is active 
throughout C.A. T. 

!J. CIiek the bold outllned box at the top to activate the data cursor. 

!J. Press any letter on the keyboard. 

As you type a letter, C.A.T. presents possible results of the search. 
If the record you want is not shown, continue typing its name. 

t:. Close the Account window by clicking the close box on the 
upper left. 

C.A. T. supplies many other ways to find information besides 
searching by typing the record name. You can work with lists and 
sublists by pointing and clicking with the mouse. 

In the window below, C.A.T. shows an alphabetized list of 53 
accounts. You can point and click on the name of the account to 
select an account. Each time you click, C.A. T. highlights your 
selection. 

t:. For example, cllck on "Damian Enterprises". 

Recount List 
C.A.T ... 11\1 Chllllt L* \12.0 

DOD Worlc/Ulew/Prlorlty 

!SanJoH 
!S.n Jon 

tan 

Quick Clicks Tutorial 

Account Lists 

Highlighting Records 
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Views When your list of names gets long, you can group specific accounts 
into views and display only the accounts in that view. For example, 
you might create views to show all "vendors" or for all "press" con-
tacts. 

One way to create views is to click to checkmark an account. In the 
Account List window, there are three columns on the left. 

W Work view This view shows all changes made to your database 
since you last saved to disk. 

V View (i.e. the current view.) There are 13 saved views -- each 
with a different name. 

P Priority view This view is used to note accounts that may be 
more important than others in the current view. 

Note that some of the accounts are already checked(✓). 

Check Views fl. To add an account to the view, point to the V column of an 
account, and click. For example, checkmark "Brodie." 

CR Recount Leads 
Company Employees 
Personal 
Project H 
Seminar lnuitations 
8 
g 
10 
11 
12 
13 

C.A.T. places a checkmark on that account. 

fl. To remove an account from a view, point to the V column of 
a checkmarked account and click. For example, uncheck 
"Franklin Power & Light." 

C.A.T. removes the checkmark on that account. 

fl. To see Just the accounts In a view, select a view name from the 
Views menu. For example, select the ''National Accounts" view. 
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Ult tfie,Viewt menu to select other views of accounts. Each time, 
C.A.T. shows the accounts for that view, instantly. 

You can also create views using the Make View command. It 
sem:cbes using criteria such as account name, city, state, or zip 
code. Or you can use the Merge Views command that combines 
multiple views using add, remove, intersect, or set operations. (See 
chapter 3.) · 

Contacts are linked to accounts. The Contact List window shows 
all contacts for the current accounL 

A ChooN Contact List from the Show menu. 

Enter lbou, lctlon UIOIIII 

Contact Lists 

---- Click here to activate the Account 

The window above shows all the contacts for the last account you 
selected. 

You can select which account is displayed in the Contact List using 
three different methods: 

A Select the account by pointing to and cllcklng on the account 
name In the Account List window. For example: 

1. Activate the Account List window by cllcklng on any part of 
the Account List window that stlll shows on screen. 

2. CIiek to select a different accounL 
3. CIiek a second time on the hlghllghted account name and 

C.A.T. zooms to show all contacts for this account. 

A Select the account by cllcklng the next button at the top of the 
Contact List window. With each cllck, C.A.T. shows the next 
account from the current view. 

Quick Clicks Tutorial 

List window. 

Search by Clicking 

Click the top half to see the prior account. 

~ ~ i Eaton, Inc. _ ............................ ~ 
San Jose, CA 95239 
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Clairvoyant Search l!J. Search for an account by typing Its name In the clairvoyant field 
of the Account window. 

1. Double-click the Goto arrow on the Contact List. 
2. Search for the account. 
3. Close the Account window. 

Note that the Contact List has columns on the left so that you can 
include contacts in the Work, current, and Priority views. 

Event Lists Events must be linked to a contact. The Events Snapshot window is 
used to show all events associated with a particular contact. 

l!J. From the Contact List, click once to highlight a contact name. 

l!J. Cilek again on the highlighted name to zoom to the Events 
Snapshot window. 

l!J. Cilek the All Time radio button on the upper right. 

C.A. T. shows all events that are linked to this contact . 

• ~~.,,,,.;-~gc; 
C6ck these radio buttons to change options. 

ortc o-Do Prtorttg 
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l!J. To see all events linked to this account, click the radio button to 
the left of the account name. 

l!J. To see all events linked to all accounts In the cu"ent view, click 
the radio button next to the word ''View." 
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Tcfselect a specific account for the Events Snapshot window, C.A.T. 
offers the same three alternatives. They are: 

• Click the Next button to see the next account for the current view. 
• Select by highlighting an account on Account List, then reacti-

vate the Events Snapshot window. 
• Go to the Account window and search using the clairvoyant field. 

We will spend more time with the Events Snapshot window later in 
this tutorial. 

From Events Snapshot: 

A Cilek to highlight an event. 

A CIiek again on the highlighted event to zoom to the Event window. 

The Event window shows your selection. The top part of the window dis-
plays the contact, activity, and time for this event The bottom note area 
contains any information associated with the event It might contain a let-
ter, simple notes, an order, contract information, or nothing at all. 

Event Record 

----Click to activate Events Snapshot. 

T--- ._I __ __, 

=-11-• 
...... 1,.., 
c..tT.-.OIS....-1_..,..___ 
,.__.,.,PA-
ATIN:"-1.Mor ___ ,4 

•MCC..,.vtlN_......,•-.,T.-..,,-10,1"'7. v.. ... ......, ........ __ 

To see another event, you can either: 

• Select by highlighting an event in Events Snapshot, and then 
clicking once. Or 

• Click the Next button on the upper left of the Event window to 
see the next event. 

A Before proceeding to the next section, close the Event, Events 
Snapshot, Contact List, and Account List window. 

Quick Clicks Tutorial 

Click to highlight another event. 
Click again to see the event. 
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Activity Lists The Activity List shows a list of 
user-defined activities. Activities 
are grouped into classes. The 
default classes are shown at the 
top of the window. You can 
change the class names (and the 
button names as well) using the 
Activity Class command under the 
Enter menu. 

Rctlultu List 

8Lot,_. OfnJ•d• 0-.... i O Plltln• O Ordan O liananil 
is.ij" Rctlua Ontu 

J•-'---- ;=:: 
1 ......... utl .. I .. ~ ....... ' ----

1cttu1t ust !J. Click any of the radio buttons to show the list of activities 
OP111Jact1 ttMnttng for that class. 
O lnlan C,Senant 

Events Linked to an Activity Event records are linked to contacts and activities. To see the list 
of events associated with a specific activity: 

2-12 

!J. Cilek on any activity name from the Activity List. 
!J. Cilek again on the highlighted activity. 
!J. Cilek the All Contacts button on the upper left of Events Snapshot 

C.A.T. zooms to show the Events Snapshot. The event list shows 
all events associated with this activity . 

• Fila Edit 

!J. You can see all events for an activity class by cllcklng the 
Next button beside the class name. 

!J. You can see all events for a different activity by cllcklng the 
Next button beside the activity name. Each time you cllck, 
C.A. T. shows the next activity for the current class. 
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You'•lllH ac;dvity records to manage projects such as mailings, 
titai~W jult. personal information. When you need it, the rele-
·~ appear on screen, instantly. 

C.A. T. also lets you review events 
b,y,tfme pcJiod. You can select 
dates by clicking on the Calendar 
window. 
A H the Calendar le not on your 

acrNn1 chOON Calendar from 
th• Show menu. 

The sample data has events dated from September 1987 through 
December 1987. In the instructions below, we will navigate you to 
that time period. 

Time Management 

A CIiek th• year box to ehlft the calendar forward or backward untll Selecting the Year 
the two yeare brackat the year you wanl (The year Heelf le die-
played In the field at the top of the Calendar.) 

11 CIiek a month to hlghllght that month. Choose December. 

11 CIiek again on December. 

11 CIiek the All ActlvHles button In the 
upper middle of the Events Snapshot 
window. 

C.A. T. zooms to show all the events for the month of December 1987. 

Quick Clicks Tutorial 

Selecting the Month 
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Selecting the Week To see all events for a week: 

lJ. Click on the Calendar to activate 
thewlndcw. 

lJ. CIiek on the box to the left of any 
week. C.A.T. zooms to show all 
the events for the week. 

lJ. CIiek the Next button for the date 
range and C.A. T. shows all 
events for the next week. 

Selecting a Range To see all events for a specific time period, from Events Snapshot: 

lJ. Double-ellek on the Go-to arrow for the date range. 
lJ. C.A. T. displays a dlalog box with a begin and end date. Enter a time 

range. 
lJ. CIiek OK. 

Selecting the Day To see all events for a specific day: 

lJ. CIiek to activate the Calendar window. 
lJ. CIiek to hlghllght a date. 
lJ. CIiek again on the hlghllghted date to show all events for that day. 

To-do Lists C.A.T. uses a series of check marks in the Events Snapshot window 
to classify items. On the left of the Events Snapshot, there are three 
columns. 

You click to checkmark or uncheck 
Work, To-do, and Priority events. 

lJ. To see Just events from one sta-
tus group, ellck to place an "X" 
In the box above the column. 

C.A.T. shows the events selected. 

Summary To summarize the key concepts in this section: 

• C.A.T. has four kinds of records: Accounts, Contacts, Events, 
and Activities. Records are linked. 

• List windows let you select and manage records. 

• Entry windows are used to search and enter records. 

• The Next button shows the next record. 

• The Goto arrow jumps to the appropriate list or entry window. 
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En:tering Data 
This section will show you how to set up your own C.A. T. database. 
It will show you how to: 

• Enter account records; 
• Add contacts to an account; 
• Create activities; 
• Create form letters; 
• Enter events. 

C.A. T. UHi basic MacIntosh techniques for editing text (such as Inserting, 
deleting and aelectlng text). If you are new to the MacIntosh or you want a 
refresher on thll8 techniques, consult your MacIntosh owner's guide. 

To get C.A. T. up and running, do the following: 

If you are starting C.A. T. from a hard disk: 

1. CIiek the C.A.T. Icon In the Finder to select It. 
2. Choose Open from the Fila menu. 
3. Whan C.A.T. presents the choice of files to load, double-click 

the "Quick Start" Icon. 

Or double-click the "Quick Start" data icon to open it. 

If you are using C.A.T. with one new 3.5-inch disk drive: 

1. Insert and open your "C.A.T. Work" disk. 
2. Doubla-cllck the "Quick Start" Icon. 

You can use the "Quick Start" to save time (it contains some preset 
report formats but no accounts or contacts.) Regard this as your 
own database. Choose Save As from the File menu to rename the 
file with your filename (e.g. "Jack's C.A.T."). In the future, to start 
C.A.T., follow the instructions above, but select your filename. 

Entering Data 

Starting C.A.T. 
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Fields & Buttons 

Next Button 

Editing Buttons 

Type of Field 
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C.A.T. Entry windows contain different types of fields and buttons. 
You use them to enter information. link to records, and make selections. 

n 1 ont,1, t 

~ I I 

N.lnw: - I Data Entry Field I 
Aocolnt: - "'. --Ttt'II N T Clairvoyant Field I Lrffl N I 
Tai.-11 --- -
T.tii.-12 ) ------ _:j I - Echo Field l D ORIIH OMrLN 0 Ms LN ®llrK.... I 

Phon•/Extensioll Alia M.ail Stol! ---Goto Arrow I I I I 

I 
Note Field 

□ ( ENTER ) ( CLEAR ) ( onm ) 

Type of Fleld Border Description 
Data Entry Fields Solid Box for entering data. 

Clairvoyant Fields Heavy Fields for linking records using 
clairvoyant search or by high-
lighting records. C.A.T. presents 
possible results in adjacent 
fields called Echo fields. 

Echo Fields Dotted Box for displaying possible 
options when you type in an 
adjacent clairvoyant field. 

Note Fields Scroll Box with scroll bars. You can 
enter up to 16 pages single-
spaced in this box. 

Chapter 2: Learning 



Type of Button Description 
Next button Shows the next record when you 

click the bottom of the button (or 
press the PgDn key). 

Click the top (or press PgUp) to 
see the previous record. 

Goto arrow This button is a shortcut that takes 
you to other related windows. 

Enter button Records information to your C.A.T. 
file when you click on the Enter 
button (or press the Enter key). 

Clear button Removes the information from 
view without deleting it, when 
you click on the Clear button (or 
press the Clear key). 

Delete button Erases all the information in the 
record. You cannot undo a delete. 

Push button Enters current record and sets it 
aside in a "stack." You can push 
aside up to 100 records. 

Pop button Displays the records in the stack 
starting with the record on top. 

Xchg button Exchanges the current record with 
the record at the top of the stack. 

Prior to entering data, do the following: 

A ChooH the Options command from the Enter menu and flll out 
the basic Information on your company name and your name. 
Then click OK. 

A ChooH the Preferences command from the Edit menu and 
change any Item to suit your own need. 

Consult chapter 5, "Command Reference," of this manual, if you 
need help with these commands. 

Entering Data 

Type of Button 

( ENTER ) 

[ CLEAR ) 

( DELETE ) 

Options & 
Preferences 
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Entering Names, 
Addresses & Phone 

Numbers 

To set up your C.A.T. files, start by gathering all sources of names 
and addresses of your contacts. We recommend that you enter the 
names by source. For example, enter all personal contacts, then 
customers, and finally vendors. For each category, create a view to 
let C.A.T. help you manage all your contacts. 

• If your contact list is already in computerized form, consult the 
Appendix for instructions on importing and exporting. 

• If your contacts need to be entered, simply choose New Account 
from the Enter menu and start typing. If you have a very large 
number to enter, consider hiring a temporary typist. Most can 
easily enter 120 names per hour. 

Adding Accounts To enter a new account: 

2-18 

t:. Entering account records 

1. Select New Account from the Enter menu. 

2. Enter your Information In the appropriate spaces. To move the 
cursor to the next field, click the mouse In the field or use the tab 
key to move to It. 

3. When you have finished entering the data for the record, click 
the Enter button. 

You can add information in the Account window at any time. 
Whenever you need to clear the window for new entries, click Clear. 
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Type name of person who is pri-
mary contact either first name or 
last name first. 
Type the company name, if any. If 
you are entering an acx:ount record 
for an individual, C.A.T. automatical-
ly uses the last name as the account 
name so you can skip this field. 
Use the Alias field to record an account 
identifier such as account number. 
Use - or / or () to separate parts of the 
phone number. 



To make changes to an account record you have already entered: 

A Changing account records 

1. Activate the Account window. 

2. Find the account to change: 

• Either use the clalrvoyant field at the top of the window. 

• Or go to the Account List and select the account. 

3. Make the changes to your Information. 

4. When you have finished your changes, cllck the Enter button. 

To add more contacts to an account: 

A Adding contacts to an account record 

1. Select New Contact from the Enter menu. 

2. Type the name of the contact In the Name fleld. You can enter 
last name or first name first. C.A.T. automatlcally sorts the entry 
by last name. 

3. Press the tab key or cllck once In the clairvoyant Account field. 

If the right account name is not shown in the echo field, type the 
first few letters of the company name for this contact until the 
account shows in the echo field. 

Alternatively, go to the Account List and click to select the account 
name. Once the account for which you are entering contacts is 
selected in the Account List window, it will appear in the echo field 
of the Contact window. 

4. Prea the tab key or cllck once In the Title field. Enter the title. If 
the title Is already In the lookup table, C.A.T. will echo the title to 
the right. If not, continue typing the full title. When you click 
Enter, C.A. T. will ask you If you wish to add the title (code} to the 
lookup table. 

The remaining table codes are optional. (See Chapter 3 for a full 
description of lookup tables.) 

5. CIiek the Enter button to record the contact In C.A.T. 

Entering Data 

Changing Account Data 

Adding Contacts 

I f1,11l,11 t 

~ -= .... Kon -= ~·~ ... 
Tfflt --Loni • r•1o-11 
r•1o-12 ',7 

D ORHH OMrLN OM•LN (i)Flnt I 1• 1~ □ 
I ENTER JI CLEIIR )[ oum J 
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Changing Contact Data To make changes to any contact records you have already entered: 

Creating Activities 

2-20 

A Changing Contact Records 

1. Activate the Contact window. 

2. Find the contact to change: 

• Either use the clairvoyant search field at the top. 

• Or go to the Contact List and select the contact. 

3. Make any changes to your Information In the appropriate spaces 
Including reassigning the contact to a new account. 

4. When you have finished changing the data for the record, click 
the Enter button. 

Activity records are used to track projects. You create one activity 
for each type of project and use activities as you need them. 

• If you have existing projects that you want to track in C.A.T., 
take each project and create an activity that describes it. Then 
enter the events for each contact involved. 

• Otherwise, activities and events can be created as needed. 

• At a minimum, create one activity called "Standard Letter" and 
create one letter to tell us at Chang Labs that you are up and 
running and a registered user of C.A.T. 

[] tHIIL'lflj 

~ I - . 
c=J@ Letten O Projects O Meeting 

QPhone ODrden Q&eneral 
Alm DneripHon 

I 
Q 

fj 

( ENTER )( CLERR )( DELETE )( Tactics> ) 
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Search for an existing 
activity using this clair-
voyat field. 



To create a simple activity to track appointments or meetings: 

A Creating • Slmple Activity Record 

1. Chooae New Activity from the Enter menu. 

2. CIiek the button next to the activity class for which you want to 
define a specific activity type. 

3. CIiek In the Description field or use the tab to move your cursor to It 

4. 'fype the specific activity name (e.g., "Appointments" or "Staff 
Memos"). 

5. CIiek Enter. 

To create a form letter: 

A Creating a Form Letter Activity 

1. Choose New Form Letter from the Enter menu. 

2. Type the specific form letter name (e.g., "Standard Letter" or 
"Product Intro Letter"). 

In the notes area of the Activity window, C.A.T. has already pre-
pared two preset blocks that contain the address and closing of your 
letter. 

The address block contains symbols that reference fields of your 
database. Please see chapter 3, "Managing Activities," for more 
examples about using these symbols. 

3. CIiek on the notes, and cllck to position the cursor following the 
► In the body of the letter. Type the standard letter you want to 
appear as the form and cllck Enter. 

If you want to create a standard letter with just the address block, 
closing blocks, and no preset body, then delete the ► 4 pair of char-
acters and click Enter. 

Note: Be sure to enclose all standard information for the form letter 
itself within block markers as indicated on the screen. To create a 
block marker, type Option . (Option-period) at the beginning of a 
piece of standard information (information that should appear on 
each copy of the form) and Option, (Option-comma) at the end of 
the piece of standard information. 

A form letter can have multiple blocks. When you prepare a specif-
ic letter for one individual, you can insert personal paragraphs 
between blocks of the form letter. 

Entering Data 

Appointment 

Form Letter 

c::::i~ L■tt■n O PntJ■et, O MHtlng 
0 Phon■ O Onl■n O &■n■nl -.-

These symbols position 
names and addresses in 
form letters. 

Insert the body of the form letter follow-
ing the begin marker or delete the pair 
of block markers, here. 
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Simple Fann You can enter blocks of text into the notes field of an activity to 
create a form. These forms can be used to manage a survey, track 
invoices, or keep information regarding outstanding purchase 
orders. 

To create a simple form: 
I 

c:::JO lattan O Pn1Jact1 0 Maattng 
Ii Creating a Form Activity 

• Phon• O Onlan O lonenl - -.-
I l11nw I 
........... ·---·- !:: --'4 __ ., _____ ,. __ ,.. ___ ,,_.t4 
►,... ........... -..--,. 
►r,-,...,..,.,..~,.,.•-H 

►-tw--.. .. --4 
In 

[ ENIEI JI CWI I DELm )( Tactics> ] 
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1. Choose New Activity from the Enter menu. 

2. CIiek the button next to the activity class for which you want to 
define a specific activity type. 

3. CIiek In the Description field or use the tab to move your cursor to ll 

4. 'fype the specific activity name (e.g., "Purchase Contracts"). 

5. In the notes area of the Activity window, type the standard Infor-
mation you want to appear as the form and click Enter. 

Note: Be sure to enclose all standard information for each part of 
the form within block markers as indicated on the screen. To create 
a block marker, type Option . (Option-period) at the beginning of a 
piece of standard information (information that should appear on 
each copy of the form) and Option, (Option-comma) at the end of 
the piece of standard information. 
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Bvcnts are used to log information. Each event is linked to a con-tact-~ activity. And events are automatically time stamped 
with a date and time. For example, to record an appointment: 

4 Aeoord An Appointment 

1. ChooN New Event from the Enter menu. 

f11l'nl 

~ 1,,,,,. 
I ""'E!:::_f I ~ 

Cent-': : I~ 
ActtYitv: ACTIVITY □ Done ;; 

Q (ENTER] 
(CLEAR] 
~ 
[HCH&] 
~ 

n [PUSH] 

2. Check the date In the first field In the Evant window. If naces-
ury, change the date to the date you want for the meeting. Then 
preN the tab key to move to the time flald. 

3. Change the time to the time for the meeting and press the tab 
key to move to the contact field. 

4. Begin typing the name of the person (first name or last) with 
whom you are scheduling a meeting. Stop typing when you see 
the name you want In the echo field and press the tab key. 

You can also search using the Next button in the echo field. For 
example, type the name "john." Since the database has lots of con-
tacts named "john," click the Next button until the correct person 
shows on screen. If you jump past the name you want, click the top 
part of the Next button to go backwards. 

5. Begin typing the name for the type of meeting you want to 
record. Preas the tab key when the activity type In the Echo flald 
la the one you want If your meeting type Is not defined, C.A.T. 
wlll prompt you to create an Activity record for It. 

6. 1ype the Information you want recorded regarding the mealing In 
the note field and click Enter. 

Entering Data 

Entering Events 

Entering An Appointment 
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Customizing a Form Letter To use a form letter and customize the letter for one individual: 

Use the Activity window if you 
wish to change the preset 
blocks of a form letter. 
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letters following this marker. 
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Hi 

1 - ,i.ci to h..- ttw 111stem ts worlmt w•n 111d rM.ttng y_. l'lffCls. 'rl• 
.njoyN wartrin9 with your stiff 111d look forwrd to fwn coopenti,,. 
proJ-cts. 

fl Prepare a Latter for an Individual 

1. Choose New Event from the Enter menu. 

2. CIiek In the Contact field and begin typing the name of the con-
tact to whom you want to send the letter. 

If you have not already entered the contact record for this person 
into C.A.T., you can do so now by double-clicking on the Goto 
arrow next to the the Contact field. If you have not yet entered the 
address information for this person, then double-click on the Goto 
arrow next to the Account field. In either case, enter the record and 
close the entry window. In the Event window, click in the Contact 
field and the name you entered will show in the echo field. 

3. CIiek In the Activity field and begin typing the name of the spe-
cific form letter such as the "Standard Letter." 

Alternatively, highlight the letter you want using the Activity List 
window. First, single click the Goto arrow for the Activity field 
and C.A.T. shows the Activity List. 

Actwtt11 : I ~L•tt•rs : Standrd l•ttft" 

Single click to select the "Standard 
Letter" activity and close the Activity 
List window. The name of the activity 
and the contents of the form letter will 
be displayed in the Event window. 

,I iS.,,.;...,r lnvit1t;,,,, 
?_ •• ,. 
,I ist1ndrd M•mo 
7 l5t1ndard Nott 

Note that the letter has already been customized with the date, 
name, and address information. 
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4. ~ the custom contents of your letter In the notes flald. 

Be sure not to type between the block markers. The information 
between block markers is text that appears on every copy of this 
form letter. To change the preset text for this form letter, use the 
Activity window. 

Custom parts of letters should be entered in the space after the ◄ 
marker following a block of text. 

5.. When you have finished typing, you can print the latter by salactlng 
Print from the Fila menu, salacUng the 'Latter/Mamo/Note" option, 
and clicking Print Altarnatlvaly, click Enter and print the latter later 
along with the other letters you prepare during a session. 

Look in chapter 4 for detailed information on printing reports. 

To summarize the key concepts in data entry: 

• Data is entered using Entry windows. 

• Contacts are linked to accounts; events are linked to contacts 
and activities. 

• To link records, type in clairvoyance fields, point and click to 
highlighted records on List windows, or click the Next button 
until the record you need is found. 

• Single-click on Goto buttons to show List windows and double-
click to show Entry windows. 

• Single-click on hightlighted records in List windows to zoom to 
the next List windows and double-click to show Entry windows. 

Quick Clicks Tutorial 

Summary 
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This chapter explains the advanced features of C.A.T. It shows you 
how to use C.A.T. commands to manage information, print form let-
ters, and track your data. The chapter is divided into three sections: 

• "Managing Contacts" shows you how to use views and lookup 
tables to organize your accounts and contacts. 

• "Managing Activities" shows you how to use preset text and tac-
tics to simplify routine tasks. 

• "Managing Time and Events" focuses on how to use the 
Calendar and the Events Snapshot windows to retrieve informa-
tion. Sample day-to-day events and examples of how to use 
C.A.T. to calculate amounts are also given. 



Managing Contacts 

This section describes how C.A.T. can track your interactions with 
the people you know. You will learn how to: 

• Define views, 
• Use lookup tables, 
• Make views, 
• Merge views, and 
• Change views manually. 

To review what you learned in previous chapters, account records 
contain an account name, address, phone number, and other 
account-related information. Accounts are entered in the Account 
window and displayed in the Account List window. 

Each account can have an unlimited number of contacts. Contact 
records contain the names and specific information about individu-
als. Contacts are entered in the Contact window, which includes a 
field for you to link each person to his/her account. The contacts 
for each account are displayed in alphabetical order by last name in 
the Contact List window. 

You can also record up to 16 single-spaced pages of notes for each 
and every account or contact. 

Whenever you click on a highlighted account in the Account List 
window, C.A.T. zooms to the Contact List window to display all of 
the contacts for your selection. 

Accounts & Contacts 

You may have hundreds of contacts. How do you organize them to About Views 
locate one quickly? You group the people you know by association. 
For example, you have "family," "friends," and "business associ-
ates"; you may also have "regional accounts," "clients," "press edi-
tors," etc. You think of people in terms of their association to some 
group. 

To help you manage your accounts and contacts, C.A.T. lets you What Is a View? 
create lists of accounts called views. A view is a list of accounts 
and contacts grouped together by association. 
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Selecting Views 

Naming Views 

You also use views to print reports, do mailings, send an electronic 
list of records to an associate, produce labels, manipulate your data, 
and manage interactions with your contacts by groups. 

Note that an account or contact can be associated with several 
views. For example, if you set up views of investors and cus-
tomers, a contact who is both an investor in your company and a 
key customer could appear in both views. 

Further, a view could contain the records for a single company with 
multiple locations. For example, you could create a view called 
"General Motors" to keep track of 20 different plant locations. 

All views are saved to disk along with your data and are displayed 
in the Views menu. You can have up to 13 views at one time. 

Views can be permanent, for regular use, or temporary, to perform 
simple searches or to support special projects. For example, you 
may want to find all accounts in California for a promotional mail-
ing. All views can be redefined at any time to suit your needs. 

The available views are listed in the Views menu. Until you assign 
a view name, the views are numbered from I to 13. To select a 
view, choose a view from the Views menu. 

When you select a view, the Account List window is activated and 
the name of the view is displayed in the title bar. 

To name a view or to change the name of a view, choose Name 
View from the Action menu. The following dialog box will appear: 

Enter a name for the view; for 
example "Major Accounts." Next, 
if you are using a color monitor, 
select a color to use to distinguish 
the accounts in this view with 
color. Then click OK. The name 
is inserted into the Views menu and 
is shown in the title bar of the 
Account List window. 

Name Ulew: Enter 
~ ulew name, Hlect 

color end cllck DK. 

I Major Recount◄ 

0Red QBlue 
0 &reen O Yellow 
O Cyan O Magenta 
®Black Et [ Cancel J 

Creating Views You can use any combination of three ways to create views: 

• Use the mouse to point and click to place or remove a check 
mark(✓) in the Work, View, and Priority columns of the 
Account List and Contact List windows. 
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• Choose the Make View command to search through account and 
contact records using specific criteria. 

• Select the Merge Views command to work with multiple views 
to create a new view. 

Each option will be described below. 

In the Account List and Contact List windows, C.A.T. shows three 
columns labeled W, V, and P. They are defined as follows: 

W Work Account and contact records that are checkmarked 
have been changed during the current session. As you 
either add a new record or change an existing record, it 
is automatically checked. 

A new "current session" begins whenever you save to disk; and the 
check marks for the Work column are automatically cleared. 

V Current Accounts that are checked belong to the currently 
selected view from the Views menu. When you select 
a new view from the Views menu, the account and 
contacts for that view will show check marks in this 
column. 

P Priority A check mark by a name means the record has higher 
priority than others. 

Priority is left to you to define. It is, in effect, just another view. Since 
it has its own column, Priority can be used in combination with another 
view, to let you be even more selective. 

Managing Contacts 

Checkmarking (✓) 
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Click on check box to 

You control which accounts to show on the Account List window 
by checking the three boxes on the upper left. These boxes let you 
select to see: 

• Work accounts only, 
• Current view accounts only, 
• Priority accounts only, or 
• Any combination of the three. 

To change the status of any box, point and click to check or 
uncheck the three boxes (i.e., add or remove the "X"). For exam-
ple, point to select the check box for the current view. 

select view. - M1Jor Recount• 
~ C.A.T.'"'"' a-,a.-vz.o 

~ 1810 Wortc/Ulew/Prlorltg 

,I 

_.,_ 
~nu ,, lot-I hie•- ~- Nf. ,.. Jo«..-..-1 ......... CA 

Click on columns to ,.. -•-llr - L 

check records. 

Checking (VJ Records You can add or remove check marks(✓) from account and contact 
records. To check any item, point with the mouse and click. 

To remove a check mark, point to the check mark and click. 

You can use pointing and clicking to check accounts and contacts to 
make a view. You can also change existing views using the same 
procedure. 

Creating Views To create a view manually: 

• Select a view from the Views menu. 
• Choose Name View from the Action menu to assign a name. 
• Uncheck the V box on Account List to show all accounts. 
• Checkmark each account to be included in the view, in the V 

column. You may want to check each contact to make sure spe-
cific individuals are included in the view. 

• Check the V box on the Account List window to see all accounts 
for the new view. 
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The Make View command lets you create views automatically, Make View 
using search criteria. For example, you can search for specific zip 
codes. To use Make View, first select a view from the Views menu, 
then choose Make View from the Action menu. The following dia-
log box will appear: 

Al.. MRI .... : E11ter crltlrllj tll1n tfftlc st,rt. 1 I 
(Q) Nw: ► . ~ Color:~O~R-,d.,.....-~o~,-,u-,-~o~~---~1 

• llaclc O Yellow O C .. ■ 0 Megente 
lltceunt: 

I 

ltert , 

Cenc•I 

CIHr ) CltF 
ltate: 
zi,: [ Clrulea, ) 
U..: 

Countrg 
Tlllle-Z r,1111,-, 
r....-4 
Titll 
Leull 

r,111,-s 
r,1111-1 
Teble-7 
Teble-1 ------1 Table-I I . r,111,-12 

The first field is used to enter a name for the view. The name 
entered here will replace the number or name displayed in the 
Views menu. 

Next, if you are using a color monitor, select a color to use to dis-
tinguish the accounts and contacts in this view. 

The buttons in the upper right are used to: 

Start the salectlon process and create the view. 

Cancel the Make View operation. 

Clear all of the fields In the dlalog box for new entries. 

Cir View removes all accounts and contacts from the cur-
rent view. 

The remaining fields are for you to enter selection criteria. Your 
criteria can include information from any of the fields in your 
account records such as account name, city, state, zip, or alias. 

For example, if you want a view of all contacts in the state of 
California, click in the State field and type "CA." 

Managing Contacts 

Make View Buttons 

Selection Criteria 
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Search for all clients 
in California. ' 

You can enter as many criteria as you need. Each criterion makes 
the view more selective. 

In the lower half of the dialog box, you can make the search even 
more specific by entering codes from lookup tables. A lookup table 
is a list of codes used to categorize your records. Lookup tables are 
described at the end of this section. 

After entering your criteria, click the Start button. 

~ M■t■ ulew: Enter crttertai then cllct Start. 
N■m■: lc■Hfoml■ 11ccount1 I~ Color: QRed 0Blue Q&nen , Cancel 

•11■ct QY■How QCyen QMegente 
Recount: 
City: I Clear ) - CII -····· -

~ 
( Clr11lew ) 

t 
. 

Teble-5 
Table-2 Client Teble-6 
Table-5 T11bl11-7 
Teble-4 Teble-8 

TIiie I I Table-I I I I Leuel Table-12 

In a few seconds, C.A.T. will display the results in the Account List 
window. 
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C.A.T. can also search for a range of values. For example, you can Compound Criteria for Views 
select: 

• All accounts in the states of California, Oregon, and Washington 
by entering CAIORIWA in the State field. 

• All zip codes less than 50000 by entering cSOOOO in the Zip field. 

• All account names that start with the letter C or K or any letter 
in between by entering c .. k in the Account field 

Symbols combined with key words can be used to specify selection Make View Operators 
ranges. These symbols, called operators, are described below: 

Operator Example Meaning 

(text only) ABC Starts with the letters "ABC" 
= :ABC Exactly equal to "ABC" lnclud-

Ing spaces. 
> >ABC Greater than "ABC" 
C cABC Less than "ABC" 
>• >=ABC Greater than or equal to "ABC" 
<= <=ABC Less than or equal to "ABC" 
? ?ABC Contains the letters "ABC" 

ABC .. XYZ Range from "ABC" to "XYZ" 

If you leave a field blank, this means no selection criteria are speci-
fied, and all accounts and contacts meet the criteria. If all fields are 
left blank, then all accounts and contacts will be included in the 
current View. 

In addition to operators, C.A. T. also allows the following mod If I er•: Modifiers 

Modifier Example 

AIBIC 

Al>Nl?X 

Meaning 

Words starting with "A" or "B" 
or "C" all pass the selection cri-
teria. 
Starts with "A" or greater than 
"N" or contains "X". 

(To enter the I modifier, press the Shift and\ keys simultaneously.) 

I /ABC 
/>ABC 

Does not start with "ABC" 
Not greater than "ABC" 
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Notes on Criteria When entering criteria, note the following: 

• Make View looks for all records that start with the text you enter 
as your selection test. For example, if you entered "com" in a 
field, the codes "commercial" and "communication" would pass 
the test. However, the code "intercom" would not pass since the 
letters "com" are contained within the code value. 

• Make View is not "case" sensitive, meaning it does not differen-
tiate uppercase and lowercase text. "ABC" would match "abc," 
"Abe," or "abC." 

• With range comparisons, Make View follows strictly the 
Macintosh sort sequencing. Numbers precede the alphabet. 
Therefore, "A" is less than "Al" and "Al less than "AA." A 
null value (i.e., no value for a field) is the smallest value. 

• International characters are sequenced according to Macintosh 
sort sequencing. 

• Make View does not permit the use of multiple "range" opera-
tors( .. ) separated by the "or" modifier (I). For example, 
"A .. BIX .. Z" is not permitted. However, "AIBIXIYIZ" produces 
the same result and is permitted. 

• The = operator can be used to find all records with blank fields. 
For example, you might want to find all records that are missing 
zip codes. If you enter just"=" in the Zip code field, C.A.T. will 
look for all records that have no values (or null input) in that 
field. 

Changing View Criteria You can change criteria any time you want to modify views. First 
select the view to be changed, from the Views menu. Then choose 
Make View from the Action menu. Enter your changes and click 
Start. C.A.T. will automatically search using the new criteria and 
display the new view in the Account List window. 

View Membership When you specify criteria for a view, C.A.T. saves these criteria on 
disk along with your data. When you enter a new account or con-
tact record, C.A.T. automatically checks the criteria of all views to 
see if the record belongs in each view. This allows you to automate 
the maintenance of views as you enter new information. 

For example, you could enter "Apple" in the Account Name field to 
create a view of all Apple offices. As you enter new account 
records, if the account name begins with "Apple," C.A.T. will auto-
matically make that account a member of the Apple view. 
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When new account or contact records are entered, C.A.T. checks 
the selection criteria for all views and determines if the account or 
contact should be added to each view. 

However, to prevent changing manually created views, C.A.T. does 
not check view membership for existing records that have been 
modified. In this case, you could click in the View column to man-
ually correct the view membership. 

When creating a view, note that view membership of contacts la 
solely controlled by the four lookup tablas at the bottom of the 
Maka View dlalog box. Whan thoaa four flalda are left blank, 
this means that all contacts for the account wlll be Included In 
the view. (If you are preparing a malllng, this means every con-
tact associated with the account wlll receive his or her own 
copy of the malllng. In this case, manually review each accoun-
t's Contact List and add check marks so that the appropriate 
contacts wlll receive your malllng.) 

The Merge Views command allows you to work with views in the 
Account List and Events Snapshot windows to create a new view. 

When you choose the 
Merge Views command 
from the Action menu, a 
dialog box will appear: 

The Mode controls how 
you combine two views. 
Modes include: 

Mode Explanation 

~ Merge Ulew1: Select II mode 
o"-i} and an operation. (see manual 

for eHul11n11tlon1) 

MODE 
(l)Set 
OMerge 

OPERATION 
® Work <• current 
O Work <• Euent 

O lntenect O Current<• Work 
O Remoue O Current <• Euent I OK ) [ Cancel ] [ Clear Work 

Sat 

Marge 

Intersect 

Remove 

Ona review replaces another. 

Merge one view with another to create a combined view. 

Intersect to find the common members of two views. 

Remove common members of one view from another. 

The Operation tells C.A.T. which two views to use. The view to the 
left of the"<=" symbol is the one that will be created as a result of 

0 the merge. 

Managing Contacts 

Merge Views 

Modes 
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Merge View Operations Each view is defined as follows: 

View 

Work 

Current 

Explanation 

The Work view Is a transient view. (It normally 
accumulates all new and changed records from the 
current session.) 

The Current view Is the view currently selected 
from the Views menu. 

If necessary, click Cancel in the Merge Views dialog box to return to 
the main screen and select a different view. 

Event The Event view Is the 11st of events currently dis-
played In the Event Snapshot window. 

If you select the "Set" mode and the "Work<=Current" operation, 
C.A.T. will replace the Work view with the Current view. This 
means that after the merge, members of the Current view will also 
be members of the Work view. Each record will have a check mark 
in the Work column of the Account List and Contact List windows. 

If you select the "Remove" mode and the "Current<=Work" opera-
tion, C.A.T. will remove all members of the Work view from the 
Current view and save the result in the Current view. Each record 
will have a check mark in the V column of the Account List and 
Contact List windows. 

If you select the "Merge" mode and the "Work<=Event" operation, 
C.A.T. will merge all members who have one or more events cur-
rently displayed in the Events Snapshot window with the members 
in the Work view, and temporarily hold the results in the Work 
view. Each record will have check mark in the W column of the 
Account List and Contact List windows. 

After you select a Mode and an Operation, click OK to begin the 
merge. A dialog box will appear showing the number of records 
merged. The view created as a result of the merge will be displayed 
in the Account List window. 

Notes on Merging The Merge Views command is designed to help you create views in 
a step-by-step process. In order to get the view you want, you may 
need to move a view into the Work view, select another view, and 
choose Merge Views again to combine the two views. Finally, you 
can save the resulting Work view as a permanent view. Use the Set 
mode to move it back to the V column, where it can be saved. 
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For example, suppose you have a "California Accounts" view and a Merge Example 
"National Accounts" view that you want to combine for a special 
mailing. First choose the "National Accounts" view from the Views 
menu; it will appear in the Account List window as the current 
View. Then choose the Merge Views command: 

A dialog box will appear. To 
make "National Accounts" the 
Work View, select the Set mode 
and the Work<=Current 
Operation, then click OK. 

Another dialog box will appear 
showing the number of ac-
counts merged. Click or press 
any key to continue. 

.A,,. M•rv• Ul■1111: l•l•ct a mode 
~ anti on operation. (He manual 

fDr aNplanatlDnl) 
!~atlonal Account, 

MODE Ol'ERITI ON 
8 S■t 9 Worlt <• Curnnt 
O M•rg• O IIIDl'k <• Euent 
0 lntenect O Currant<• Wort 
O Remoue O Curraot <• Eu■nt 

( Cancel ] ( Clear Wort ] 

Every account in the view will be checked in the Work column, 
meaning "National Accounts" is now the Work view. 

Next choose "California Accounts" from the Views menu; and it 
will appear in the Account List as the current view. 

Choose Merge Views again. 
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Current view is "California Accounts". 
Work view still holds "National Accounts". 
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To merge "California 
Accounts" with "National 
Accounts," which is now the 
Work view, select the Merge 
mode and the Work<=Current 
options in the dialog box and 
click OK. 

A\. Merge Ulew1: Select e mode 
~ end en openttlon. (see menuel 

for eHplenetlon1) 
j~allromle Recounts 

MODE OPERRTION 
O set (i) Wor1[ <• current 
(i) Merge O Wor1[ <• Euent 
O I ntenect O Current <• Work 

O Current <• [Pent 
[ Cancel ) [ CIHr Wor1[ 

Another dialog box will appear showing the number of accounts 
merged. Click or press any key to continue. 

In the Account List window, click to check the box above the Work 
column. Then click to uncheck the box above the view column. 
You will see all of the accounts in the Work view. 
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To save the view, choose an 
undefined view from the 
Views menu and choose 
Merge Views once more. 

Enter a name, in this example, 
"Special Promo Mailing." 
Then select the Set mode and 
the Current<=Work operation 
to make the Work view the 
current view. 

~ Merge Ule111,: Select • -de 
and •• ep•ntlon. (SH manu•I 
fir HDlan■tlons 
Spaclal Prvmo M•llln 

MODE OPERRTI ON 
• ••t O won<• curnnt 
O Marg• 0 IPOrlt <• Eu.nt 
O IDten•ct • turn■t <• Worlt 

O Current <• Euent 
( cancel ) [ Cla•r W•rlt ) 

A dialog box will appear, showing the number of accounts merged. 
Click or press any key to continue. 

Your new view will be displayed in the Account List window and 
saved when you save to disk. 

Similarly, you can manipulate the Events Snapshot window in steps 
to create a highly selective list of accounts. The Merge Views com-
mand facilitates using all of the information in C.A.T. to create 
views. 
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Lookup Table A lookup table is a list of codes used to categorize your accounts 
and contacts. You can set up eight tables (1 through 8) for accounts 
and four tables (9 through 12) for contacts. Each table can contain 
as many codes as you need. Codes can be any attribute that you 
want to use to categorize accounts or contacts. Before explaining 
how to create a table, let's look at the ways they can work for you. 

For example, to categorize your accounts, you could create a table 
named "Groups" with the following codes: 

Table Name: Groups 

Codes: Dealers 
Investors 
Key customers 
Personal 
Press 
Vendors 

Then by linking the appropriate code to each account record, you 
could search on "Group" using Make View to create six permanent 
views with the same names. 

Country Table Table 1 has been preassigned to contain "Country" codes. If you 
have international contacts, you should: 

• Enter the names of each country in this table. 
• Enter the appropriate country code in each account record. 
• Select the "Country table" option under Preferences (see the 

Edit menu). 
• Select your "Label Options" also under Preferences to print 

country names on mailing labels. 

If you do not need country codes, you can redefine table 1 and use 
it for some other purpose. 

Sample Tables tor Accounts Here are some tables that you might define for account records. 
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Channel 
National 
Retail 
Wholesale 
Trading 

Industry Size (Employees) 
Finance A-Large: more than 1000 
Manufacturing B-Mld market: 100-999 
Mining C-Small: fewer than 100 
Service 
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Yell can also define tables to gather information for market 
iuearch. For example: 

County 
Alameda 
~ 
San A'ancleco 
San Mateo 
Santa Clara 

NttWortb 
A: c$100,000 
B: $100,000-$500,000 
C: $500,000-$1 mllllon 
D: >$1 mllllon 

Age of Business 
A: under 5 years 
B: 6 to 10 
C: 11 to 15 
D: 16 to 20 
E: over 20 

Table 9 has been preassigned to contain "Title" codes. Here are 
examples of titles you might enter: 

Aulatant Editor Publisher 
CEO Editor In Chief Receptionist 
CFO Executive VP Secretary 
coo Manager Senior VP 
Controller owner Vice-President 
Director President 

'The following tables may give you ideas for supporting your views 
of contacts: 

PIPldro•ot 
Administration 

. Engineering 
. "1=1nance 

Marketing 
•s 

Llxtl. 
Buyer 
Primary 
Secondary 
VIP 

IIHearch & Development 
Sales 

like account lookup tables, contact tables can be defined for mar-
let research. For example, you could set up the following tables to 
·support temporary views: 

0r1totat1on 
ConNrVatlve 
Moderate 
Risk-taker 

Education 
High school 
College 
Master's 
Ph.D. 

Profession 
Academia 
Blotech 
Computer 
Engineering 
Finance 
Law 
Medical 
Real Estate 

Managing Contacts 
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Defining Tables To create a lookup table, choose the Lookup Table command from 
the Enter menu. The following dialog box will appear: 

e Tables 1 through 8 are for account records. 

e Tables 9 through 12 are for 
contact records. 

Select IHkup table. 

Entering COdes 

Changing COdes 

~ountrg 

Click to select a number and the 
Lookup Table window will 
appear. 

In the first field at the top of the win-
dow, enter the title for the table. This 
title will appear in the Codes window 
and Make View dialog box. 

In the second field, enter a code and 
click Enter. 

eble-2 
eble-3 
eble-4 

Continue to enter codes as needed and 
click the Enter button after each entry. 
C.A.T. will automatically alphabetize 
and list each code under the Description 
heading. 

You can change codes whenever neces-
sary. Just display the lookup table that 
contains the code to be changed, click 
once to select the code and it will appear 
in the second field at the top of the win-
dow. 

Make your changes and click Enter. 
Note that the new code will replace the 
old one in all of the records that con-
tained the original code. 

oble-5 rr1t1e 
Jobie-• uuel 
oble-7 eble-11 
able-I eble-12 

I Cencel J 

Deleting COdes Select the code to be deleted in the Lookup Table window, then 
click the Delete button. C.A.T. will ask you to confirm the action. 
Click as appropriate. 
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Once your lookup tables for accounts are set up, you can link one of Linking Accounts to Codes 
the codes in each table to each account record. To enter codes, you 
must first display an existing or new account in the Account win-
dow. Then click the Codes> button. 

The Codes window will appear with one field for each of the Tables 
1 through 8. 

If you named your tables, the titles will appear beside each field in 
this window. 

To enter codes, you can: 

• Type the code in the clairvoyant field, and C.A. T. will display 
names that match in the echo field; or 

• Click the Goto arrow beside the table you want and that lookup 
table will appear. Double-click on the code you want and it will 
be linked to the field in the Codes window. 

After you link codes, activate the Account window and click Enter. 

ProjNts ,,It E?~ IMustrv 
Tlllle-S 

ProjNts 

1, i IMustrv 
Tllli.-5 

You can link one of the codes in each table to each contact record. Linking Contacts to Codes 
To enter codes, you must first display an existing or new contact in 
the Contact window. 

There is one field for each of the tables 9 through 12. If you named 
your tables, the titles will appear beside the fields in this window. 
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D O RIIH O Mr LN O Ms LN ® First Fi r~Ci 

To enter codes, you can: 

• Type the code in the clairvoyant field; and C.A.T. will display 
names that match in the echo field; or 

• Click the Goto arrow beside the table you want to see and that 
lookup table will appear. Double-click on the code you want 
and it will be linked to the field in the Contact window. 

After you link codes, click Enter. 

Automatic Code Entry Once you define what a lookup table will contain (e.g., you decide 
that table 9 will contain title codes), C.A.T. makes it easy for you to 
add new codes to the table automatically. 

Choose the Preferences command from the Edit menu and a dialog 
box will appear. Select the "Automatically create codes ... " option 
and click OK. 

Once this option is set, you can enter new codes directly in the 
Codes window for accounts and in the Contact window for contacts. 
For example, suppose you are entering information for a new con-
tact, "Jack Jones," in the Contact window. Jack's title is 
"Consultant." You could type "Consultant" directly in the clairvoy-
ant Title field: 

0 (ontact 

I 
Nam•: Jack Smith I 
Account: 
Titl• 

t 1:>Tuck•r R,sourc.s Group ~ 
t,..----IG:·"·-· ... 

ConS\lltant .I~ ! 
, •••• ·--·--·-·-· .r 
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~ yo11 click Enter, C.A. T. will discover that the code is new and 
tisplay a dialog box: 

6 ..., ceH 'Ceneultent' far teble 'lllle"l 

t • 1 
Click OK and the code will be added to the appropriate lookup 
table. Similarly, codes can be entered in the Codes window for 
accounts. 

The Set Codes command makes it easy for you to enter codes for 
more than one account or contact at a time. 

First choose a view from the Views menu. It will appear in the 
Account List window as the current view. Then: 

• Choose Lookup Table from the Enter menu. 
• Select the table that contains the code you want. 
• Click once to highlight the code in the Lookup Table window. 
• Then choose Set Codes from the Action menu as shown in the 

following screen: 

Managing Contacts 

Set Codes 
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A dialog box will appear to let you confirm the action: 

A\. Set tedH: Set Ille 'lnduatry' nelll to Ille 
~ 'Serulce' Code for ell record• In Ille current 

ulew. I OK I [ cancel ) 

Click OK and the code will be linked to every account or contact in 
the current View. 
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Managing Activities 

This section describes how you can use activities to keep track of 
any subject matter in C.A. T. You will learn how to: 

• Define activity classes and types of activities; 
• Create form letters; 
• Use mail merge; 
• Set up routine preliminary or follow-up activities; and 
• Use activities to manage projects. 

An activity in C.A.T. is defined as "any subject matter." C.A.T. lets About Activities 
you create activities to keep track of any information you want. 

Think about the things you do in the course of your work and the Activity Class 
kinds of information you need to keep track of. In general, you 
probably spend much of your time on the phone, writing letters, and 
attending meetings. These items in italics are examples of "activity 
classes." 

Every activity must belong to one of six Activity Classes. 

Within each class, what variations or types of the activity do you 
have? For example: 

• When using the phone, you may receive inquiries or presale 
calls; you may make prospecting calls.follow-up calls, or want 
to keep notes of phone conversations with certain people. 

• When you write letters, you may have an introductory letter, an 
offer letter, a thank-you letter, personal letters, or form letters 
that you routinely send out. 

• For meetings, you might have appointments; or attend staff meet-
ings, committee meetings, strategy meetings, or board meetings. 

These items in italics are all examples of activities. In fact, activity 
records can be used to track any information, including birthdays, 
expense reports, project notes, marketing ideas, and lists of things 
to do. 

Managing Activities 

Activity types 
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User-Specific Activities Different users have different information-tracking needs: 

• A Consultant could set up activities called "Proposal," 
"Hearing," "Notice," or "Time" (to keep track of billable time). 

• A Personnel Manager could have activities called "Salary," 
"Wage Review," "Insurance," "Vacation," and "Sick Leave." 

• A Paralegal might have activities called "Research," "Court 
Appearance," "Deposition," and "Pleas." 

• A CEO might have "Board Meeting," "Statistics," 
"Investments," "Acquisitions," and "Mergers" as activities. 

• A Sales Manager could have "Prospecting Call," "Sales Lead," 
"Purchase Orders," and "Returns." · 

C.A.T. lets you set up activities to suit your own needs. 

Project-Related Activities When you start a new project, think about your information needs 
and create a set of activities that will help you track them. For 
example: 
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• If you want to plan a seminar, set up an activity called "Seminar 
Invitation" that contains a form letter to invite participants and 
another activity called "Confirmed" to record confirmations. 

• If you want to do a phone survey and need to record responses, 
set up an activity called "Survey" and then create events (using 
"Survey" as the activity) to record each contact's responses. 

• To plan a fund-raiser, you might set up activities called 
"Invitation," "Follow-up Call," and "Donations". 

Form Type Activities Activities can also be a form. For example, you could set up: 

• form letters, 
• order forms, 
• surveys.and 
• expense reports. 

You decide what activities are relevant for your business, and create 
records for them as the need arises. Activities are entered in the 
Activity window and displayed by class in the Activity List win-
dow. 
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An event in C.A.T. is a record of an activity (which can be any sub- About Events 
ject matter) with a specific contact on a specific date and time. For 
example: 
• You mate a follow-up call to Joe Chin at 3 :00 PM on 9/17. 

• You send an offer letter to Sally Smith at 4:30 PM on 10/14. 

• You schedule a staff meeting for 9:00 AM onll/21. 

• You jot down notes for marketing ideas at 7:00 PM on 12/5. 

• You record the birthday of your best friend on 3/4. 

Every event is linked to a contact, activity, and time. In the staff 
meeting and marketing ideas examples above, "you" are the contact. 

The use of events and the Events Snapshot window are described in 
the next section. 

Managing Activities 3-23 



3-24 

Activity Class 

Show Actlo 
NOlll[IIOnt •o 
Now Account •• 
CodH •z 
Now Contact •s 
Now Form Latter 

Nau, Actlulty as 
Tactics X6 

Lookup Tolllo 
Option, 
PIIHUIOrd 

Activities are grouped into six classes. Initially, C.A.T. provides 
the following: Letters, Phone, Orders, Stats, Meeting, and General. 

These classes are suggestions only and can be changed to suit your 
own needs. For example, you could set up "Stocks" as a class and 
list individual securities as activities. Or you could set up "Ideas" 
as a class and create activities for different subject matters to help 
you collect information by topic. 

To change the class names, choose Activity Class from the Enter 
menu and a dialog box will appear. 

llctlulty Clan NllmH 
(MIN of a Characten) 

Latten Phone 
ldHI 
&eneral 

( Cancel 
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Use standard Macintosh editing conven-
tions to make your changes. Class names 
can be no more that eight characters long. 
After you make your changes, click OK. 

The new class names will automatically 
appear in the Activity and Activity List 
windows as shown in the following screen: 



·~~ are entered in the Activity window. 

· · ··• ~ ctivlty, you must select a class and enter a Description. 
· ·Aeld in this window is used to enter preset text and refer-
described next) for form letters and other information that 

like to standardize. This is the only field in C.A.T . 
........ preset text and references may be entered. 

t.,.ett~ is any text that you want to set up in advance and use 
re,eatedly. For example, preset text can be a form letter, a data 
~,et. a marketing survey, or an order form. 

Pr,set text is organized into blocks. A block must begin with a "►" ••ter (Option.) and end with the"◄" marker (Option,}. Any text 
m this Note field that is not enclosed by markers will be ignored. 

As a simple example, the activity 
called "Meeting" shown below 
includes a reminder question in 
theNote field: 

~ 
c::JO Letters O Pn1Ject1 • Meeting 

O Phone O Dnlen O &enenil 
AIiis ~ 

Creating 
Activity Records 

Preset Text 

Text Blocks 

Every time you enter an event 
using "Meeting" as the activity, 
"► Where is the meeting? ◄" will 
appear in the Note field of the 
Event window: 

It In Activity, enter preset text 

It 

inside text block markers. 

In Event, enter your response 
following the end marker. 

Thus you will always remind yourself to ask for the location of 
the meeting and type it in the Note field. 
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Sample Survey Preset text can also include multiple blocks of text (up to 256 
blocks). Each block is designated by the ► and4 markers. For 
example, blocks can contain a series of questions for a quick phone 
survey. The activity called "Survey" shown below includes ques-
tions in the Note field: 

To conduct the survey, you would 
create an event using "Survey" as 
the activity and enter the name of 
the person being surveyed as the 
contact. The preset text blocks 
will automatically appear in the 
Note field of the Event window. 

While you have the contact on the 
phone, you can type his/her 
answers directly in the Note field; 
just use standard Macintosh edit-
ing conventions: 

►--.,-·,--?◄ Responses entered after---+~► -
end markers. "'-:.=.":."'-=:r•"•tt• .,.,.., ... __,._,,__" 

Y• ... , ... ...., ..... 'lol!c"I,.,..,._,, ___ ....,. 
►-,.,. ....... - ... 4 

~ 
(=10 l1tt1n O ProJ1ct1 0 MHtlng 

® Phon1 0 0rd1n O IIID■IW 
A'llls .,._._ 

Hie ......... - .. _ ...... _._?4 
_, _ ., __ .... haft?◄ 

- did ... --.... pnduct'4 .,.,.. ......... -...-.. .,,, . ................. __,,.,..,.llornotlY,'4 
►-,_. ....... - ...• 

Every block of 
preset text must 
begin with a ► 
and end with a 
◄· 

You can enter as many lines of text as needed, as long as the 
answers are outside of the markers. Here in the Event window, text 
inserted between the ► and ◄ block markers will be ignored and not 
saved. 

Note that preset text cannot be changed in the Event window. 
Preset text can only be entered and changed in the Activity window. 
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·· Te:tt blocks can also contain references. References are graphic References 
syll)bols used to represent fields of information from your account 
add contact records. For example, the lr•NHEI symbol represents the 
first name of a contact and fl2Bl symbol represents the address of 
an account. You can use references to include a contact's name and 
address in letters automatically. 

To enter references, you press combinations of keys called "Hot 
Keys." For example, if you press the Option key and the letter "o" 
(lower-case) simultaneously, the iF"·NMEI reference will appear. 
When you press the Shift, Option, and"=" (equal sign) keys simul-
taneously, the~ reference will be displayed. 

Here is a list of the most commonly used references and their Hot 
Keys. A complete list is provided in Appendix B. 

Reference Hot Key Description 

I 
Option J Today's date 
Option z Contact name 
Option y Account name 
Shift Option= Address lines 
Option 5 City, State Zip 
Option v Salutation 

To the right is a sample activity called "Standard Memo" which 
includes references for the contact name and date. 

When you create an event using "Standard Memo" as the activity, 
C.A.T. will insert the heading for the memo in the Note field of the 
Event window. The references will be replaced with the date cur-
rently set on the C.A. T. Calendar and the name of the contact that 
you select. Then you just enter the body of the memo and click 
Enter: 

!.!;,"'., I "Ii#- ! • ~ 
I 1m 

Aollytly:: tws:SIMAnl-
□ Done ~ 

tTo: -,◄ Q [£NTIR) _,Joo◄ 

-:◄ F__,ll,1- [CLERR) Mio:◄ - _, 
•--• ...... "11\Jlfflolo-l"roJ,ctlC-t ~ ..,._.,_ --··-·-... ,,_, .. _,,.,,_ [NCH&) -· [POP) 

c (PUSH) 

Managing Activities 
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~ I I 

C]<I Letten O Project, O Meeting 
O Phone O Orden Q&anenl 

A- ~ I 111-- I 
►To: E:!1 ◄ 
.,,._, Joo◄ 

Q 

~-=◄ E!iil Hlo:4 

fi 

{ Dm:R ){ CURR ){ mm ){ Tactics> ) 
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Standard Letter Similarly, you can set up 
"Standard Letter" as an activity 
with an address block, a salutation 
block, and a closing block: 

HI 1JJq1q 

~ 
c::::::J• l•tt•n O Pnjecta O Meeting 

O Pllone O Onlen O ll•n•l'III 
111111 ~ 

When you want to send a letter, 
you will create an event using 
"Standard Letter" as the activity. 
C.A. T. will display your preset 
text blocks in the Note field of the 
Event window and replace the ref-
erences with the name and address 
of the contact you select. You just 
enter the body of the letter in 
between the blocks and outside of 
the markers: 

Select the contact. ---c.w~:--1~._-~_-_..,:J-~~~,.;,;,_,~==-~ 
Select the letter. 
Type the letter. 

ftwa•p11.rt_.,.,..,at .. -. me_,_,... .. 
--""' -""· , _ l'lnrntt-... .,_, .. _I 

To print the letter, first click the Push button to formally record the 
event in C.A.T. Then click Pop to redisplay the letter in the Event 
window. 

Next choose the Print command from the File menu. A dialog box 
will appear. Select the "Letter/memo/note" option and click OK. 
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To create form letters, use the New Form Letter command under the 
Enter menu. This command displays the Activity window with ref-
erences fQr a standard letter already entered for you. It includes an 
address block, salutation block, and closing block: 

You just enter a description, add preset text, and make changes to 
references as needed. For example, if you want to set up a "Product 
Intro Letter" to send to all of your 
customers, you could enter text 
following the ◄, and click Enter: 

When you are ready to send the 
letter, you will create an event 
using "Product Intro Letter" as the 
activity and the letter will auto-
matically appear in the Note field 
of the Event window. The refer-
ences will also automatically plug 
in each contact's name and 
address: 

c::::]11 Lotton O Pnjects O MeeUng 
O PhDH O Onion O &enenl 
~ 

I 
ATTN:CIJ 

liii!il4 
""•-111 .......... ____ "" _ .. , .... --.................... 
~~~[ Tactics> ] 

Form Letter 

c:::J• L•tt•n O PnJ•ct• O MHllng 
O Phone O Inion O &enonl ,. ... _.,... 

I 
ATTN:CIJ 

liii!l4 

CLERII [ anm ]( T■ct1c1> ) 

Start your form 
letter here. 

Padllc ,._. t. LIIM 
1:mc..,-
.......... cAMffl 
ATTN:Cllr•-
Dor.,..,.,_,,,( Insert any custom 

paragraphs, here. 
►v...-111111_1111 ____ 11_11, .... --_.,,.....,.,..,. __ I POP I 

[PUSH) 

Note that even though this is a form letter, you can personalize it 
for each contact here in the Event window. Just type text between 
the blocks of preset text, outside of the markers. 

Whenever you need to create a form letter, choose New Form Letter 
from the Enter menu. 
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Batch of Letters To prepare a batch of form letters, use the Mail Merge command. 

List of accounts to send to. 

Event (letter) that is to be cloned. 

Select Mail Merge. 
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First create a view of the accounts and contacts who should receive 
the letter. Select the view from the Views menu and it will appear 
in the Account List window as the current View. 

Next create an event using one of the contacts from the view and 
using the form letter (i.e.,"Seminar Invitation") as the activity. 
Click the Push button to record the event in C.A.T. 

Click Pop to redisplay it in the Event window. 

►MC0or?.wffl•-_,•--T--.i,-10,l,e7, , ..... _...., ___ _ 
Then choose the Mail Merge command from the Action menu. 

A dialog box will appear for you 
to confirm the action: 

Click OK and C.A.T. will create 
an event containing the form let-
ter for every contact in the view. 
A dialog box will appear show-
ing the number of letters 
(events) created. 
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As. Mell Merge: Schedule euent 
~ In date 111lndo111 for ell 

DK 

memben of the 'Seminar' 
ulew. Then UH the PRINT 
command to pn,duce 
documents. 

i Cancel 



To print the letters, display all of the events just created in the 
Ev.ems Snapshot window. Be sure that the option for the specific 
acd.vity, in this example, "Seminar Invitation," is selected: 

,;( 

, __ _ , __ _ 
,,.., __ 
=---=•---=•---

Then choose the Print command from the File menu, select the "All 
Notes" option, and click Print. The standard Macintosh print dialog 
box will appear; click as appropriate. 

Managing Activities 
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Preset Tactics Preset tactics allow you to schedule routine preliminary or follow-
up activities in advance. For example, you might want to schedule 
a follow-up call five days after every contact receives a seminar 
invitation. The letter is the primary activity, and the follow-up call 
is the tactic activity. 

Note that all tactics must be set up as activities in the Activity win-
dow, just as primary activities are. 

By presetting tactics, every time you create an event using the pri-
mary activity, the tactic activity will automatically be scheduled as 
well. C.A.T. essentially uses the tactic activity to create an event 
for you. 

Preset tactics will help you automate routine activities, plan your 
strategies on projects, and save data entry time. 

Setting Tactics First enter or display the primary activity in the Activity window. 
The following example uses the "Seminar Invitation" as the primary 
activity. Then click the Tactics> button and the Tactics window 
will appear. 

c:]® Letten O Projects O MHtlng 
O Phone O Orlien O &enentl 

FIIW- -.,tion ---
li-=--i ....,_.....__; ---'IJ 
Pr--= 

You can preset up to four tactics. For each one, you specify: 

e The number of calendar Days separating the primary activity 
from the tactic. Enter a negative number such as "-2" for tac-
tics to be scheduled before the primary activity; enter a positive 
number such as "4" for tactics to be scheduled after the primary 
activity. 
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• The tactic activities. You can type the activity name or alias in 
the clairvoyant field, and C.A. T. will display names that match 
in the echo field (or click once to select an activity from the 
Activity List window; then reactivate the Tactics window). 

To schedule a follow-up call five days after the "Seminar 
Invitation" is sent out, you would enter the following: 

c:::J<I Letten O Projects O M1etlng 
O Phone O Dnl•n O lleMl"II 
~ -lnYII-

1· rm - I i-:!:.....--+--ofl:--------l -----·--
□ •llnlount QSODOQUnlts Qletlo IO,INT.vw ... _... 

,,_. .... , 
Then reactivate the Activity window and click Enter. 

Every time you create an event to send an "Seminar Invitation," Using Tactics 
C.A.T. will automatically create an event for you to make a follow-
up call five days later. These events will be displayed in the Events 
Snapshot window: 

Euent, Snop1hot 
omo,._ I •. " !!!i ~·.. = ~;::-:: og:_-- 0~1,1•-1120,- ei 

Q -- QIJ"n,.,.t:,,I __ 
~ llerlt/11-Do!Prlortty -

11/211/ff 10:DO -~---
,,,_ 

lflStw 1:111 ·---. =--I•-•- 1:111 ·--- .... 
" 
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Notes on Tactics Tactics can only be created when the primary activity is entered in 
the Event window or when using the Clone Events or Mail Merge 
commands. If you change the date of a primary activity that has 
already been entered, C.A.T. does not automatically change the 
dates of the corresponding tactics. 

To manually change a tactic date yourself, first display the tactic in 
the Events Snapshot window, then double-click on it. The Event 
window will appear with the record displayed. Make your changes 
and click Enter. 

Preset Rate & Amounts In the Event window, there is an Amount field that can be used to 
capture different types of numeric data. 
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You select the data type in the Tactics window when you create an 
activity to track amounts. For example, you could set up an activity 
called "Travel Expenses." When "Travel Expenses" is displayed in 
the Activity window, click the Tactics> button to display the Tactics 
window: 

There are four options in the 
lower half of the Tactics win-
dow which indicate how 
amounts entered in the Event 
window should be formatted 
on reports. 

Select: 

Ii 
CJ i) llmount O SOOD O Units O Ratio 
,..__, I I rt 

Amount 
$000 
Units 

to Indicate dollars and cents 

Ratio 

to Indicate thousands of dollars 
to Indicate a quantity; a rate per unit can be entered 
at the bottom of the window in the Preset Rate 
fleld. 
to Indicate non-dollar amounts Including numbers, 
Indices, or ratios. 

After you make your selection, activate the Activity window and 
click Enter. 

C.A. T. can be used to track time and will print time cards separat-
ing billable and nonbillable hours. For billable activities, be sure to 
select the Units option and enter an optional rate for this activity. 
{To learn how to use C.A.T.to compute elapsed time, see "Managing 
Time and Events" in this chapter.) 
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Settmg up activities in advance is necessary if you want to use pre- Auto Create Activities 
set text and tactics. However, you can also enter activity records 
"spontaneously" in the Event window. To set this feature, choose 
the Preference~ command from the Edit menu, select the 
"Automatically create ... activities" option and click OK. 

Once this option is set, you can type new activities directly in the 
Event window as you create new events. For example, suppose you 
are talking to a client on the phone who has just made a proposal 
for new project. You can go directly to the Event window and 
enter: the contact's name, "Proposal" as the activity, and details in 
the Note field. 

~ t/15/81 
Contiot: 

Aetivffv: 

Yogtl 
1 Sratog.o 7 1vifv ................ ._ •• ~ 

- ii ~ 
.___ _ __,I l!m 
□ Done ~~ 

When you click Enter, C.A.T. will discover that "Proposal" is a new 
activity and display the following dialog box: 

6 Craatlng HIii Rctlultu called 'Proposal'. 
Select cleH for this ectlulty: 

,--.,...L•..,.tt-•n-"""') [ Project, ] [.---M-■-•-tln_g___, 

Phone ) [ Orden ] [ General 

( Cancel ) 

Click to select the appropriate class and an activity called 
"Proposal" will be created for you. In this way, you can enter new 
activities as you need them while C.A.T. simplifies your data entry 
and helps you save time. 
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Managing Projects The following example illustrates how C.A.T. can help you manage 
projects. 
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Suppose you want to invite hundreds of people to a fund-raising 
dinner. You have already set up account and contact records for 
them and created a view. For each person, you want to send an 
invitation and schedule a follow-up call one week later. Further, as 
each person confirms attendence or declines but promises a dona-
tion, you want to record their expected attendence or donations. 

Start by creating the appropriate activities: 

Activity 
FIR Invitation 
FIR Follow-up 

FIR Attendees 
FIR Donations 

ExplaoaUon 
Set up a form letter with preset text inviting participants. 
The follow-up call. Preset this as a tactic seven days 
after the invitation is sent. 
An activity to record the list of attendees. 
An activity to record the amount of donations. 

To create a letter and schedule a follow-up call for every contact in 
the view, use the Mail Merge command. Then use the Print. .. com-
mand to print the invitations and mailing labels. 

Note that if you want to invite additional people after the mail 
merge, you just create events for each contact using "FIR 
Invitation" as the activity. 

To begin following up, display all follow-up call events in the 
Events Snapshot window. Double-click on the first one to display 
the record in the Event window. C.A.T. displays the contact's 
phone number in the upper right corner of the Event window. Make 
your follow-up call. 

If the contact will attend, click in the activity field and type "FIR 
Attendees." You can also enter the donation amount in the amount 
field, and enter other information in the Note field as needed, then 
click Enter. C.A.T. has linked this contact to the "Attendee" activi-
ty and unlinked it from the "Follow-up" activity. 

Select the next follow-up call. If the contact declines to attend but 
agrees to donate, click in the clairvoyant activity field on the Event 
window, change the activity to "FIR Donations" and enter the 
amount of the donation in the amount field. When you click Enter, 
C.A.T. has linked this contact to the "Donations" activity and 
unlinked it from the "Follow-up" activity. 
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Alterna&ively, instead of changing the "Follow-up" record, you 
could create new events to record attendence and donations. 
However, changing the activity lets you record the result of your 
call as well as the fact that you have finished the follow-up for this 
contact. 

You can use the Events Snapshot window to display events and 
print reports that show: 

• follow-up calls that still need to be made, 
• expected attendees, 
• labels for each attendee, and 
• expected donations to collect. 

Use the Merge Views command to create a view that includes all 
attendees. Then print an alphabetized account list. 

Further, you can use C.A. T. to develop additional follow-up letters 
that: 

• confirm attendence at the dinner or 
• confirm donations from contributors. 

C.A.T. makes possible the managing of highly complex projects. 
C.A.T. ensures that no step, vital or trivial, is overlooked. 
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M1naging Time and Events 
mdl$tion includes lots of examples. They show you how you 
Mtiuse C.A.T. commands and records to manage your daily 
events. You will learn how to: 

• Use C.A. T. to manage time; 
• :Record amounts in C.A. T. using the Cale button; and 
• Use the Event window to enter daily events. 

Managing time with C.A.T. is simple and powerful. You use the 
Calendar window to identify a date range of events. Then you use 
the Events Snapshot window to see the events within that range. 

Time Management 

For example, activate the Calendar window; point to the highlight-
ed day; and click. C.A.T. zooms to the Events Snapshot window 
and shows all events for the day. 

You can use the Calendar to identify a specific day, week, or month Day, Week or Month 
u the date range. The Events Snapshot window shows all events 
for the selected time period. 

You can scroll through time periods by clicking the Next button in 
tile date range field. For example, if you have selected a weekly 
time period, each time you click on the Next button, C.A.T. 

, iastantly shows the events for the next week. 

Managing Time and Events 

@ ~9/6 - 9/12/87 ~ 
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□~□ Work/To-Do/Priority When the to-do box is checked. you can quickly: 

• Scroll backward to see all events from prior weeks that need 
attention or 

• Scroll forward to see all events that are scheduled. 

Choosing a List of Events You can choose the events to see by selecting buttons in the Events 
Snapshot window and choosing values for each button. 
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You can select events for: 

• All contacts. all contacts in the current view. specific account. or 
one contact. 

• All activities. a class of activity, or one activity. 
• All time periods. a range of dates, or one day. 
• Work, to-do. or priority items; or any combination of items. 

® RII O Ul8l" ..... ® RH -•■Ii ® 
Q i;:>Ak.,.s Oro.. ~ Q ~.twig ,ej Q 
Q ~clc Fff'911Son ~ Q ~M:Bumt" Trip ~ Q ir-:,-:---=--=-:-=-rl 

Using a List of Events You can use the list of events to: 

• Find a specific event you need. 
• Use the list on-screen to take care of your "to-do" list. 
• Manage your time by reviewing all of the events scheduled for a 

specific week. 
• Use the Merge View command to convert event information into 

views that you can use for other projects. 
• Send an electronic report to a spreadsheet or another application. 

Printing a List of Events You can also use the events in the Events Snapshot window to pro-
duce reports. You can print: 

• An audit of an account by selecting one account. all activities. 
and a specific time; 

• Activity reports by selecting all contacts. one activity, and all time; 
• All letters, memos. and notes by selecting all contacts. the letter 

class of activities. and one day; then choosing the "All Notes" 
option in the Print dialog box; 

• A calendar of events by choosing all contacts, all activities, and 
one time period; and 

• Custom event lists by choosing any combination of settings. 
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Y0t1can,use C.A.T. in three ways to manage your to-do lists. In 
each cue. first identify the list of events you want in the Events 
Snapshot window as shown below: 

- Ennt, SneDlhot •• I gi£.fri I ~'g;ffil!:~!i 
CDD lfln/To-lo/Prlorlty -2/'rln •• lo 1'1:--

A• ff.f I :..-..Lt-
I-• 2 

___ ,., 
:-,.,.,... 2 

___ .,.__ ,, __ o,w 417S.rx 
ZIii/ff I ·--- :Col 
2112/ff T -·- 1'1:-

First, you can change the status of each event by pointing to the 
three status columns on the left and clicking to check or uncheck 
events. The columns have the following meaning: 

W Work Events that are checked have been changed during 
the current session. The "current session" is the 
time spent since you last saved to disk. 

T To-do Events that are checked mean that the item needs 
attention. To tell C.A.T. that the item is done, 
click on the check mark (✓) to remove it (like 
crossing out an item on a paper to-do list). 

P Priority Checked events have higher priority than other 
events. You click to checkmark the items (like 
highlighting important items on a paper to-do list). 

Note that on a color monitor, to-do, and priority items are displayed 
in color. 

By checking and unchecking events, you can update your to-do list. 

Managing nme and Events 

Handling To-do Lists 

Checking NJ Event Status 
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Changing Each Event Second, you can handle each item in the Events window. Click to 
highlight the first event on the Events Snapshot window. Click 
again on the highlighted record. C.A.T. zooms to the Event window 
to show the first event. 

The list of to-do events.:-::::!~!Pftllll------==:.=-:==~------......-1 The first event. 
Click on Next button to 

see next to do event. 

Reviewing Account History 
for Each Event 
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You can handle the event by: 

• Calling the contact (the phone number is in the center of the 
window); 

• Jotting down comments in the notes area; 
• Changing the date, time, or even the activity link information; 
• Clicking the Done box; or 
• Simply ignoring the event and going to the next event. 

If you make any changes, click Enter to record them. If you change 
the date or time, C.A.T. will automatically update the sequencing 
on the Events Snapshot window. 

To proceed with the next event on your to-do list, click the Next 
button in the upper left of the Event window. With a few clicks, 
you can deal with long to-do lists in an orderly fashion. 

Finally, you can use Merge View to convert your to-do list into an 
alphabetical list of accounts; then use the Events Snapshot window 
to display the history of each account prior to handling the out-
standing to-do item. You need this power feature when your con-
tact list becomes very long and you cannot recall the context of the 
specific to-do item. 

Let's go through this procedure step by step. 
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First. create your to-do list in the Events Snapshot window: 

Next, choose an unused view 
from the Views menu and then 
select Merge View from the 
Action menu: 

Enter a title for the new view, 
such as "To Do This Week"; 
click to select the Current<= 
Event operation; and click OK. 

To-do list for a week. 

A\.. M•rv• Ul■w,: l■l■ct • mod■ 
(l.;il and ■n operation. (H■ ra■nu■I 

for ■HDlonot1on1) u,o 
MODE OP[RIITION 
• Set • Work<• Curnnt 
O Marg■ O Work <• Eu■nt 
O lnt■n■ct O Curnnt <• Work 
OR■mou■ I OK J ..-tk----,-,~ ._ ___ __, 

eans convert the events on Events 
Snapshot into view with an alphabetical 
list of accounts. 

C.A. T. creates a view containing an alphabetical list of accounts associ-
ated with your to-do list and displays it in the Account List window. 

Activate the Events Snapshot window; set the buttons to show one 
account, all activities, and all time; and uncheck all status boxes. 

- £u■nt1 Snap1hot 
OHO._ ~RH (itRII 

e1 ►- ..... 
,... ..,,.,.,_T .-.i - ,.,, .,.0171111,..,7,nu-0 _, ....... -o 

I.DI.. lllarll/To-DolPrforltu --- ·- ·-•--- •:~ ... --
.... Iii ~ -·--- M:-
.... ,.--.-.~ ,_.,,.Ltlw 

1~ -111•""'"- :can 

= -Call report for each account in to-do list. 
Click Next button to review next account's history 
prior to handling to do event. 

C.A.T. shows all events for each account starting with the first 
account on your to-do list. Using the event information displayed, 
you can refresh your memory, account by account. 
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To proceed to the next account, click the Next button in the account 
field of Events Snapshot. 

You can now manage even the longest list of contacts and recall the 
context for each event. 

Amount Field The Event window can be used to record amounts in either the 
Amount field or the Note field. A single amount can be entered 
directly in the Amount field. Use the Note field to enter multiple 
formulas, and calculate the total using the Cale button. 

~ 1/15/N 
C.ntfft: t ------~-----_....., 

1aTinw 

Tracking Numbers For example, you could use the amount field to track key statistics 
for different companies or divisions. Start by creating an activity 
class called "Stats" and set up activities for key indicators such as 
"Revenues" and "Profits." Then create events by entering: 

CslcButton 

• Any contact at the company or division as the contact; 
• "Revenues" or "Profits" as the activity; 
• The key number in the amount field; 
• Additional details in the Note field as needed; 
• And then click Enter. 

To review key statistics, display the "Stats" class of events in the 
Events Snapshot window and use various combinations of the con-
tact, activity, and time options to list the events you need. The 
amount shows in the last column of Events Snapshot. 

By using the the Cale button in conjunction with the Note field, 
C.A. T. helps you compute totals for a variety of events including 
expense reports, orders, and quotations. The Cale button searches 
for amounts in the Note field; and computes and displays the total 
in the Amount field. 

The Cale button can also be used to compute elapsed time if you 
need to keep track of billable and nonbillable time. 

Examples of these uses are given below. 
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n, calcu1ato and track travel expenses, you could set up an activity Cslcu/atlng Expenses 
~ ,"'navel Expenses." Then create an event by entering: 

• 1bc Date of the expense record; 
• Your own name as the contact; 
• "Travel Expenses" as the activity. 

In the Note field, enter the expenses incurred: 

3/4 RT Airfare $311.84 
3/4 Car rental $39 
3/4 Parking $3.50 
3/4 Hotel $100 
3/5 Breakfast $5 
3/5 Lunch with cllent $25 
3/5 MIieage 45@$.25 

Notice that every amount must be on a separate line and must 
include a "$" sign. Amounts without dollar signs will be ignored. 

You can also enter negative numbers such as -$350 to record cash 
advances. 

Then click the Cale button: 

C.A.T. will search through the Note 
field for all amounts that include a "$" 
sign, then compute and display the 
total in the amount field. This total 
will also appear in the right-most col-
umn of the Events Snapshot window 
and print on event lists. 

! 495.59 ~ 

To print the expense report, choose Print from the File menu, select 
the "Letter/memo/note" option and click Print. 

If you want to print a list of expense reports that you have accumu-
lated over a period of time, display all of the Travel Expense events 
in the Events Snapshot window and print a custom event list. (See 
chapter 4 for more information on designing printed event lists.) 

To add expense items to an existing expense record: 

• Display the record in the Events Snapshot window. 
• Double-click on it to zoom to the Event window. 
• Add the items and amounts to the Note field. 
• Click Cale to compute the total. 
• Click Push or Enter to record the changes. 
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Using Formulas In addition to simple amounts, you can also enter formulas in the 
Note field of the Event window. 

A formula may contain one of the following math functions: 

+ 

* 
I 
@ 

Each formula: 

for addition 
for subtraction 
for multlpllcatlon 
for division 
for quantities 

• Must contain at least one$ (dollar sign) character 
• May not have any spaces in it (spaces identify the beginning and 

end of a formula) 
• May contain only one math function (with the exception of the 

@ operator). 

The following are examples of valid formulas: 

Formula 
55@$2.50 
200*$0.14 
-2.3*$14 
$17+$14 
$39.95/3 
$14-$12 

Description 
Quantity/Unit cost: 55 units at $2.50 each 
MIieage calculatlon: 200 mlles at $.22 per mile 
Negative numbers: -2.3 times $14 
Simple sum: $17 plus $14 
Division: 1/3 of $39.95 
Net difference: $14 minus $12 

In addition, formulas may contain the % operator. Depending on 
which math function you use, the % operator does the following: 

Operator Example 
+ $200+25% 

* 

23@$12+5% 

$14.95-45% 
14@$19-10% 

60% *$199.95 
23@$22*75% 
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Description 
Mark up the amount $200 by 25% 
23 units at $12 marked up 5% 

Discount $14.95 by 45% 
14 units at $19 each less 10% 

Compute 60% of $199.95 
23 units at 75% of $22 



Yoaca use formulas to compute "customer orders," "purchase 
orders.• lftd •quotations." First, set up activities for each item. 
Then create events to record each order or quotation. 

For each event, enter the buyer's 
or vendor's name as the contact; 
an order. purchase order, or quo-
tation as the activity; and set the 
date. Then enter formulas in the 
Note field as shown below: 

SalH Order Number: 
#123-32900 

Ship Via: UPS Blue 

Item 1: 14@$499.95-45% 
Item 2: 3@$649.50-45% 
Item 3: 3@$649.50-50% 
Bonus Item: Free. 

c::JO Latten O ProJect1 Q MHtlq 
0 Pllene • Onlen O ll■■enl 

r;x:. 
... 11per9a, ....... 1o4 

_,4 ... ,.. __ ,4 

Remember that each amount must be on a separate line and must 
contain a"$" sign. Click the Cale button. C.A.T. will automatical-
ly compute and display the total in the amount field. Then click 
Push or Enter to record the event. 

To print the order, choose Print from the File menu and select the 
"Letter/ Memo/ Note" option. 

To print a list of orders or quotes, display the appropriate set of 
ev~nt records in the Events Snapshot window and print a "Custom 
Bffllt List" (See chapter 4, "Printing Reports," for more on setting 
up printed Event Lists). 

You can also set up activities with preset text (see "Managing Activities" 
for information on setting up forms) to: 

• Set up quotations using a letter format with standard opening 
and closing paragraphs; 

• Create customer order and purchase order forms with built-in 
prompts such as "Order Number," "Ship Via," or any other infor-
;~~ you need; or 

• Desi,i custom forms for tracking information as needed. 

Managing Time and Events 

Orders and Quotations 

An activity with preset text and ref-
erences that is used for tracking 
purchase orders. 
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Computing Elapsed Time To compute elapsed time, first set up an activity called "Billable 
Time." In the Tactics window, select "Units" as the data type. 
Enter the Preset Rate for this activity, as well. 

Event starting time. 
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Click here 
to show 
Tactics. 

On printed event lists, C.A.T. will show hour, rate, and amount 
columns and compute total amounts (See chapter 4, "Printing 
Reports," for details on designing reports). 

When you create an event using "Billable Time" as the activity, 
Cale will assume that the Time field in the Event window contains 
the starting time of the event: 

~ •. =::;;;i~ai-ii:i:::~WTh-H 
s/Htl1sllon1U9h 

- Ill ~ 
~ . :1~arn•t:·Th:-·---··· 

□ Dona HIHBH 

When you finish working, click Cale button. The elapsed time of 
the event will be computed and displayed in the amount field: 

r O ..----.-------. [Lien I 

Aot1vtt11: 
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--•11114,tome C.A.T. while time is being computed, you can 
Olli,,_. to set the event record aside. When you complete your 
•. , .... , Pc»&t, to redisplay the record in the ~vent window, then 
clill M'Calc button to see the total elapsed time. - tr.t~-:: .;_t, 

Ym ._,._ tbis feature for project management or to track billable 
Clme. Bach time you click Cale, the new elapsed time will be com-

fid. 
C.A.T. is not an accounting system. It is a personal information 

_ lfllOm that can be used to record and simplify your accounting-
related activities. For example, you can use C.A. T. to: 

• Track billable time (printing or electronically sending your time 
card to your accounting department for billing); 

• Take sales orders (printing or electronically sending your own 
order forms); 

• Track travel expenses (printing an expense report to submit for 
reimbursement). 

C.A. T. is designed to track the information you need. 

Managing Time and Events 

Accounting Data 
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Daily Events C.A.T. can be used to manage a variety of daily events, ideas, and 
information. The following are just a few examples. 

Phone Messages Phone-message pads are commonly used to jot down notes as you 
talk on the phone. Often, a conversation will require follow up or 
include facts that you would like to record for future reference. 

At the end of a day, review your phone messages and select relevant 
messages for inclusion in C.A.T. For each message, create an event 
using: 

• The name of the caller as the contact; 
• "Phone Call" as the activity; and 
• Enter the information you wish to remember in the Note field. 

In particular, sensitive issues that involve contracts or delicate 
negotiations may require the accurate logging of conversations. For 
these situations, you may wish to create specific activity fields that 
help you categorize the events associated with the subject matter. 

Meetings To schedule a meeting, create an event by entering: 

• The date and time of the meeting; 
• The name of the person you will be meeting, as the contact; 
• "Meeting" as the activity; and 
• Other information (i.e., agenda, participants) in the Note field. 

Recurring Meetings C.A.T. can also be used to schedule recurring meetings. For exam-
ple, if a committee meets every Wednesday, create an event by 
entering: 

• The date and time of the next meeting; 
• Yourself or the committee chairman as the contact; 
• "Committee Meeting" as the activity; and 
• Enter other information as needed in the Note field. 

Then click the Recur button in the Event window and a dialog box 
will appear. Click to select the frequency of the meeting and it will 
appear in the field just above the Recur button. 

C.A.T. will show the event on the Events Snapshot window every 
Wednesday until you change the information. 

Mlscel/aneous To-do Items To set up a list of miscellaneous things to do, create an event by 
entering: 

• The date on which the items need to be acted on; 
• Yourself as the contact; 
• "To-do List" as the activity; and 
• Enter the action items in the Note field. 
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• talk with people, ideas come up that may be use- Tracking ldsas 
ts. Too often, the ideas are forgotten before you 

about them. Create an event by entering: 

e source of the idea as the contact; 
· subject (i.e., marketing strategy) as the activity; and 
the Note field. 

·c.ao manage lots of ideas without slowing you down. Create 
y events as you need and enter notes in sufficient detail so 

· idea is fully described. 

!~ you need the information, use the Events Snapshot window to 
·~8-d-telated ideas, examine them, and print reports to help you get 
· die new project off to a flying start. 

C.A. T. can be used to track text from other software. For example, Text From Other Products 
you can copy spreadsheet cell values into C.A.T. and store them in 
the Notes field of an event. Similarly, you can store messages from 
electronic mail systems in the Notes field of events, rather than cre-
ating a separate document on disk for each message. 

In these cases, you use the Copy and Paste commands available in 
most applications to copy text information and paste it into the 
Notes field of an event record. 

C.A.T. sorts all events by contact, activity, and time; so that you can 
find your data -- easily. 

C.A.T. can be used to produce form letters and mass mailings. 
Unfortunately, form letters are often associated with the negative 
image of "junk mail." Using C.A.T., you can elevate your efforts to 
develop relationships with people. 

The relationships that you build with people and their perception of 
you affect your ability to achieve the goals in your life. 

C.A.T. enables you to produce notes, hundreds per week, that let 
your contacts know that you are thinking of them. As you read, 
think, and talk with other people, you can produce short letters that 
tell people you understand their needs. For example, when you 
telld a news story that may be of interest to one of your contacts, 
you can make a copy of it and prepare a short letter in C.A.T. 

Managing Time and Events 

Final Note: 
II Power Marketing 
With the Personal Touch" 
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To simplify writing letters, you could set up an activity called 
"Standard Letter" that includes references and preset text. 
Whenever you want to send a letter, enter a new event in the Event 
window with the following information: the name of the contact 
and "Standard Letter" as the activity. 

The letter will appear in the Note field with the contact's name and 
address automatically filled in. You only need to type in your note 
and click Enter. Even if you use form letters with preset messages, 
you can still add that personal touch by inserting an extra sentence, 
a "P.S.," or other greeting. 

C.A. T. allows you to print documents as you create them. Or you 
can print all of your correspondence at one time at the end of each 
day as follows: Using the Events Snapshot window, display the 
events you wish to print by selecting the current date, and the 
appropriate contacts and activities. Then choose Print and select 
the" All Notes" option to print all letters, memos, and notes. It will 
only take a few minutes everyday to sign and mail all letters. 

With some diligence, you can send hundreds of notes per week that 
help you keep in touch with key contacts in your industry in a per-
sonal way. That's power marketing! 
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Printing Reports 

C.A.T. provides reports to help you manage information. This chap-
ter is a reference for printing procedures, report options, and report 
examples. 
Some reports have built-in formats; others you design yourself. 
Built-in reports include: 

• Dossiers and Calendars; 
• Letters, Memos, and Notes; 
• Mailing Labels; and 
• Activity List and Lookup Tables. 

Custom reports include: 

• An account list generator that lets you sort, group, and select the 
contacts to be included in, for example, a phone directory. 

• An event list generator that prints various reports of your own 
design, such as call reports or a subscriber list. 

For each report generator, you can design up to four reports for reg-
ular use as part of the standard print menu. 

To print your company name and address at the top of reports, Company Logo 
choose Options from the Enter menu. You can also include a logo 
if you wish. (See "Creating Your Own Logo" in appendix C.) 

C.A.T. uses the standard Macintosh dialog boxes. These boxes dis- Print Dialogs 
play and control printer options for the Image Writer or LaserWriter. 
Different versions of the Macintosh print dialog box will show dif-
ferent options. If you have any questions about printer options, 
check your printer manual for help. Note: Non-Apple printers have 
not been tested for compatibility. 

Before starting to print any report, note the following standard 
Macintosh printing conventions. 

• Use the Chooser desk accessory from the Ii menu to designate 
the printer you will be using. The Chooser lets you connect sev-
eral printers to your Macintosh through the AppleTalk network. 
Bach printer may be preloaded with different kinds of paper. 
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For example, one printer could be set up with address labels; and a 
second printer could be set up with your company letterhead. 

• Use Page Setup from the File menu to set various page options. 
For example, you can change paper sizes, print orientation, etc. 

Consult your Apple manuals for detail. 

/mageWrlter If you are using an Image Writer, note the following: 

LaserWrlter 

canceling Print 

Fonts, Sizes & Styles 

• To set the true "top of form" for printing, align your paper, then 
turn the printer off and on again. 

• Make sure you have enough space on your disk for the spool 
file. Typically, you will need 30K or more bytes of free space. 

• Note that C.A.T. does not support the Draft mode for printing 
letters, notes on reports, borders on reports, or mailing labels. 

For fastest results when printing with the LaserWriter, choose fonts 
that are preloaded on the LaserWriter. The minimum LaserWriter 
preloaded font selection includes Times, Courier, and Helvetica. 
The C.A.T. default font, Chicago, is designed for use with the 
Image Writer and is not available as a preloaded font on the 
LaserWriter. Consult your printer manual for more details. Using 
only preloaded fonts can reduce report printing time by 50%. 

During a print job, you can cancel printing by clicking the Cancel 
button or pressing the Command and . (period) keys together. 
While printing mailing labels, canceling may require several clicks 
on the Cancel button. 

You can design your reports so that you can print different segments 
of your report and letters in different fonts, sizes, and styles. For 
example, you can have your company name italicized, the address 
smaller, and different styles for the subtitle, body, and subtotal sec-
tions of your reports. 

C.A.T. is not a full-featured word processor: You do not have font 
and size control over each word in a letter. 

You use the "Set Format" com-
mand to control font, size, and 
style selection. When you choose 
Set Format from the File menu, 
the following dialog box appears: 

Chapter 4: Printing Reports 

A\. Set Format: Select the type 
~ of reports to format. 

( Letten/Notes ) Reports ) 

Tntuel Size ) ( Full Size J 
I Cencel I 



Trawl Size 
· • Travel-size Dossiers 
:••Travel-size Calendars 
• Malling Labels 
• Lookup Tables 

Reports 
• All Account Lists 
• All Event Lists 
• Activity List 
• Lookup Tables 

Full Size 
• Dossiers 
• Calendars 

Choose a button and C.A.T. presents the following dialog: 

REPORT FORMRT: Select sections to 
change. Sat font, size, style. Click 
SET. CIiek DIC to 8Hlt. 

□ 
□ 
□ 

0 ColmnnHn4ei:s 
NUiis 0 Bad:, of Report 

0 lldnnJI 

□ 

Amount 

s,000.00 
5,000.00 

CatFont 
Chicago 
Geneua 
Heluetlca 
Monaco 
Times 

Q9 □ Bold 

010 D Italics 
0 12 D Underline 
0 14 D Outline 
O 18 □ Shadow 
O 24 D condense 
QCustom LJ 

( Set I (Clear} ( DIC } Left Margin~ Top Margin~ 

The box presents a typical report divided into seven major sections. 
On the left are seven check boxes -- one for each section. Check 
one or more sections; select the font, size, and style; then click Set. 
When the sample report suits your preferences, click OK. 

About Printing 

Using Set Format 
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Print Command 
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For each report, the sections are used as follows: 

B1g2ct !)'.gt .Lmm .flWll1 Dossier Calendar Lllw 
Report Title NIA Yes Yes Yes NIA 
Company Yes Yes Yes NIA Yes 
Address Yes Yes Yes NIA Yes 
Column Header NIA Yes Yes Yes NIA 
Subtitles NIA Yes Yes Yes NIA 
Body of Report Yes Yes Yes Yes Yes 
Subtotals NIA Yes NIA NIA NIA 

To select reports to print, choose Print from the File menu. The fol-
lowing dialog box will appear: 

<c!» Check all reports & options: 

Contacts in Current Uiew: 
D Dossier O RII dossiers option 
O Truuel size Dossier O Labels for Uiew 
D Custom Recount # 1 O Custom Recount #3 
D Custom Recount #2 

Euent Snapshot: 
OCnlendar 
O Custom Euent #1 
D Custom Euent #2 
D Letter/memo/note 

D Lookup Ualue List 
D Rctluity List 

"'(( -Pr!!!in!!!t!!!J~ 

D Custom Recount #4 

O Truuel size Calendar 
O Custom Euent #3 
O Custom Euent #4 
D All Notes 
O Labels for Snapshot 

[To Screen) [ Cancel ) 

Just click to select the reports you want to print, and uncheck items 
that you do not want to print. 

The reports in the upper half of the dialog box are affected by the 
view displayed in the Account List window. If the window shows: 

• All accounts, then the reports you select will include informa-
tion for all of the accounts in your database. 

• The Current View, then information will be printed for the 
accounts and contacts in that view only. 

• The Work view, then information will be included for checked 
accounts and contacts only. 
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!.'11111.....,a the lower half of the dialog box are affected by the 
vicw of evenradisplayed in the Events Snapshot window. For ::•Nie. you can print a calendar for a specific day. Other reports 
~:,~ information for the contacts and activities selected. 

,,.'Eookup Code" and "Activity List" reports are for your refer-
ence. 
At dl&bottom of the dialog box are three buttons. After you make 

.JObf·SClections, click: 

• Print to start the printing sequence and send reports to a 
selected printer. 

• To Screen to send each selected report to the screen so that you 
can check the page layout prior to printing. 

• The Cancel button to cancel the Print command without print-
ing. 

If you attempt to print and nothing happens, check the following: 

• Make sure the printer is on and ready to receive reports. 

• Check the cable between the Macintosh and the printer to make 
sure it is fastened securely. 

• Exit C.A.T. and use the Chooser command (under the• menu). 
Then test the printer from the Finder by choosing Print Catalog 
from the File menu. Note that Print Catalog is not a C.A.T. 
command. If nothing prints, you have a printer incompatibility 
problem. Consult your local dealer. 

• Once a year, check the batteries in your Macintosh. Weak bat-
teries could cause problems relating to printing. 

If the printer shows garbage, make sure you are using an Apple cer-
tified cable. Also, make sure you have the right cable for your 
make and model of printer. The wrong cable prints garbage. 

About Printing 

Trouble-shooting 
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Dossier A dossier is a history of an account. It can include account, con-
tact, and event information with notes (if any) for each. 

Event Options You control the event records to be included by setting the activity 
and time options in the Events Snapshot window. Information will 
be printed for all of the events currently displayed in the Events 
Snapshot window. 

Report Options To choose what sections of the dossier to print, choose Dossier 
Options from the Edit menu. The following dialog box will appear: 

43>,. Dossier Options: Check the sections 
· · to include. · 

181 Address Block 
181 Contact Names 
181 Snapshot Euents 

._I( iiiiiiiiiiiiiiioK __ ;;J) 

181 Recount Note 
181 Contact Notes 
181 Euent Notes 

( Cancel ) 

You click to check or uncheck items. Make your selections and 
click OK. 

Size Options To print dossiers in full size (8-l/2"Xll ") with account, contact, 
and event information on one page and notes on a second page, 
select the "Dossier" option in the Print dialog box. 

To print a travel-size dossier (7"X7") with all information on one 
page that can be trimmed to fit in typical pocket calendars, select 
the 'Travel Size" option in the Print dialog box. 

To print the travel format using the full length of the page (i.e., 7"X 
11 "), set Preferences from the Edit menu. 

Format Options To change the fonts, sizes, and styles for a dossier, use Set Format 
from the File menu. Select the Full Size option to format full-size 
dossiers; select Travel Size to format travel-size dossiers. 

To produce page sizes that suit other travel-size notebooks such as 
Junior Page, European format, or other needs, use Page Setup from 
the File menu. 

Chapter 4: Printing Reports 



If-~!'.print a dossier for one specific account: Printing Dossiers 
•; 

1 
• , '8 highlight the account in the Account List window. f ,year options, then choose Print from the File menu. 

1 f..,,11tpdntdialog, select "Dossier" or "Travel Size Dossier." 
' l~~a.:.1.. Print. 11 \;..-.~ ·i~t.-.;;.::::::::,:,~::::'.• a view: 
l~ options, then choose Print from the File menu. 

. 
ti.., '.'.,-:.clialog box, select "Dossier" or "Travel Size Dossier." 
!lekc('die "All Dossiers" option also . 

• t..._ Ii '-Pri ,,,, .. .1.-i C CA nt. 

,~;.tilting of all dossiers is interrupted and you want to resume 
(fen a specific account, select the "Start with current ... " option 
from Preferences under the Edit menu. Then activate the Account 
I.;:ist window, highlight the account to resume printing with, and 
chbosePrint. 
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Full Size Dossier: 
DOSSIER 

415-982-tOOO 
MarbtPlaza 

IUd,mood, VA 78303 •••••..••.••••..••••.••.......•.••.•••••............•...........................•..•............................. 

NAME TJTLE PHONE 
NcbonLco CEO 415-982-1234 
Carl Mann Nat'! Account Mgr. 415-982-432! 

~ackie Smith •••••......•••••...••••.•.••••••••••••••.•••.••..•.•• Specialist ••••••••.•.••••••••••••••.•.• 415-982·1432 ••••••••• 

~ DAn TJME R NAME ACTJVTTY AMOUNT 
1 9(23/P,, 3:16J I.JI: ~Call 
' 9(}2,/8"', 11:3' Smith IL,:Scminar lnvitatiai 

U~S/8 11:3' Smith P:Pallow-up Call 
< 10/29/8 12:3 Mann P:Call 

.... ~ ····11/11/8'; ········1i~ . Smith······· L:StmdlrdLcucr······························ ......................... . 

•••• f •••• 12/lWS, .••....• 2:231 'UI:··········· 0:Plln:huc Order .••••••••..••••.•••.•••...... ··•·•••••••••·· 4,175.00 
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t-lOTRS: 

5: ...................... ___ ................................................................................................... . 
Blll:laoocl pleuo find ti» 1D1110ria11 you~ fer your~ m Nowmbor 20lli. If you 1,a.., ony 

• cpialllom, foal flee 1D call mD any limo ......................................................................................... . 
• 6: •••••••••••••••••••••••• ............................................................................ . 

... 12Jl(W7 ........................................................................................................... . 
··1,1a,······ .. ·••••··•·•··•••·••••·• .. ··••··••••••·••·•·•·••·•••·····••·••·•·•·•••••••••••·•••·•·•••••·•••••·•••••••••······••·•·••···•• 

----·································· ................................................................................... . 
•• 32' .................. ·-----···· .. ··•••··•••·• ..................................................................... . 
.. Net 30 ................................................................................... . 
.. UPS......................................................... . ....................................................... . 

•-----················· .. ·········•·· .. ••·••·········•···•··············•····••···••·········•····· ...................... . s- /uAbavo ...................... ---······· ... • •••••••••••.•••••••••••••••••••••••••••••••••••••••••••••••••••• 

----···································································· --------········ .. •·•••···••···••··•····•······································································ 
15 Widptll ..... 175.00 ......... 4,12.S.OO •••••••••••••••••.••••.•••••••••••••••••••.•••••• .._ __ 

,o.oo······------·----·············································· 
••• ... .... .... .... ... .... ••• ••• •• 4,175.00 •• -----·············································· 

,------------·---·················································•······· ......................... ·------··············································································· 
---············· ....................................................................................................... . 

••·····••·· .. ·•··••····•···•···• ......... .._ __ ................................................................................. . 
-----·························· .. ···········•···•····························•·····•···············••·· 

----····················································································· ----.. ··•········· ...................................................................................................... . 
----·········································---························································ 

---················································································ 
■-••• .. ••••--•• .... •• .. •••••••• .. •----•• .. • .. •••• .... •HHoO■■■ ouH••••••••••--•--••--•••••••••••n•--•••--~ 

1---.. ••••••••H■ oH•••••••••••• .. •• .. •--• .... • .. •• .. ----• .. ••••••••••HHHoo•••••••••••••••••••• .......... . 

------·············································································· 
....................... ·-------················································································· ---············· .. ········ .. ··•······· ... · .................................................................................. . 

................................... •······························------············································ 
---····························································································· 

-------------·············································································· 
----················································· .. ········································· 
------·················································································· 

---------········································································· .. ········•····•····•· 

Report Reference 

Full Size Dossier Notes: 
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Travel Size Dossier: 
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NOTES: DOSSIER 

4t5-9S2-t000 .~.:................................................................. ~lass :liltos. -------+---------! 
&doood p1._ find die 1Dffrial1 you rcquamd fer 
your piaentatian on November 20th. If yw ha"" 

• my question1, liocl ua:.to call me my limo •••••••••••••• 

·6,································································· 

17/10/87 ··1s119·---······· ................................. . 
----········································· 

1------········································· 
---····················································· ···324············· ............................................... . 

Not30 ··UPS····· ....................................................... . 

•• Samo M.Abavo ·---····· ..................... . .......................................... ___ _ 
::::~:~ .••.•••• Widgot1. Z,5.00 •••••••• 4,175.00 .• 

so.oo 
----··············4,175.00 •••••••••. 
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1 Market Plaza 

Richmond, VA 78303 ................................................................... 

NAME T1TLE PHONE 
NellonLeo CEO 1415-982-1234 
Carl Mann • Nat1 Aoooun11415-982-4321 
Jackie Smith ............ Specialist ... 415-982-1432 ••• 
............................... ___ _ 
,. DA) NAME ACTIVITY AMl 
19/'13/ll,,o P:Coll 
~ iri,sii Smith.... L:Semina: Invitation. • .....••••.• 

3 lWSI! Smith P:Follow-up Coll 
4 1W29 Mann P:Call 
• ll/11 Smith L:S1Jaldan!Lcua: 

• f 17/10. Leo······· 0:Pun:buc Older...... 4,175.00 



You can choose to print labels for the contacts currently displayed Mailing Labels 
in the Account List window or for the people associated with events 
currently displayed in the Events Snapshot window. Each label can 
include the following lines of information: 

• Contact's first name, last name, and mail stop (if any), 
• Title of contact, 
• Account name, 
• Street address (could be multiple lines), and 
• City, state, zip and country 

Choose Label Options from the Edit menu and the following dialog Label Options 
box will appear: 

A Label Options: Check the 
lines to Include. 

D First Lest Name /Mail Stop 
OTitle 
D Recount Name 
D Address 
D City, State and Zip 
D Country 

( OK D [ Cancel ] 

You can click to check or uncheck items. Make your selections and 
click OK. Note that a mail stop (if any) will print on the same line 
as the contact name and a country code will print on the same line 
as the city, state, and zip code. If the contact does not have a title 
or country, C.A.T. will automatically skip the line on the label. 

You can use this label utility to print name tags for seminar partici-
pants or cocktail parties. Check only name, title, and account; and 
make the fonts bigger so that they fit your labels. 

If you have international contacts, set Preferences under the Edit Country Options 
menu to tell C.A.T. that lookup table 1 contains country codes. 

Labels can be printed using different fonts, sizes, and styles. The Format Options 
"Travel Size" option under Set Format controls mailing label fonts. 

To print labels, C.A.T. supports the Image Writer only. In order to Page Setup 
print labels correctly, choose the Page Setup command from the 
File menu and select the "No Gaps Between Breaks" option. After 
printing labels, remember to uncheck the option in order to print 
reports correctly. 

Report Reference 4-11 
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Labels tor a View To print one label for each contact in the current view: 

• Display a view in the Account List window. 
• Choose Page Setup from the File menu and select the "No Gaps 

Between Breaks" option. 
• Select your other options, then choose Print from the File menu. 
• Select the "Labels for View"' option. 
• Click Print. 

(On the Image Writer, note that C.A.T. does not support printing 
labels in the Draft mode.) 

Labels will print in alphabetical order by account and contact name. 
If certain labels fail to print, make sure that you have selected con-
tacts within the account for the view. A contact selected for the 
view has a check mark beside his/her name in the Contact List win-
dow. 

If printing is interrupted and you wish to resume from a specific 
account, select the "Start with current ... " option from Preferences 
under the Edit menu. Then activate the Account List window, high-
light the account with which you want to resume printing, and 
choose Print again. 

Labels for Snapshot To print one label for each person connected with the event in the 
Events Snapshot window: 

Sample Label: 

• Make your selections in the Events Snapshot window. 
• Choose Page Setup from the File menu and select the "No Gaps 

Between Breaks" option. 
• Select your options, then choose Print from the File menu. 
• Select the "Labels for Snapshot" option. 
• Click Print. 

Labels will print in chronological order by event. 

If printing is interrupted and you wish to resume from a specific 
event, select the "Start with current ... " option from Preferences 
under the Edit menu. Then activate Events Snapshot, highlight the 
event to resume printing with, and choose Print again. 

Chapter 4: Printing Reports 



Account Lists are reports you design to print account and contact 
information. For example, you could print a customer directory. 

Each report prints using the view currently displayed in the 
Account List window. Accounts within the view may be grouped 
using one of the eight lookup tables for the account record. 
Accounts can also be sorted alphabetically by name, city, state, zip 
code or alias. If no other option is selected, by default, accounts 
are sorted by name. 

To design a report, choose Account List Options from the Edit 
menu. The following dialog box will appear: 

List Options: Click the report to change. 

Custom 2 L."'"~_c_u_st_o_m_l ___ ][ _______ _ 

[ Custom 3 ] [ 

New lltle: I Customer Directory 

( Cancel ]) 

Custom 4 

] 
] 
I 

• If you are creating a new report, enter the report title, then click 
one of the four buttons. The report name will replace the button 
name in the dialog box shown above, appear in the Print dialog 
box, and become the report title. 

• If you are changing an existing report, click one of the four buttons. 

~ Recount List Options: Check the 
· · fields to include. 

181 Hlias 181 He count 181 Address 
181 City 181 State 181 Zip 181 Phone 

181 Contact 181 Title 181 EHt. 
181 Leuel 181 Table-11181 Table-12 

181 Country 181 Table-2 181 Toble-3 181 Toble-4 
181 Table-5 181 Table-6 181 Table-7 181 Table-8 
SORT BY: GROUP BY: 
@Account O I O 5 
QCity 02 06 
QStote 03 07 
QZip 04 QB 
O Hlias (i) None 

I( OK ;J 
( Cancel ) 

Report Reference 

Account Lists 

Report Options 
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In the upper part of the dialog box, you see the columns that can be 
included in this report. C.A.T. automatically controls the width of 
each column. For example, if you want to include a lookup table as 
a column, C.A.T. determines the width of the column based on the 
width of the entries in that table. 

Sorting On the bottom left is a set of buttons for controlling sorting. For 
example, if you select "State," C.A.T. will list your accounts by 
state. 

To the right is a set of buttons numbered 1 through 8 for grouping 
accounts by lookup table. Each table value will be printed as a cen-
tered subtitle. Select None if you do not wish to group your 
accounts at all. 

You can click to check or uncheck items. Make your selections and 
click OK. 

Fonnat Options To control the fonts, sizes, and styles for a report, choose Set 
Format from the File menu and select the "Report" option. 

Viewing on Screen To preview the overall width of your report, use the To Screen but-
ton on the Print dialog box. Use Page Setup to set the actual paper 
width. 

Printing Account List To print an account list: 

• Display a view from the Account List window. 
• Select your options, then choose Print from the File menu. 
• Select one of the four "Custom Account List" reports. 
• Click Print. 

Chapter 4: Printing Reports 



••~ eofP. 
1526 Grove s-

Cuperlino, CA 95643 

Clllblwotwaa,y 

hb 13, 1SIBB 

CITY PHONE catTAcr .,. 
~ 41S.994-0183 Dick Fergu,on Praidml 

HanyMcDanald 5--.y 
Mildnidl'ack VicePraldent 

Cupertino 408-867-9375 Michael Amone.Jli Attorney 
Bloomlnaton 714-339-8349 Kirby Armstrong Praidmt 

Kai Roth Vice Praidcnt 
Trilha Steva11 Operatiom Mgr. 

Campbell···· 408-534-9686 Bill Brodie ·•••• 1:1111bcici'· ........... . 

M11111I 

Kriatin Brodie Dqbl,r 
Till Brodie 

612-338-0700 Clary FIICber 
Karen Hell..-
Su111nMoffett 

S■1eaM.,.., CEO •.••••••• 

Vicel'raident 

"Qriltlan,en S-Clara 408-776-9333 Ka!hy Cbriltiamm 
•c-r--==Tecbn~""ica...,..l ---=Fb"'i1'"1d_,.e.,.lph'"'i'••--,.603-:,:-,:22:=:-l•·i2i9··MadcKamedy Praidmt 

Secretary •.•••••••••.• 

SlaCey Linder Marketina; 
Dmllan l!ntmpril• 415.822-5321 Tom Palladin CEO...... • •...• 

lld Sherman Vice Praident 
Aaron Smith S■lea M■nase, 

S■n1aClara 41s.696,'.i98'i··u;~ii,c;i;;···············Tecbnical Suppori. 
Pred Lms !'"IIIICO 

---RIii-sell Klnbncr Vice Praldent • 

BriuOmm Speci■Jin 

Glenn Topper Praidmt 
41S.267~ Alm Poprty Secretary 
213-448-9323 M■--aiillill S«:tmtry ............ . 

Sharon Leigb Vice Praldent 
.JuJtin Rooney Praidmt 

Olua Bn11. Ric:bmcmd 41S.982-1000 Nuon Lee • ••••·•···•·· ·cEO ·····••·••········ 

Carl Monn Nll'I AccCIIIDI 
J■ckie Smith Speci■li1t •••••••••••• 

Gould Deligm Sllllla Cruz 408-338-6422 Mike Gould 
"'0n'""am.,.--.::..-----Cam,,,..--pbel~l· 408-584-3303 AlliJOn Clnham •••••••··••·•••••·•••••··•·•• 

• Hmper Pmdudl San Pr■ncisco 41S.923-5688 Bill Kirkpatrick CEO 
1uJtin Pub Vice Praidmt 
M■rlee Thompson Secretary 

Sacramento 712-441-6755 Bernie Hitcbcock ••••• fflllbcid ·•·••••··••··• 

Dina Hitcbcoc:k Daugbta-
D■vid Hitdicoc:k Son 
Sylvi■ Hitcbcock 

Report Reference 

Sample Account List: 
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Calendar The Calendar report shows your schedule for one day or a range of 
days. 

The events printed on the calendar are determined by the events 
shown in the Events Snapshot window. 

For each day, C.A.T. prints a one-page calendar that shows each 
event and the associated notes which can be your agenda for a 
meeting or figures for a sales call. Optionally, you can include the 
address and phone number for each event so that the calendar can 
be used as a travel aid. 

CB/endar Options To choose what items will be printed on the calendar, choose 
Calendar Options from the Edit menu. The following dialog box 
will appear: 

Calendar Options: Check the 
sections to Include. 

181 Hddress & Phone # 

181 Euent Notes 

Cancel ) 

Make your selections and click OK. 

Size Options To print calendars in full size (8-1/2 "X 11 ") with events, addresses, 
and phone numbers on one page and notes on a second page, select 
the "Calendar" option in the Print dialog box. 

To print calendars in travel size (defaults to 7"X7") with all infor-
mation on one page, select the "Travel Size Calendar" option. Each 
page can be trimmed to fit in typical pocket calendars. 

To print the travel format using the full length of the page (i.e., 
7"X 11 ") see Preferences under the Edit menu. 

Format Options To change fonts, sizes, and styles for a calendar, use Set Format 
under the File menu. The "Full Size" button controls the selections 
for the full-size calendar. The "Travel Size" button controls the 
selections for the travel-size calendar. 

Use options on Page Setup to produce sizes to suit other travel-size 
notebooks (such as Junior Page or European format) or for other 
needs. 

Chapter 4: Printing Reports 



ro•·-specific calendar: 
·! • . ! 'l'·Deable-click on a day in the Calendar window. t rseteetevents in the Events Snapshot window. t ·:1e1ect your options, then choose Print from the File menu. 
t jJelect the "Calendar" or "Travel Size Calendar" option. 
t : tlick Print. 

fo print a calendar for a range of days: 

• Double-click on the Goto arrow for the date range in the Events 
Snapshot window. 

f Set the range and click OK. 
• Select events in the Events Snapshot window. 
• Select your options, then choose Print from the File menu. 
• Select the "Calendar" or "Travel Size Calendar" option. 
• Click Print. 

Report Reference 

Printing calendars 
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Full Size Calendar: 
Wed, Nov 18, 1987 

... .11,CT1VITY 

Mcming 

1 ll:3C Racbol Zimmonnm M:L,mch 
Zimmonnm ~OMootgomorySL 
SanPrancilco ~lS-771-1069 / 

, 11:3! Gary Pischor P:Pollow-up Call 
8W1inca Conmunicatiooo, 378 Arguollo Blvd. 
IMiami 612,-338-0700/ • • • •• ........ ................. .................................... ......................................................................... . 

Aftomoon 

' 12:0C Phillip Yama10 ~Seminar 
• YIDIOID 1899MariottaDriw, •••••••• 

Loa Alm ~lS-241-8550/211 

.•..• 4 ......... l.OOfJoeSmnple •....•......•..•.••.. M:BoudMoeling···················································· 
Sample ~35 Ccrbctt A""· 
Cupertino i◄OS-665-6682 /219 

........ ........ 6.30J: Hal Sullivan •.......•.•••.....• IM:Businca Trip ..........•.••.................•...•.•....•.•••..••.. 
U.S. lllcclronics 5221 Cenb'll Aw, . 

........ ................. Homton························· 203-776-1074/ .........•....••.••.•.........•..........•••...•••..••. 
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·-----------------····························· 
,!=......,._ .................................... . 

----fll-............. . r· ·---------------··································· 
·--------········································ 

...__" __ .. _ ............. _________________ _ 
---·"-······ .. ··,----·----------------__ "_ ................... ·---------·--------------._ ___________ , ____________ _ 
---··--·-····----·--·--·-------,__ ...... " ....... _________ _ 

1------------------·································· -----------------···················· .. ·-------~ 
, ____________ ......................... ,------------~ 

,----·············································· 

·--------······························'-----···· ............................................. . 
1-------------------····································-----,-----················· .. ····------l 1----------------------··········· .. ···············---~ 

,---····-············· 1-··------------·········· ... ··········------

,----············,··········· 
,---···················· 

,-----------·····················-------1 
1------------------···································------~ 
1---------------·····························································----1 

,--------------····················································· 

Report Ref ere nee 
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Travel Size calendar: 
!NOTES: Wed, Nov 18, 1987 

1: .tA T/MANAME 1'1CTIVJTY 
Joe's Seafood, on Montgomery and Sansomc: 

· 2: ·•·•··••·••··•··················································· t-,----,----M_oT"m_in_:g:.__ ____ ~ 
How contract progn:ssing? 1 11 :31 Zinnncnnan IM:Lunch -~=~:=·:=·;~·~:;:::················ ... ·········· ~-=~~-~~~=St ........ . 

• 5(································································ . : 11 :3! Fiochcr P..Follow-up Call 

• Ovcncc installatioo of now system........................ Busim:ss 378 Arguello Blvd. 
............. Miami ..••••.. 612-338-0700 / ··············· 

Janet will be out of town. • ••••••••••••·•• 

····································································· l-''----'------L---------1 
Aftcmooo 

····································································· 1--r-,-1-2:-,-0CY-amato--~P-,Scminar--. -------1 
Yamato 1899 Marietta Ori"" 

.........•.•. Los.AllcJI .... ~15-241-8550/211··········· 
, .... 1,ooj Sample ....... M:BoardMccting············· 

Sample 435 Ccrbctt A""· 
· Cupertino 408-665-6682/219 

...... 6:3oj ~~'.van ..... ::iu:-.:iT:~ ........... . 

... .......... Houston ...... '1iJ3-776-HJ/4 / .............. . 
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Event Lists are reports of your event records. You can use this Event Lists 
report generator to design call schedules, sales reports, travel 
schedules, seminar lists, portfolio valuations, statistical analyses, or 
a variety of other reports. 

Each report includes the events currently displayed in the Events 
Snapshot window. Events are always shown in chronological order. 

To display events in alphabetical order, use Merge Views and con-
vert the event list into a view. (See "Managing Contacts" in chap-
ter 3 for more details on Merge View.) Then use the Account List 
generator to print the report you need. 

To design a report, choose 
Event Lists from the Edit 
menu and the following 
dialog box will appear: 

~ list Options: CIiek the report to change. 

custom I custom z 
Custom 3 Custom 4 

Ne111 tltle: !••miner P■rtlclpent◄ 

I Cancel J 
• If you are creating a new report, enter the report title, then click 

one of the four buttons. The report name will replace the button 
name in the dialog box shown above, appear in the Print dialog 
box, and print on the report. 

• If you are changing an existing report, click one of the four but-
tons. 

The Event List Options dialog box will appear: 

~ Euent List Options: Check the fields 
to Include. 

ISi D■t■ ISi lime 
ISi NHI■ ISi 1111■ 
ISi en, ISi stet■ 
ISi lctlUltg ISi Unit I IIC ., 

ISi Recur ISi Notes 
ISi Recount ISi Phon■ 
ISi Zip ISi To tel 
ISi Rate ISi Rmount 

[ Cancel 

Report Ref ere nee 

Report Options 
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Most of the options are obvious; but some need special attention: 

.Qml2n 
Notes 

Total 

Activity 
Unit 

Rate 

Amount 

Description 
Prints the notes associated with every event. 
Notes are printed under the event record. 
Shows the total of the amount column at the bot-
tom of the report. 
Shows the activity name for this event. 
If the event's activity Is a "Units" type, the amount 
from the Event record Is shown In this column. 
If the event's activity Is a "Units" type, the preset 
rate In the Activity field Is shown In this column. 
If the event's activity Is a "Units" type, C.A.T. multi-
plies the unit column by the rate column and 
shows the result here. Otherwise, the Amount field 
from the Event record Is printed In this column. 

You can use the unit, rate, and amount columns to produce billable 
hours, time cards, sales analysis reports, or other reports that 
require similar computations. 

Click to check or uncheck items. Make your selections and click OK. 

Format Options To control the fonts, sizes, and style for a report, choose Set 
Format from the File menu and select the "Report" option. 

To preview the overall width of your report, use the To Screen but-
ton on the Print. .. dialog box. Use Page Setup from the File menu 
to set the actual paper width. 

Printing Event Lists To print an event list: 

• Select events in the Events Snapshot window. 
• Select your options, then choose Print. .. from the File menu. 
• Select one of the four "Event List" options. 
• Click Print. 
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Sample Event List: 

Feb 13, 1988 

--~ (ofp. 1526 Onwe Street 
Cupertino, CA 95643 

SemharPw;; I t 

"41E'NAAE 11TLE ACCOCMr PHONE CITY 
9121/8 Trilha S1e¥4111 Openli~- Armstrma ,t 714-3~~!1 Bloamin~~--
9/21/8 S-, Uader Mmeling c-t Tedmlcal 603-221-121!1 Pbiladelphia 
9121,a SJwocii'i'.eiih······· .. vi-;;;·iir.ldmt PnmkliD Power a: 21~93i3-·ii-········· .. 
9/21/SJICkleSmlth Specialilt. OlauBroa. 415-982-ilioo"'~.;;;;j······ 

'"'iaa,a DIIYe 1111X1bo ....... NM'iAccaunt HudsaG at ~:mci6i:i"1iis .. 00u 
9/21/8 Katy MacMillm Nat') Account Knall-Seigla' 515-872-0377 auc.g;; ....... .. 

"'i;jiji"j.w"Bndy l'Nlideilt 'l\ickerRelaun:a 212-684-2922 N_y;;j.:····"' 
, 9121/SHal Sullivan ........ Vicel'Nsidmt U.S. Blectranicl 203-776:!!!?:! .. ~~ ......... 
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Letters, Memos & Notes Letters, form letters, notes, and memos are stored in C.A.T. as event 
records. (See chapter 3 for details on creating letters.) 

Letter Options 

You select the letters to print using the Events Snapshot window. 
Manipulate the contact, activity, and time buttons to display the let-
ters you want. 

Choose Letter Options from the Edit 
menu and a dialog box will appear. 

You can click to check or uncheck 
items. If you will be printing letters 
on letterhead, uncheck the "Return 
Address" option. If you will be 
printing memos and notes for your 

~ Latter Options: Check the 
sections to Include. 

• 

181 Return Rdd.,.H 
D Today', Data 
D Note Identification line 

DK J ( cancel ] 

own use, check the "Note Identification Line" option to print a 
date/contact/activity reference at the top of each page. Make your 
selections and click OK. 

Format Options To change the fonts, sizes, and styles of your text, use Set Format 
and select the "Letter/Notes" option. 

Printing One Item To print one specific letter, memo, or note: 

• Display the item you wish to print in the Event window. 
• Select your options, then choose Print from the File menu. 
• Select the "Letter/memo/note" option. 
• Click Print. 

C.A.T. does not support printing letters in the Draft mode on the 
Image Writer. 

Printing a Batch of Letters To print a batch of letters, memos, and notes: 

4-24 

• Select the events to print in the Events Snapshot window. 
• Choose Print from the File menu. 
• Select the "All Notes" option. 
• Click Print. 

If printing is interrupted and you wish to resume from a specific 
event record, select the "Start with the current. .. " option under 
Preferences in the Edit menu. Then activate the Events Snapshot 
window, highlight the event to resume with, and choose Print again. 

C.A.T. will print the information in the Note field of each event as a 
single document. Each note is printed on a separate page. 
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ABC Corp. 
3400 Main street 

Sacramento, CA 99999 

Jun 1, 1987 

Mary Smith 
ABC Corp. 
4381 Broadway 
Artesia, AZ 34598 

Dear Mary, 

As you know, euery year the club sponsors e fundralser 
to raise money for special projects. This year, we would 
Ilka to lnulte your pertlclpetlon. 

There wlll be a committee meeting held on Wednesday, 
June 10th et 7 P.M. We hope you can Join us. 

Sincerely yours, 

James Mitchell 
Chairman 

Report Reference 

Sample Letter: 
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Sample Memo: 

Sample Note: 
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6/1 /87 Wyntt @Pnrk Plnzn Industries 

To: Rlicin 
From: JD 
Dnte: Jun 1, 1987 
RE: Fundrniser 

Prepnre n list of potentinl donors nnd drnft II cnmpnign letter. 
Letters must be mnlled by June 5th. 

6/1 /87 Ferenznk @Hidnlgo, Inc. Rctiuity: Stnndnrd Note 

Ruth, 

Our plnns for the fundrniser ere progressing smoothly. 
Rlicin is hnndling the list of donors end sending out letters. 
Let me know if you need ndditionnl informntion. 

John 
cc: JC 
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Tile ~-Codes List" is a reference report that shows all of the Lookup Codes List 
codes ia.caelrof your Lookup Tables. Each table is alphabetized. 

To print: 

• Clloose Print from the File menu. 
• Select the "Lookup Code List" option. 
• Click Print. 

I DESCRIP110N 

••e eo?p. 
15:26 Orovo s-

Cupertillo. CA 95643 

LookupTableo 

Feb 13. 1988 

-----···················· Coum,y·················································· l a-la 

2 Bapmd -----····················· 3 ••••••• Pnmce ....................................... . 

4 Oomuny ---------······ .. ••·•············•·•• .. ···············----s Japm ""°6-=M,._e.idco~--·············································································· 
------················· .. ··························---7 U.S.A . .................................................................................. __ _ 
----..................... Account Typo ............................................. . 

Client ------········· .................................................................. . 
2 Customer 
3 Employee 
4 ....... Pawonal ·········---······························································ 
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Activity List 
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The "Activity List" is a reference report that shows all of the activ-
ity records that have been entered in your database. Activities are 
grouped by class and printed in alphabetical order. 

To print: 

• Choose Print from the File menu. 
• Select the "Activity List" option. 
• Click Print. 

FELD NAME 

Ill«- t:oi-p. 
1S26 Grove Stn>ot 

Cupertino, CA 9S643 

Mtlttlty FWd u.t 
COlMT 

Feb 13, 1988 

AJICI.MT 

............. Sllmdardl..ctm ............ . 13..... . ........ . 

·----►~-----············--································--····················----· 

►Sinctrtl\l ~ours, 

Jot S•mplt 
M•n•~r◄ ...... .... SlandardMcmo • • • 7' 

►To: ◄ 

►From: Jot ◄ 

►D•tt: ◄ fE•DATll 
... ►Rt: ◄ ................................................................................. .. 
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This chapter describes each C.A.T. command. A command is an 
instruction to the computer to perform an action. 

Some commands tell C.A.T. to open List or Entry windows. 
Descriptions are given for the fields and buttons in every window. 

The commands are arranged in the order in which they appear on 
the menus. For an alphabetical list of commands, look in the index. 

C.A.T. has six menus: File, Edit, Enter, Show, Action, and Views. 

• The File menu commands are used to load and save files, format 
and print reports, and end a C.A.T. session. 

• The Edit menu includes commands to set preferences and report 
options. This menu also contains C.A.T.'s special commands for 
importing and exporting data, as well as standard Macintosh 
commands for copying and pasting text. 

• The Enter menu includes commands to enter account, contact, 
activity, and event records as well as lookup tables, options, and 
the system password. 

• The Show menu commands open or activate List windows 
which show your accounts, contacts, activities, and events. This 
menu also has commands to open the Calendar and Status win-
dows. 

• The Action menu commands are used to name, make, and merge 
views; set codes; and clone events. 

• The sixth menu called Views lists all of the views that you create. 
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Fife Menu 
'f '• , 

.. 
There are eight commands under the 
File.menu. These commands are 
used to: 

• Create a new C.A. T. database. 
• Open an existing database. 
• Save data. 
• Rename a file. 
• Print reports. 
• Set page options for printing. 
• Set fonts, sizes, and styles for 

printed documents. 
• Exit C.A.T. 

New 
Open... HO 

Saue HS 
Saue Rs ... 

Print... HP 
Page Setup 
Set Format 

Quit HQ 

New is used to start a new C.A.T. database. 

When you choose New from the File menu, C.A.T. will automati-
cally create an empty database with the filenames "Untitled" and 
"Untitled-NOTES." All C.A.T. records, options, and notes are 
saved as a database in these two Macintosh files. 

If you choose New while working with an existing database, C.A. T. 
will give you the opportunity to save changes before creating the 
new file. C.A. T. allows you to open one database at a time. 

File Menu 

New 
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Open The Open command is used to open an existing C.A. T. database. 

If you have made changes to the existing database, the Open com-
mand will give you an opportunity to save your work prior to open-
ing the new database. 

When you choose Open from the File menu, a dialog box will 
appear. Click to select the filename you want, then click the Open 
button as shown below: 

l(g} CRT Wort! 
[) Quick Start 
■Ii ' 
CJ System Folder 

F 

0 

lg) CRT Work 

Eject 
Driue 

Each C.A.T. database is stored as two Macintosh files. Using the 
filename you selected, C.A.T. will search for a corresponding notes 
file. If a notes file cannot be found, a dialog box will appear with 
an explanation of your options. Click as appropriate. 

To load files from another drive, a separate disk, or from 
Macintosh's folder structure, click to select in the dialog box shown 
above. See your Macintosh Owner's Manual if you need help. 

Save Save is used to save your data on disk. 

C.A.T. keeps new entries in your Macintosh's memory. As a result, 
you can work quickly and see updates on-screen immediately. 

New entries are not saved to disk until you use the Save or Save As 
commands. After you choose Save, C.A.T. will confirm the action 
with a message reading: "SAVED to Disk!... back up your data." 
Click or press any key to continue working with the same database. 

Note that If a power failure Interrupts your C.A.T. session, all of 
the Information entered since the last time you saved will have 
to be reentered. Data entered prior to the current session 
would still be Intact. It Is recommended that you save periodi-
cally and back up your database regularly. 
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The Save As command saves the current file to a new filename. 

When you choose Save As from the File menu, the following dialog 
box will appear: 

lei CAT Folder 
Hard Disk 

[ E,jt.>Cf 

011110 

saue Data as: [ Seue ) 
Cancel ) 

The default name for a new database is "Untitled." Enter any name 
you wish and click Save. Two files will be created: one icon with 
this name will hold your data; another icon with the same name fol-
lowed by "-NOTES" will hold your notes file. (For information on 
storing your data and notes files on separate disks, see "About 
C.A.T. Files And Disk Management" in appendix E.) 

Save As 

The Print command is used to print documents such as dossiers, let- Print 
ters, notes, mailing labels, and reports. 

Note that there are many commands related to the printing of 
reports. (See chapter 4, "Printing Reports," for an overview and 
examples of each report. ) 

When you select 
Print from the File 
menu, the follow-
ing dialog box will 
appear: 

~ Check all n1por11 It option,: 

Contacts In Cunant Plew: 
D Dossier D RH doulen option 
D Trauel size Bonier D Lebel, for Ulew 
□ Custom Recount # I D Custom Recount #3 
D Custom Recount #2 D Custom Recount #4 

Euent Snapshot: 
D Calendar D Tn1ue1 size Calendar 
O Custom Euent #1 D Custom Euent #3 
D Custom Euent •z D Custom Euent #4 
D letter/memo/note D RH NolH 
□ lookup CodH u,t D labels for Snapshot 
D Rctlulty Lisi 

1-•Pr•1n•t-] (To Screen) [ Cancel 
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(( Print ]I Click to check or uncheck items. You can select more than one 
_. item at a time. After you make your selections, make sure your 

printer and paper are properly set. Then click the Print button. 

A dialog box with your printer options will appear. Note that 
C.A. T. uses the standard Macintosh dialog boxes for printing with 
the Image Writer or LaserWriter. See your printer manual if you 
need more information about the options displayed. 

Click OK in the printer options box and the program will begin 
printing your selected item(s). If you need to cancel printing in 
progress, click the Cancel button displayed on the screen or press 
the "Cmd . " (command period) keys on the keyboard. 

(To Screen) To see how a letter, note, or report will look before printing, make 
your selections in the dialog box shown above, then click the To 
Screen button. 

Page Setup 

If you made more than one selection, click the Next button to see 
each page one after the other. Click Cancel to return to the C.A. T. 
screen. 

Page Setup is the standard Macintosh command used to control the 
page size and appearance of printed documents. 

When you choose Page Setup from the File menu, a dialog box sim-
ilar to the following will appear (depending on the printer you use): 

L111erWrlter Page Setup v5.0 

Peper: ® us Leiter O R4 Letter Reduce or IHmJl9' 
O US Legel O BS Letter Enlarge: 

Orientation Printer Effects: -~ 181 Font Substitution? 
181 Smoothlng1 
181 F111ter Bitmap Printing? 

I OK I 
[ cancel ] 

[Options] 

[ Help ] 

C.A.T. uses the standard Macintosh dialog boxes for printing with 
the Image Writer or LaserWriter. (See your printer manual if you 
need more information about the options displayed.) 
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,tis used to change the fonts, sizes, and styles of text on 
xi document. C.A. T. lets you decide how your dossiers, 

lellln, auemos, notes, reports and mailing labels will look. 

Whffl you choose Set 
Format &om the File 
menu, a dialog box will 
appear: 

Select 

~ Set Format: Select the type 
of reports to format. 

( Letters/Notes ) [ Reports 

[ Trauel Size ] [ Full Size 

I Cancel 

Letters/Notes to format letters, memos, and notes. 

] 

I 

Reports to format reports such as Account and Event Lists. 

Travel Size to format travel-size (7"X 7") dossiers, calendars, 
and malllng labels. 

Full Size to format full-size (8-1/2"X11") dossiers and calen 
dars. 

After you make your selection, another dialog box will appear: 

REPORT FORMAT: Select sections to 
change. Set font, size, style. CIiek 
SET. CIiek OK to BHlt. 

□ 
□ 
□ 

D Co11lm.n Haden 
h111lG11 

0 Ba4::,otRa,ort 
□ lub101lls 

□ 

ReponTltte 
CoJD11U1:, 
A441'111 

Amount 

5,000.00 
5,000.00 

CatFont 
Chicago 
611n11ua 
H11lu11tica 
Monaco 
Times 

09 □ Bold 
0 IO D Italics 

r 
iii 

O 12 D Underline 
O 14 D Dutllne 
O 18 □ Shadow 
O 24 D Condense 
ocu,tom □ 

( Set J [ Clear ] [ DIC ] Left Margin~ Top Margin~ 

File Menu 

Set Format 

Type of Document 
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On the far left side are seven boxes that correspond to the seven 
sections that can be changed. 

Column Width The font size of the text for the Column Header section controls the 
width of each column of the report. By choosing a smaller font size 
for the body section than the Column Header section, you can avoid 
the clipping of information caused by columns that are too narrow. 
(Also, you can use the reduction factor available on the Page Setup 
command to make reports fit onto your paper.) 

Click to check the box beside the section to be modified. 

Fonts In the upper right corner are the fonts available. The number of 
fonts available is determined by your particular System file. You 
can scroll to see others. Click once to highlight the font you want. 

Sizes & Styles Below the fonts are the size and style options. Click the buttons 
beside the point size and style desired. If you need a size other than 
those listed, click the button beside Custom and type a number in 
the field. 

~!!!!!!!!!!!!!!!!!!!Iii After you make your selections, click the Set button in the lower n Set » left corner. The sections selected will change immediately to show 
- - your choice of font, size, and style. For example, the illustration 

below shows a selection of Times, 18-point, Bold, Italic for the 
company name section: 

~ REPORT FORMAT: Select sections to CatFont I change. Set font, size, style. Click Chicago 
SET. CIiek OK to eHlt. Geneua 

Heluetlca 

□ ReponnGe Monaco mm 
i!!!!i 

C!!:I ColDJNUly 111,n, ~ □ 
Address ~ 

09 C!!:i Bold 

□ 
Column Heiden Anx>unt O 1 O C!!:i Italics 
Subtitles 

□ BodyofRepon 5,000.00 O 12 D Underline 

□ 
Subtotals 5,000.00 O 14 D Outline 

□ 
® 10 D Shadow 
O 24 D Condense 
ocu,tom □ 

(( Set ]) ( Clear ) ( OK ) Left Margin! 0.051 Top Margin~ 
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~~ that each section can be a different font, style, and size. Set 
~i,eadl selection separately. 

To clear your selections for the current sections checked (i.e., -----
uncheck them), click Clear. [ Clear ) 
In the bottom right comer of the dialog box, there are also boxes to Margins 
adjust the left and top margin widths. 

After all selections are set, click OK to return to the main screen. 
Then use the To Screen option on the Print dialog to see how the 
item will look before you actually print it. 

Quit is used to exit C.A.T. 

When you choose Quit from the File menu, C.A.T. will exit imme-
diately if no changes have been made to your file. 

If changes have been made, C.A.T. will give you the opportunity to 
save before exiting. 

File Menu 

Quit 
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Edit.Menu 
,,,.,.;,i ,,, . Tliit '1i 14 commands under 

tho&Ui menu. These com-
mands are used to: 

• Export data from one C.A. T. 
ftle to another C.A.T. file or 
to other applications. 

• Import data from other 
databases ( via spreadsheets) 
into C.A.T. 

• Delete multiple records at 
one time. 

• Cut, copy, paste, or clear 
information from one field 
to another field or applica-
tion. 

• Choose program use prefer-
ences. 

• Select options for printing 
dossiers, calendars, event 
lists, letters, account lists, 
and mailing labels. 

Copy Records 
Run Macro HR 
Delete Records 

Cut 
Copy 
Paste 
Clear 

HH 
XC 
XU 

Preferences 
Dossier Options 
Calendar Options 
Euent Lists 
Letter Options 
Recount Lists 
Label Options 

Copy Records is used to export data from one C.A.T. file to another Copy Records 
C.A.T. file or to other applications. You use Copy Records to pass: 

• A single record, 
• An entire view, 
• A snapshot of events, 
• A set of related records, 

or any combination of records to the clipboard. From the clipboard, Exponlng Records 
the records can be sent to: 

• Another C.A.T. database, 
• . >+ spreadsheet, 
• A word-processing program, or 
• Any application that accepts tab-delimited files. 
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Sending Records The records sent to the clipboard are compatible with all communi-
cation programs. Using simple Copy and Paste commands avail-
able in most programs, the clipboard text may be transferred elec-
tronically through local area networks, modems, or mainframe com-
puters. For example, you can paste the clipboard contents produced 
by Copy Records into a "memo field" of an electronics mail soft-
ware program and send the data to another user. 

Receiving Records The receiving application can also use Paste to accept the results of 
Copy Records. If the receiving application is another C.A.T. 
database, you can tell Copy Records to insert special codes that 
allow the receiving C.A.T. to properly place account, contact, activ-
ity, and event records in the proper places. Using the Run Macro 
command, C.A.T. then adds the new records into the current 
database. In a spreadsheet, the data would be pasted into cells of a 
spreadsheet -- one field per column and one record per row. 

Using Copy Records To use Copy Records, select the records to copy using any List win-
dow. For example, if you want to copy a single account, activate the 
Account List; click to highlight the account to copy; and select 
Copy Records from the Edit menu. 

If you want to copy all events from the Events Snapshot window, 
activate Events Snapshot, identify the events you want, and choose 
Copy Records. 

(Make sure no single event is highlighted. If one is, only that entry 
will be copied. Click on a blank row, if necessary, to prevent this.) 

Copy Options Depending on which window is active, Copy Records displays a 
dialog box with the following options: 

• Use the C.A.T. format. (This inserts commands in the data that 
tell the Run Macro command which window to use for which 
records. If you do not choose this option, records are copied 
using the tab-delimited format of a spreadsheet.) 

• Include record notes with the data copied. 

• Include linked records with the record to be copied. For exam-
ple, if an account is selected, you can choose to pass all contact 
and event records as well. 

• Pass notes only, in the word-processing format. 

Click to select the options you need and click OK. The data is 
copied to the clipboard. (For examples of Copy Records applications, 
see appendix A.) 
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Rdn,Mamo inued to import data records from the clipboard into 
C.A.T. 

'lle>tODicmti of the clipboard can be prepared by C.A. T. using the 
~ command or using a spreadsheet program. (To see 
ddi inslnlctions for importing data into C.A.T. from spreadsheets, 
• tfppendb: A.) 

Run Macro 

Run .Nacro accepts keystrokes from the clipboard. All characters How It Wol1cs 
of dat tDxt in the current clipboard become keystrokes, as if you had 
m"'8d them one by one through the keyboard. 

In addition to alpha-numeric characters that become field values in 
C.A.T., the Run Macro command also handles certain special char-
acters, including: 

Tab 

Return 

{x} 

causes C.A. T. to move to the next field. 

Ignored. 

Command keys. 

The { symbol tells C.A.T. that the next character is a keyboard 
command. For example, if x were the number 1 in C.A.T., pressing 
"Cmd 1" on the keyboard means activate the Account window. 
" { 1}" in the text of the clipboard would tell C.A. T. to perform the 
same command. Similarly, if x were the letter E, pressing "Cmd E" 
on the keyboard is equivalent to clicking the Enter button on Entry 
windows; "{E}" tells C.A. T. would put the record away. 

The Copy Records command automatically inserts tabs, returns, and 
command keys between records to tell the Run Macro command 
how to handle the incoming text. 

To use Run Macro, prepare the contents of the clipboard using the Using Run Macro 
Copy Records command or using a spreadsheet. Then choose Run 
Macro from the Edit menu and click OK. 

Watch as C.A.T. visually activates windows and enters text auto-
matically into your database. (For examples of Run Macro applica-
tions, see appendix A.) 

To cancel the Run Macro process, click the mouse button at any 
time. 
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Delete Records Delete Records removes multiple records from your database using 
a single command. 

To delete multiple records, display the records to be deleted in a list 
window. For example, to delete all events associated with an activ-
ity, show all those events in the Events Snapshot window and 
choose Delete Records from the Edit menu. The command will 
request you to confirm your intent prior to proceeding. 

When you elect to delete a list of account records, C.A.T. will also 
delete the contacts and events that are linked to these accounts, if 
any. Similarly, when you delete contacts, C.A.T. will delete all 
events linked to these contacts. 

If you delete an activity record, C.A.T. does not delete the events 
linked to this record. C.A.T. unlinks the events so that the events 
are linked to no activity. If you wish to delete these events, use 
Delete Records on these events prior to deleting the activity record. 

When you save to disk, the records will be permanently deleted 
from your file. 

Cut/Copy/Paste/Clear C.A.T. uses the standard Macintosh commands for editing text 
within fields. Each command is described here. Refer to your 
Macintosh Owner's Manual if you need help. 

5-12 

• The Cut command removes a selection and places it on the clip-
board. Any previous contents of the clipboard will be replaced. 

• The Copy command places a copy of a selection on the clip-
board. Any previous contents of the clipboard will be replaced. 

• The Paste command inserts a copy of the contents on the clip-
board at the insertion point. 

• The Clear command removes a selection without placing it on 
the clipboard. 

These commands are particularly useful when working with text in 
Note fields (i.e., preset text in the Activity window) and when 
transferring text from one application to another. 
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Preferences are used to set screen and print options. 

Choose Preferences from the Edit menu and the following dialog 
box will appear: 

Preferences 

Check 1111 preferences: ( DIC ] 
Screen Options: •---•-
181 Show warning messages on teHt, amount and data entry. 
181 Rutomatlcally create codes and 11ctluitles. [,,..-C-an_c_e_l .... 
181 Search using alias of 11ccounts/contacts/11ct1ultles. 
D Early bird. R11ume 7 and 8 mean RM - not PM. 
D Rutometlcally enter changes to an euent record. 
D On zoom, close the current window. 
Print Options: 
D R11ume lookup table #1 contains Country information. 
D EHpand treual size reports to full page length. 
D Print ell dosslan and labels starting with currant. 

Make your selections and click OK. When you save, your selec-
tions will be saved as well. You can change these options any time 
you wish. Each option is described below. 

• Show warning messages ... lets you choose to see warning 
messages on-screen or not. If you choose this, the program will 
let you know when irregular entries are made. 

• Automatically create codes and actlvHIH. This simplifies 
data entry for you. Choose this option if you want to enter new 
account codes directly in the Codes window, new contact codes 
directly in the Contact window, and new activities directly in the 
Event window. 

• If you enter aliases for your accounts, contacts, or activities, you 
can choose to search for them by alias in clairvoyant fields. Just 
check Search using alias ... 

• When you enter time to schedule events, C.A. T. assumes 9, 1 O, 
and 11 are •A.M.■ hours, and that 12, 1, 2, 3 through 8 are •P.M.• 
hours. If you want C.A.T. to assume 7 and 8 are •A.M.■ hours, 
check the Early Bird ... option. 

• Automatically enter changH to an event record. When you 
select this option, changes to event records are entered auto-
matically. You do not have to click the Enter button. 
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Dossier Options 
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• If you prefer C.A. T. to close windows as you go from one window 
to another, check On zoom, close... For example, if you click on 
a highlighted account in the Account List to display the Contact 
List, the Account List window will first close. 

• When you select Assume lookup table #1 ..• , C.A.T. will 
assume table 1 contains country codes and will include the infor-
mation on mailing labels. This option is for labels only. 

• Travel-size reports are normally 7"X7" and print out in smaller 
type in notebook-size format. If you want the report in the same 
format but on a full page, select Expand travel size ... 

• When you instruct C.A.T. to print all dossiers, it normally prints 
them in alphabetical order starting with the first account dis-
played in the Account List window. If you were printing 100 let-
ters and the printer jammed on the 75th one, you could select 
the Print ... starting with current option. Then resume printing 
by clicking once to highlight the 75th account in the Account List 
window, and choose the Print command again. 

Similarly, if the printer jams while you are printing "All Notes" 
from the Events Snapshot window, you could select this option to 
resume printing by clicking once to highlight an event in Events 
Snapshot. Then choose the Print command again. 

Dossier Options let you choose what information will print on 
dossiers. 

When you choose Dossier Options from the Edit menu, the follow-
ing dialog box will appear: 

A,.. Dossier Options: Check the sections 
~ to include. 

0 Address Block D Recount Note 
D Contact Names D Contact Notes 
O Snapshot Euents O Euent Notes 

I DK I Cancel 

Make your selections and click OK. (See chapter 4, "Printing 
Reports," for sample dossiers.) 
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Calendar Options let you choose what information will print on the 
.calendar report. 

Wlien you choose Calendar Options from the Edit menu, the follow-
inf dialog box will appear: 

~ Calender Options: Check the 
aactlons to Include. 

D Rddre11 & Phone # 

D Euent Notes 

I OK ) Cancel 

Mate your selections and click OK. (See chapter 4, "Printing 
Reports," for sample Calendars.) 

Event Lists options specify what information will be included on 
Event Lists. 

When you choose Event Lists from the Edit menu, the following 
dialog box will appear: 

A\. List Options: CIiek the report to change. 
~ 

Custom 1 )( Custom 2 

Custom 3 ][ Custom 4 

New title: II 
t Cancel ) 

You can customize up to four lists at a time. There is one button for 
each list. Of course, you can change them any time as new reports 
are needed. 

Initially the names of the lists appear as Custom 1, Custom 2, etc. 
Enter a name for the list in the New Title field. This name will 
appear in the Print dialog box and on the report. Then click to 
select one of the buttons. 

Edit Menu 

Calendar Options 

Event List Options 
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Another dialog box will appear with the Event List Options: 

Euent List Options: Check the flelds 
to include. 

□ Date □ Time O Recur □ Notes 

□ Name 0Tltle O Recount O Phone 
□ City □ State □ Zip □ Total 

O Rctiulty O Unit □ Rate □ Amount 

I DK i cancel 

Make your selections and click OK. (See chapter 4, "Printing 
Reports," for sample event lists.) 

Letter Options let you choose what information will print on letters 
as well as memos and notes. 

When you choose Letter Options from the Edit menu, the following 
dialog box will appear: 

~ Letter Options: Check the 
sections to Include. 

O Return Address 
O Today's Date 
O Note Identification Line 

I DK ] Cancel ] 

If you are using letterhead, .uncheck the Return Address option. 

If you are printing notes for your own use, you can select the Note 
Identification Line option which will print the date, contact name, 
and activity at the top of the page. It also directs your filing clerk 
to the proper file folder. 

Make your selections and click OK. (See chapter 4, "Printing 
Reports," for sample letters and notes.) 
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~'l.fSrs c,ptions specify what and how information will print Account List Options 
dlft--t Lists. When you choose Account Lists from the Edit 
-, the following dialog box will appear: 

List Options: CIiek the report to change. 

Custom I )( Custom 2 ) 
Custom 5 )[ Custom 4 ] 

I New tltle: II 
.... ----~----~~~~------n Cancel ] 

You can customize up to four lists at a time. There is one button for 
each list. 

Initially the names of the lists appear as Custom 1, Custom 2, etc. 
Enter a name for the list in the New Title field. This name will 
appear in the Print dialog box and on the report. Then select one of 
the buttons. Another dialog box will appear with options: 

~ Recount List Options: Check the 
fleldl to Include. 

D Rll111 O Recount□ Address 
D City O State O Zip O Phone 

O Contact O Tltle O EHt. 
0 Leuel O Table-I I □ Table-12 

O Country O Recount□ Projects O Table-4 
□Table-5 □ Table-6 □ Table-7 □ Table-a 
SORT BY: GROUP BY: 
® Recount O I O 5 
QClty 02 06 u OK j 
Qstate Ol 07 
OZlp 04 08 Cancel ) 
O Rll111 ® None 

In addition, you can choose how accounts will be sorted and 
grouped. There are five options for sorting. If you choose "State," 
then all of your accounts will be listed in alphabetical order by 
state. Sorting by "Account," "City," or" Alias" will also list 
accounts in alphabetical order; sorting by "Zip" will list them in 
zip-code order. 
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The numbers under "Group By" refer to the eight lookup tables that 
you can set up for accounts. If you choose to group by "3," then 
your accounts will be grouped according to the codes that you have 
in table 3. Each of the codes becomes a subtitle, and following the 
subtitle is a listing of the accounts. 

Note that you may make one selection for sorting and one for 
grouping for each report. 

Make your selections and click OK. Prior to printing, you can use 
the To Screen option to see how the report will look. (See chapter 
4, "Printing Reports," for sample account lists.) 

Label Options Label Options are used to choose what information will print on 
labels. When you choose Label Options from the Edit menu, the 
following dialog box will appear: 

A-,.. Label Options: Check the 
~ llnes to Include. 

D First l111t Name /Mail Stop 
Dntle 
D Recount Name 
□ Address 

D City, stnte nnd Zip 
□ country I OK J [ Cancel ] 

Note that mail-stop information will print on the same line as the 
contact's name, and country information will print on the same line 
as the city, state, and zip. 

Make your selections and click OK. (See chapter 4, "Printing 
Reports," for sample labels.) 
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(~,am eleven commands 
, ,....,,the Enter menu. These 
···•·· flllflBmaods are used to enter: 

:t:·, 

• slinntrecords. 
• Actouot records. 
~. Account codes. 
• Contact records. 
• Ferm letters. 
.,, ►Activity classes. 
• Activity records. 
• · Activity tactics. 
• Codes in lookup tables. 
• User options including 

your company name and 
password. 

• A system password. 

New Euent XO 
New Recount X 1 
Codes X2 
New Contact X3 

New Form Letter 
Rctiuity Class X4 
New Rctiuity XS 
Tactics X6 

Lookup Table 
Options 
Password 

New Event is used to enter event records. An event is a record of 
111 activity with a contact on a specific date and time. 
i 

~ you choose New Event from the Enter menu, the Event win-
• ~ will appear: :.i: ,:.;..,: :.>• 

Enter Menu 

New Event 

5-19 



Centaet: 

5-20 

Note that the Date, Time, and Contact are the only required fields 
for recording events. All other fields are optional. 

Date and Time Fields The current date set on the C.A.T. Calendar and the current time set 
on your Macintosh clock are automatically displayed in the Date 
and Time fields. To schedule an event for a different date and time, 
use the normal Macintosh editing conventions and type directly in 
those fields. 

C.A.T. allows free-form entry for dates. The following date con-
ventions are accepted: 

MM/DD/YYYY 
MM/DD/VY 
MM/DD 

M/D/19YY 
M/D 

DD 
D 

Note that dates must be entered numerically and that slashes (j) 
must be used to separate the month from the date from the year. 

The following date conventions are not accepted by C.A.T.: 

MMDDYY 
Jan 3, 1987 
1987/3/4 

No slashes. 
Not completely numeric. 
Year cannot precede month and day. 

When entering time, C.A.T. assumes 9, 10, and 11 are "A.M." hours 
and that all other hours are "P.M." hours. If you prefer 7 and 8 to 
represent "A.M.," then set the Early Bird option under Preferences. 
Acceptable time conventions are: 

9 
9AM 
9A.M. 

9:00 
9:00A.M. 

1PM 
13:45 

Contact Field Every event must be linked to a contact. There are three ways to 
select a contact. You can: 

C)CONTACT ~ • Type the contact's first name, last name, or alias in the clairvoy-
--..11~~--,,.-ccou_N_T __ ..x_l ant field. C.A.T. will look for names that match and will display 

them in the echo field. 

Click once on the Goto arrow in the Contact or Account echo 
field and a List window will appear; click to highlight the con-
tact you want; then reactivate the Event window and your selec-
tion will appear. 

Click the Next button to scroll through the current list of contacts. 

The link is complete when the correct contact appears in the echo 
field. Note that each contact's company name, phone number, and 
extension (if any) will be displayed as well. 
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1\~'ff'1ll•Y be linked to an activity. Similar to contacts, there Activity Field 
•• .ways to select an activity. You can: 

• ,:,,,,_,tile activity name (e.g. Introduction Letter) in the clairvoy- AotMtw: 
ut field. C.A.T. will look for names that match and display 
~ in the echo field. 

•,ri 'C!lict on the Goto arrow in the Activity echo field and the [:> 
4ctivity List window will appear; click once to highlight the 
activity you want; then reactivate the Event window and your 
selection will appear. 

• Click the Next button to scroll through the current list of activities. ~ 
The link is complete when the correct activity name appears in the 
echo field. 

If you enter a new activity name by typing the new name, C.A. T. 
automatically creates a new activity with that name. 

In the Note field, you can enter up to 32,000 characters or 16 sin-
gle-spaced pages of any information you wish. 

If the activity entered for the event includes preset text, that infor-
mation will appear in this field. Use the scroll bar or arrows to 
scroll through the field. 

Note Field 

If an event occurs on a regular basis (i.e., monthly board meetings), - ~ 
click the Recurring button and the following dialog box will appear: 

~ CIiek recurring button: 

( Dally [ Week ) [ BIWeek ) 

Month (2 Months) ( Quarter) 

None I [ Annual Cancel ) 

Click the button that represents the frequency of recurrence, then 
click Enter in the Event window. The event will automatically be 
scheduled on your calendar continually until you change it. For 
example, if you select "Month," C.A. T. will show the event every 
month on Events Snapshot starting with the current month. 

To cancel a recurring event, first display the event in the Events 
Snapshot window. Then double-click on it, and the Event window 
will appear with the record displayed. Click the recurring button 
and click None. Then click Enter in the Event window. 
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Cslc Button & Amount Field 

□ Done 

;; 
(ENTER) 

[CLEAR] 

(DELETE) 

The Cale button can be used to calculate amounts entered in the 
Note field. Enter each amount on a separate line with "$" signs, 
then click Cale. The total will appear in the amount field to the left 
of the Cale button. 

The Cale button can also be used to capture elapsed time which 
may be useful for billing purposes. (See "Managing Time" in chap-
ter 3 for examples of these uses.) 

The amount field to the left of the Cale button can show various 
types of information: 

• A total calculated from amounts entered in the Note field. 
• A total for elapsed time. 
• Any amount that you wish to type directly in the field. 

Information entered in this field will appear in the Amount column 
of the Events Snapshot window. 

If an event does not require any further attention, click to check the 
Done box. In the Events Snapshot window, "Done" events will not 
be checked in the To Do column. 

Click this button as a short cut to go to the Events Snapshot win-
dow. 

Click the Enter button to record the event. Events are listed in the 
Events Snapshot window. 

To clear all of the fields in the Event window, click Clear. Note 
that Clear does not delete the current record. It clears the window 
for new entries. 

To delete an event, first display it in the Event window. Then click 
the Delete button. C.A.T. will ask you to confirm the action. Click 
OK and the event will be deleted. 

These buttons are designed to handle interruptions and allow you to 
work with more than one event at a time. You PUSH event records 
aside and POP them back to continue working. 

• PUSH enters a record and sets it aside in a "stack." You can 
push aside up to 100 records at one time and they will be neatly 
stacked one on top of the other. 

• POP redisplays the events in the Event window, starting with the 
record on top. The last one pushed is the first one popped. 

• XCHG exchanges the current event with the event at top of the 
stack. The event at the top of the stack shows on screen and the 
current event becomes the top of the stack. 
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To find events, use the Events Snapshot window. For example, 
identify a to-do list of events that needs to be handled. 

• Double-click on the first event in the Events Snapshot window, 
and the Event window with your event will appear. 

• Use the Next button beside the Date field in the Event window 
to scroll through the list of events in Events Snapshot. With 
each click, C.A.T. shows the next event. 

You can review one record after another in this way. 

Rndlng & Reviewing Events 

To change the data for an event, use the Events Snapshot window to Changing Events 
find and display the record in the Event window. Then make your 
changes and click Enter or Push. 

You can change the contact, activity or time fields; as well as the 
date, notes and amount. 

New Account is used to enter new accounts. Accounts can be com-
panies, organizations, or individuals. 

When you choose the New Account command from the Enter menu, 
the following window will appear: 

' flt I uu11t ,_, 

~ I I 

Cent.I: 

II 
I 

c..,,,.,.,, : 
Addrns: 

Clt1:1 /st/Z11: I I 
PhoM/Aliu: 

Q 

0 
( ENTER ) ( CLERR ) ( DELm ) ( Codes> ) 

New Account 

The heavily outlined field at the top of the window is a clairvoyant Search Field 
search field. To find an existing account record, type its name or 
alias and C.A.T. will find records that match. 
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Contact Field 

The Next buttons in the upper left comer of the window are used to 
scroll through the list of accounts currently displayed in the 
Account List window. 

If you work with individuals who are not associated with compa-
nies, enter their full names in the Contact field and leave the 
Company field blank. When you click Enter, C.A.T. will automati-
cally create an Account record with the individual's Last Name as 
the Account name; and a Contact record using the individual's Full 
Name. 

For example, if you enter Jackie Smith in the Contact field and 
leave the Company field blank, C.A.T. will use "Smith" as the 
account name and 
create a Contact Contact: 
record for "Smith, Company: 
Jackie." 

I J•ckto Smtth II; 

Company & Address Fields Enter company names in the Company field. If there is no company 
name, you can leave the field blank. 

Al/as Field 

Notes Field 

( ENTER ] 

( CLERR ] 
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Enter the Address, City, State, Zip, and Phone for each account in 
the appropriate fields. This information, which can be entered in 
any format, will be displayed in various windows and print on 
reports. Press the Tab key or click with the mouse to move from 
field to field. 

Aliases help differentiate accounts with similar or long names. If 
you prefer to identify an account by something other than its name, 
enter an Alias. Aliases can be abbreviations, acronyms, or num-
bers. Then you can set Preferences (under the Edit menu) to search 
for accounts by alias. 

In the Note field, you to enter up to 32,000 characters or 16 single-
spaced pages of any text you wish. This information will print on 
dossiers only. Use the scroll bar and arrows to scroll through the 
field. 

To record an account, click the Enter button at the bottom of the 
window. Accounts are automatically sorted in alphabetical order 
and shown in the Account List window. 

To clear all of the fields in the Account window, click the Clear 
button at the bottom of the window. Note that Clear does not delete 
the current record shown. It clears the fields for new entry. 
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f# ..... account, first display it in the Account window. Then ( DELETE ] 
• "8 Dol8te button. C.A.T. will ask you to confirm the action. ~ _ 

' · · · · all contacts, events, and notes associated with the account 
' · as well. Click OK and the record(s) will be deleted . 

.... die CodeS> button to go to the Codes window. The Codes ( ) 
Wf 1J1e1 is used to enter account codes from lookup tables. See the Codes> 
Codes command in this section. 

-ae,.Coctes window is used to select the account codes you use to Codes ,._ize and group account records. Codes can be preset entries 
ia,tbe Lookup Table or automatically created as you need them. For 
tadl account, you can set up to eight codes, one from each table. 
(For discussion on setting up tables, see chapter 3, "Managing 
Contacts.") 

To set codes for an account, find the account using the Account window. 

Talt-2 
Tait-I 
r•i.--. 
Talt-5 r•~ 
Tllllt-7 
Tait-ti 

For each clairvoyant field, type a code name, and C.A. T. will dis-
play names that match in the echo field. 

If you choose Preferences from the Edit menu and select the 
• Automatically create codes ... " option, then you can enter new 
codes directly in any of the clairvoyant fields. C.A.T. will ask you 
to confirm whether the new entries should be added to the appropri-
ate lookup table. 

~ you are done setting codes, activate the Account window and 
click Enter. 

Codes Fields 

~~. cliclt the Goto arrow beside any field to display the select- ~ 
ed lookup table. Double-click on the code you want and it will be 
inserted in the Codes window. 
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New Contact New Contact is used to enter and alter contact records. 

Choose New Contact from the Enter menu and the following win-
dow will appear: 

0 I ontac t 

I I 

1 
I I 

O Ms LN ® First. 
~fl Stop 

[ ENTER ] [ CLEAR ] [ onrn ] 

I 

Search Field To display existing contact records, type a name or alias in the 
clairvoyant search field and C.A. T. will display names that match. 

~i In the upper left comer of the window, click the Next button to 
, .... , scroll alphabetically through the list of contacts for the current 

account. 

Name Field You can enter a contact's first name followed by the last name (John 
Smith) or the last name, followed by a comma, followed by the 
First Name (Smith, John). C.A.T. will automatically sort by last 
name. 

Account Field Every contact must be linked to an account. There are several ways 
to link the appropriate account. You can: 

• Type the account name and C.A.T. will find names that match. 

--~-»~---~.¥.!• • Click on the Goto arrow and the Account List window will 
appear; click to highlight the account you want; then reactivate 
the Contact window. 

• Click the Next button in the Account echo field to scroll through 
the current list of accounts. 
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The link is complete when the correct account appears in the echo 
field. 

Code fields are used to select codes to categorize your contacts. 
Codes can be preset entries in lookup tables or created automatical-
ly as you need them. (For discussion on setting up tables, see 
chapter 3, "Managing Contacts.") 

To select a code, type a code name in the appropriate clairvoyant 
field, and C.A.T. will find codes that match. 

If you choose Preferences from the Edit menu and select the 
"Automatically create codes ... " option, then you can type new codes 
directly in the appropriate field. C.A.T. will ask you to confirm 
whether the new entries should be added to an appropriate lookup 
table. 

You can click on the Goto arrow beside any field, which activates 
its lookup table. Double-click on the code you want and it will be 
inserted in the Contact window. 

If you will be using C.A.T.'s preset text feature for writing letters, 
you can designate the greeting. The choices are: 

• First Dear (First Name): 
• Mr LN Dear Mr. (Last Name): 
• Ms LN Dear Ms. (Last Name): 
• Alias Dear (Alias): 

Code Fields 

Salutation Buttons 

If the contact has an extension or a direct line that is different from Extension & Other Fields 
the account number, enter the information here. This number will 
appear in the Event window when the contact is selected. 

The Mail Stop (if any) will print on address labels. 

In the Note field, you can enter up to 32,000 characters or 16 sin-
gle-spaced pages of any text you wish. This information will print 
on dossiers only. Use the scroll bar and arrows to see more. 

To record contacts in C.A.T., click the Enter button at the bottom of 
the window. Contacts will appear in alphabetical order by last 
name in the Contact List window. 

To clear the window, click the Clear button. Clear does not delete 
information; it clears the record for new entries. 

Enter Menu 
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( CLEAR ) 
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( DELETE ] To delete a contact, find the contact record using the Contact win-
dow, then click the Delete button. Note that all events and notes 
associated with the contact will also be deleted. Click OK and the 
record{s) will be deleted. 

New Form Letter This command is used to set up form letters. Form letters are 
stored as Activity records. 

When you choose New Form Letter from the Enter menu, the fol-
lowing window will appear: 

I LJ Hl tw1ty : 

c:]® Letten O Projects O Meeting 
O Phone O Orders O General 

Dtscr•tian 

I 
ATTN:CJJ ~· 
.Slnctn'ly VOlrS, 

[ ENTER ][ CLERR )[ OELm )[ Tactics> ) 

C.A.T. field references. 

iE•DHEI Event Date 

m m 
[IJ 

Account Name 
Street Address 
City State Zip 

Contact's Name 

lDEARI Salutation 

C.A.T. has already selected the class for this form letter and com-
pleted the address and closing blocks of your form letter. If you 
supplied your name to C.A.T. (using Options under the Enter 
menu), your name is also included in the closing block. 

Supply a name for this letter in the Description field. 

If you wish to alter either the address block or closing block, posi-
tion the data cursor in the preset text blocks and make your 
changes. Type the body of your form letter following the ► marker 
in the middle. 

When done, click the Enter button. 

(The same window is used to enter other types of activities. See the 
New Activity command in this section for additional information 
about the general use of this window. See also "Managing 
Activities" in chapter 3 for more information on form letters.) 
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ii med to name the general categories of your activi- Activity Class 
llavin1 a file cabinet with six drawers. An "activity 

and an "activity" is a folder in the drawer. 

. . . ••;::dloose the Activity Class command from the Enter 
· ... tile following dialog box will appear: 

·:i N;, .• 
•· lot up six classes. The 

...... displayed are suggestions 
~Jl,.change a class, type a new 
... in any of the fields and click 
ox. 
CJaa names can only be eight char-
acters long. They appear in the 
Activity and Activity List windows. 

Rctiulty Clan Names 
(MaH of 8 Characten) 

Latten Phone 
Projects Orders 
Meeting General 

I[ OK J [ Cancel ) 

New Activity is used to enter records for any subject matter that New Activity 
you want to keep track of in C.A.T. Examples of "simple" activities 
are letters, phone calls or appointments; "significant" activities 
might be orders, contracts, facts, and statistics. 

Choose New Activity from the Enter menu and the following win-
dow will appear: 

Ht l11•1lq 

~ I I 

c:=J<I Latten O Projects O Meeting 
QPhone QDrdera Q&eneral 

A!Ms O.S.-•tton 
I 

Q 

0 
( ENTER )( CURR )( onm )( Tactics> ) 

Enter Menu 5-29 



5-30 

Search Field 

Only the Class button and Description field are required. All other 
fields are optional. 

The heavily outlined field at the top of the window is a clairvoyant 
search field. To display existing activities in the Activity window, 
type the activity name or alias and C.A.T. will find and display the 
record that matches. 

Class Buttons Activity classes are displayed in the upper half of the window. All 
activities must be assigned to a class. Click to select a class. 

Alias Field Enter abbreviated names (a maximum of eight characters) in the 
alias field. 

Description Field Enter a descriptive name for this activity. When linking to activi-
ties, you will be searching using either the alias or description 
names. 

( 

( 

( 
( 

Note Field In the Note field, you can enter up to 32,000 characters or 16 sin-
gle-spaced pages of text if you wish. Use the scroll bar and arrows 
to scroll through the field. 

ENTER ) 

CLEAR ) 
DELETE ) 

You also have the option to enter preset text for form letters, data 
sheets, surveys, and other uses. This is the only Note field in 
C.A. T. where preset text may be entered. (See "Managing Activities" 
in chapter 3 for examples of preset text) 

To record activities in C.A.T., click the Enter button at the bottom 
of the window. Activities will appear in alphabetical order by class 
in the Activity List window. 

To clear the Activity window, click Clear. Note that Clear does not 
delete information, it clears the fields for new entries. 

To delete an activity, display the record in the Activity window, 
then click the Delete button. C.A.T. will ask you to confirm the 
action. Click OK and the activity is deleted. 

Tactics> ) Click the Tactics> button to display the Tactics window. Tactics 
allow you to set up routine preliminary or follow-up activities. 
(See the Tactics command described next.) 
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Tactics are used to automate routine preliminary or follow-up activ- Tactics 
ities. For example, a tactic could be set up so that every time you 
send out a letter (your primary activity), a follow-up call is auto-
matically scheduled one week later (your follow-up tactic). 

To set up tactics, first display the primary activity in the Activity 
window. Then click the Tactics button in the lower right comer of 
the window or choose the Tactics command from the Enter menu. 

llctlult 

c:::::Jt> Letten O Projects O MHtlng 
O Phone O Dnlen O &ene1111 .,._.._ , ___ 

The primary activity is displayed at the top of the window, and 
there are fields to preset up to four tactics. 

Enter the interval between the primary activity and the tactic activi- Days Field 
ty. Enter a positive number (i.e., "5") to indicate the number of 
days after the primary activity, enter a negative number (i.e, "-3") 
to indicate the number of days prior to the primary activity. 

To enter tactic activities, type the activity name or alias in the clair- Tactics Field 
voyant search fields and C.A. T. will display names that match in 
the echo field. Alternatively, you can click once on a Goto arrow 
and the Activity List window will appear. Click once to highlight 
the activity you want, then reactivate the Tactics window. 

The four buttons below the tactics are used to designate what type 
of data will be captured in the Amount field of the Event window. 
These are used in reports to control formating and totaling. 

Amount 
$000 
Units 
Ratio 

means "dollars and cents" 
means "thousands of dollars" 
means "quantity" {see "Preset Rates Field" below) 
means numbers and Index ratios. 

Click to make your selection. 
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Preset Rates Field If you select the Units option above, you can enter an amount per 
unit in the Preset Rate field. This feature allows you to manage 
time charges. 

Lookup Tables 

Table Name Field 

Code Field 

( ENTER ) 

[ DELETE ) 

After you enter your tactics in the Tactics window. activate the 
Activity window, and click Enter. 

Lookup tables are used to set up codes for categorizing your 
accounts and contacts. Codes can be any attribute that you want to 
use to categorize account or contact records. 

When you choose the 
Lookup Table com-
mand from the Enter 
menu. a dialog box 
will appear. 

Tables 1 through 8 are 
for accounts. Tables 9 
through 12 are for con-
tacts. 

Select lookup table. 

Country rable-s 
rable-2 lfable-6 
Table-3 l[able-7 
able-4 fable-8 

( Cancel J) 

nue 
~euel 
Table-I I 
,able-12 

Table 1 has initially been assigned to country information. If you 
do not need to manage foreign contacts, rename this table for your 
own use. 

Click to select any table and the Lookup Table window will appear: 

Enter a title for the table in the 
first field at the top of the win-
dow. All references to the table in 
other windows will be updated to 
show this new title. 

The second field from the top 
(under the Title) is for entering 
codes. Type in code descriptions 
and click Enter. Codes will be 
displayed in alphabetical order 
under the Description heading. 

To delete codes, display the 
lookup table that contains the 
code to be removed. Click once 
to highlight the code and it will 
appear in the entry field below the 
table title. Then click the Delete 
button. 
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To change codes, display the table that contains the code to be 
changed, in the Lookup Table window. Click once to highlight the 
code to be changed and it will appear in the entry field below the 
table title. Make your changes and click Enter. (The entry and use 
of codes is explained in chapter 3, "Managing Contacts.") 

When you choose Options from the Enter menu, the following dia- Options 
log box will appear: 

«:»-- Options: 

Company: I 
Address: 

usarn11me: 
Passwonl: I 
Logo: O None ® Slngle O Double I OK ] ( Cancel ) 

Enter your company name and address as you would like this infor- Name & Address 
mation to appear at the top of reports. 

Enter a user name. The name you enter here will (a) print at the top 
of reports above your company address and (b) appear at the end of 
letters created with the New Form Letter command. 

Enter a password if you wish to use the Lock command to protect 
your database. In order to use Lock effectively, you must enter a 
system password as well. (See the Password command described 
next and the Lock command later in this chapter.) 

Once passwords are entered, C.A.T. will prompt the user for a pass-
word every time (a) the Lock command is selected and (b) every 
time the file is loaded. Either the user and system passwords would 
be acceptable. Failure to enter a valid password causes C.A.T. to 
deny access to the file. 

The user password permits data entry. However, the user cannot 
change activities. The system password, to facilitate system admin-
istrator control, permits complete access to all commands and data. 

If you enter a password, write it down, and store it in a safe place. 
C.A.T. distinguishes uppercase and lowercase letters in passwords. 

Enter Menu 

User Password 
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Logo C.A.T. allows you to create your own logo which can be printed in 
the upper left comer of reports. Instructions for creating a logo are 
given in Appendix C. 

Password 

If you are printing a logo, click Single if it is 32 dots wide or click 
Double if it is 64 dots wide. If you are not using a logo, None is 
already set as the default. (See Chapter 4 for a sample report with a 
logo.) 

After you make your entries, click OK. 

This command is used to enter a system password for use with the 
Lock command under the Action menu. Note that in order to use 
the Lock command effectively, you must enter a user password 
(under Options) as well. 

When you choose Password from the Enter menu, the following 
dialog box will appear: 

~ Enter new system 
pnssword: 

11 

(( OK J ( Cancel ) 

Passwords can be alphanumeric and up to eight characters long. 
Note that C.A. T. distinguishes uppercase and lowercase letters in 
passwords. After you enter a password, write it down, and store it 
in a safe place, then click OK. 

Once passwords are entered, C.A.T. will prompt the user for a pass-
word every time the Lock command is selected and every time the 
current file is loaded. Either the user or system passwords would 
be acceptable. Failure to enter a valid password causes C.A.T. to 
deny access to the file. 

(See the Lock command later in this chapter.) 
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Show Menu 
There are six commands under the Show menu. These commands 
are ued to display the following windows: 

• Account List shows 
,, 8"0UDts by view. 

• Contact List window 
shows contacts by 
account. 

• Events Snapshot shows 
all events by contact, 
activity, and time. 

• Calendar shows days by 
month. 

• Activity List window 
shows all activities by 
class. 

Recount List X7 
Contact List XB 
Euents Snapshot X9 

Calendar X' 
Rctiuity List X-
Status X= 

• Status window shows vital statistics about your C.A. T. database. 

This section describes the contents and shows all the actions that 
can be performed using each list window. 

The Account List window shows a list of accounts in alphabetical 
order. You can group accounts into views and display only the 
accounts in a particular view. You select a view by choosing it 
from the Views menu. When you choose Account List from the 
Show menu, the following window will appear: 

Account List 
C.11.T .• bti CIMlrMJ Libs Y2.0 

!Boston NII 

Show Menu 

Account List 
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Window Headings For each account, the window shows the name, city, and state. The 
total number of accounts in the view is also shown. 

The Account List window includes three columns on the left 
labeled W, V, and P. They are defined as follows: 

W Work Accounts that are checked have been changed during 
the current session. The "current session" is the time 
spent since you last saved to disk. When you save to 
disk or quit, the check marks for the Work column are 
automatically cleared. 

V Current Accounts that are checked belong to the currently 
selected view from the Views menu. 

P Priority Checked accou...11t means the record has higher priority 
(as defined by you) than other accounts. 

□DD Work/Ulew/Prlorlty You can control which accounts are listed in the Account List win-
dow by checking the three boxes on the upper left. These boxes let 
you select to see: 

• Work accounts only, 
• Current view accounts only, 
• Priority accounts only, or 
• Any combination of the three. 

To change the status of any box, click to check or uncheck the three 
boxes. 

Checking NJ Accounts You can add or remove check marks (✓). To check any account col-
umn(s) to the left of the account name, point and click. 

Highlighting Accounts 

Zooming to Contacts 

To remove a check mark, point to the check mark and click. 

To select an account, click on the account name, city, or state to 
highlight the account. 

To open the window displaying the contacts for the highlighted 
account, click once on the highlighted account. The Contact List 
window will appear with the names of all contacts for the current 
account. 

Zooming to Entry Window Zoom to the Account window for the highlighted account, double-
click on the highlighted record. The Account window will appear 
with the selected record displayed. You can make changes and 
click Enter as needed. 
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List window shows the names of all contacts for the Contact List 
·· When you select Contact List from the Show ~e1 T!dlsptays the following window: 

tf ~L,< .. 

At the top are listed the current account's name, city, state, zip code, Window Headings 
phone number, and the number of contacts. Then each contact's 
name, title, and extension are listed. 

You select the account for the Contact List (i.e., make it the "cur-
rent account") using one of three methods. 

• Click on the Goto arrow by the account name and the Account 
List will appear; click to highlight the account you want; then 
activate the Contact List. 

• Double-click on the Goto arrow by the account name and the 
Account window will appear; use the clairvoyant search field to 
type the account name and have C.A.T. find the account; then 
activate the Contact List. 

• Click the Next button to scroll through the current list of 
accounts. 

Show Menu 

Current Account 

~Armstro119 &. Knight 
Bloomington, ll. 57830 
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The Contact List window also includes three columns on the left 
labeled W, V, and P. They are defined as follows: 

W Work Contacts that are checked have been changed during 
the current session. The "current session" is the time 
spent since you last saved to disk. When you save to 
disk or quit, the check marks for the Work column are 
automatically cleared. 

V Current Contacts that are checked belong to the currently 
selected view from the Views menu. 

P Priority Checked contact means the record has higher priority 
(as defined by you) than others. 

Checking (.../) Contacts You can add or remove check marks (✓). To add a check mark click 
beside the name in the first three columns. 

To remove a check mark, point to the check mark and click. 

Highlighting A Contact To select a contact record, click on the name, title, or extension 
columns to highlight the record. 

Zooming to Events To open the window displaying the events for the highlighted con-
tact, click once on the highlighted contact. The Events Snapshot 
window will appear with all the events for the current contact. 

Zooming to Entry Window To zoom to the Contact window for the highlighted contact, double-
click on the highlighted record. The Contact window will appear 
with the selected record displayed. You can make changes and 
click Enter as needed. 
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'I'll& S.tl Snapshot window shows a list of the events from your 
c~A. T cMtabase. When you select Events Snapshot from the Show 
menu, the following window is opened: 

Euents Snapshot 

Events Snapshot 

At the top. Events Snapshot has radio buttons, Goto arrows, Next Window Headings 
buttons. and check boxes that are used to select the events to be list-
ed. For each event, the window shows the date, time, contact, 
activity, and amount. 

You control the events you wish to see by selecting buttons. Events 
Snapshot has four sets of buttons that you can set: 

Contacts 
Actlvltlas 
Time 
Todo 

All, by view, an account, or one contact. 
All, by class, or an activity. 
All, by range, or a specific date. 
Work, to do, priority or any combination. 

For contacts, you can select events for all accounts, accounts in the 
current view. a specific account, or for one contact. Click the radio 
button to make your choice. 

You select the current view by choosing a view from the Views 
menu. 

Show Menu 

® All O Uiew 
O I::> Armstrong &. Kntg 

1 

0 C?Kirb'ij Armstrong ~ 

5-39 



5-40 

®Rll-
0~•~ 
Q (:>st-,ct.rd Lett•r ~ 

You select the account to show using one of three methods. 

• Click on the Goto arrow by the account name and the Account 
List will appear; click to highlight the account you want; then 
activate the Events Snapshot. 

• Double-click on the Goto arrow by the account name and the 
Account window will appear; use the clairvoyant search field to 
type the account name and have C.A.T. find the account; then 
activate the Events Snapshot. 

• Click the Next button to scroll through the current list of accounts. 

You select the contact to show using one of three methods. 

• Click on the Goto arrow by the contact name and the Contact 
List will appear; click to highlight the contact you want; then 
activate the Events Snapshot. 

• Double-click on the Goto arrow by the contact name and the 
Contact window will appear; use the clairvoyant search field to 
type the contact name and have C.A.T. find the contact; then 
activate the Events Snapshot. 

• Click the Next button to scroll through the current list of contacts. 

For activities, you can select events for all activities, a class of 
activities, or one activity. Click the radio button to make your 
choice. (Note that if the Active Only check box is checked on the 
Activity List, then only Active activities are shown.) 

You select the class of activity to show using one of two methods. 

• Click on the Goto arrow by the class name and the Activity List 
will appear; click a radio button to select the class of activity; 
then activate the Events Snapshot. 

• Click the Next button to scroll through the activity classes. 

You select the activity to show using one of three methods. 

• Click on the Goto arrow by the activity name and the Activity 
List will appear; click to highlight the activity you want; then 
activate the Events Snapshot. 

• Double-click on the Goto arrow by the activity name and the 
Activity window will appear; use the clairvoyant search field to 
type the activity name and have C.A.T. find the activity; then 
activate the Events Snapshot. 

• Click the Next button to scroll through the current list of activities. 
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For time periods, you can select events for all time periods, a date 
range, or one day. Click the radio button to make your choice. 

You select the date range using one of three methods. 

• Click on the Goto arrow by the date range, and the Calendar will 
appear, click to select a week or double-click to select a month, 
and the Events Snapshot window will appear. 

• Double-click on the Goto arrow by the date range, and a range 
dialog will appear; enter the begin and end dates; click OK and 
the Events Snapshot window will show the specific date range. 

• Click the Next button to scroll through the next date range. 

You select the date to show using one of two methods. 

• Click on the Goto arrow by the date and the Calendar will 
appear; double-click to select a date and the Events Snapshot 
will appear. 

• Click the Next button to scroll to the next date. 

The Events Snapshot window includes three columns on the left 
which show the status of events. They are: 

ODD Work/To-Do/Priority 

W Work Events that are checked have been changed during the 
current session. The "current session" is the time 
spent since you last saved to disk. When you save to 
disk or quit, the check marks for the Work column are 
automatically cleared. 

T To-Do Events that are checked mean that the item needs 
attention (as defined by you). 

P Priority Checked events mean that this event has higher priori-
ty (again, as defined by you) than other events. 

To see just events with a specific status, check and uncheck any 
combinations of the work, to-do, and priority check boxes above 
those columns by pointing and clicking on the boxes. 

You can add or remove check marks (✓). To add a check mark click Checking {V} Events 
beside the event in the first three columns. 

To remove a check mark, point to the check mark and click. 
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Hlghl/ghtlng Events To select an event record, click on the date, time, contact, activity, 
or amount columns to highlight the record. 

Zooming to Event Window To activate the Event window for the highlighted event, click on the 
highlighted event. The Event window will appear with all the data 
for the current event. You can make changes and click Enter as 
needed. 
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Calendar 

Selecting a Day 

The Calendar shows a 
month at a time -- any 
month of any given year. 

When you choose 
Calendar from the Show 
menu, this window will 
appear. 

The field at the top of 
the window displays the 

Su"!Moni Tu•!'f •di Thui Frii Sati 
29 30 1 2! 3! 4 ~ 

, 1 a 9. l,, 12 

13 14 llli 1,1 17° 18 · 19 
20! 21 22 23! 24 2~ 26 
27! 28 29 30! 31 I 2 

3! 4 5 '! 7 8 9 

iJ•n i.Jul 
Feb !Aug 
Mar~.., 
!Apr pct 
Ha11Nov 
~u~lll 
!86 !88 ! 
'•ooNOHIHHNOHI 

date currently selected; below, the day is highlighted. Click on 
any day and it will appear as the current date. Note that this 
date will automatically be used in the Event window when you 
enter new events. 

[ T d ] Click the Today button to set the Calendar to your Macintosh sys-
O ay tern date. The system date is displayed in outline style, no matter 

what date is highlighted. 

Selecting a Month To change the month, click on any month shown on 
the right; the Calendar will display it. 

Selecting a Year 

Zooming to Events 

The year selected is the one between the two years · II 
displayed on the bottom right. To change the year, l~~ ... 
click one of the boxes. Click the right box to move 
forward one year. Click the left box to move backwards one year. 

To see the events for any day or month, click on the highlighted 
box. To see events for a week, click on the left-most column next 
to the week. The Events Snapshot window will appear with the 
events for your selection. 
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,. ! :r:.. •. 
The Acuvity List window shows the names of activities in your 
C.A. T. database. When you choose Activity List from the Show 
---.the following window will appear: 

Activities are listed alphabetically by class. To select the class of 
activities, click one of the radio buttons across the top. 

For each activity, Activity List shows a description, tactic, and 
number of events for this activity. 

On the left is a single column that shows the status of activities. 
All activities are automatically designated as "Active" by a check 
mark. You can mark activities as inactive and choose to see the 
"Active Only" ones by checking the box above the column. 

Note that inactive activities are not deleted from C.A. T. When you 
select Active Only, C.A.T. hides all inactive activities and the 
linked events from view. 

Activity List 

Window Headings 

D Rct111e Only 

To check an record as active, point to the first column next to the Checking (../) Activities 
activity name and click. To remove a check mark, point to the 
check mark and click. 

To select an activity, point and click on the activity, tactic, or count Highlighting Activities 
columns. The selected record is highlighted. 

To see all the events for this activity, click again on the highlighted zooming to Events 
activity. The Events Snapshot window will appear with the events 
for the current activity. 
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zooming to Entry Window To change an Activity record, double-click on the highlighted activ-
ity. The Activity window will appear with your selection displayed. 
You can make changes and click Enter as needed. 
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Status The Status window shows statistics about the records in your 
C.A.T. database. When you choose Status from the Show menu, the 
following dialog box will appear: 

A C.R.T. Uenlon 2 

Recounts: 53 
Contacts: 111 
Euenta: 152 
Rctlultles: 32 
Codes: 42 

FREE MRH 
RRM: 636528 643442 
Support: 408-246-8020 

I OK ] 
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The total number of accounts, 
contacts, events, activities and 
codes entered in your database 
to date are shown. 

You can also see how much 
memory is available: 

• Free RAM is the space 
available including notes. 

• Max RAM is the space 
available without notes. 



commands under 
u. These commands 

; ~ ';.~ ~ 

j 1-your data; 
i Dial die current phone number; 

"'~, ••·~·ll"iiile views; ;i,..,~ 4:lCCOunts by making 
,f views; 
♦ Combine and extract accounts 

ly merging views; 
• A,sign codes to multiple 

accounts or contacts at one time; 
• Record an event for multiple 

contacts at one time; 
• Create letters for multiple con-

tacts at one time. 

Lock 
Dial 
Name IJlew 

HL 

Make Uiew HM 
Merge IJlews 
Set Codes 

Clone Euents 
Mall Merge 

Lock is used to protect your database from unauthorized use. This Lock 
command allows you to step away from your Macintosh temporari-
ly without exiting C.A. T. 

First enter a user password using the Options command and a sys-
tem password using the Password command. Both commands are 
on the Enter menu. Then choose the Lock command from the 
Action menu. The following dialog box will appear: 

C.R.T.: relatlonal database for Integrated 
management of Contacts, Rctluitles and Time. 

Enter password: 

n OK D 

LOCKED. 
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This box will remain on-screen until a valid User Password or 
System Password is entered. Enter your password and click OK. 

If you enter only the user password, you may enter data; but you 
may not change activities and lookup codes; a system password per-
mits full access to all commands and data. 

Note that after you set up passwords, the Lock dialog box will appear 
whenever you load the current file. If you fail to enter a valid pass-
word after three attempts, you will be returned to the Finder. 

Dial Dial is used to automatically dial the phone number for the current 
record displayed in the active window. 

• If the Event-or Events Snapshot window is active, C.A.T. will 
dial the phone number for the linked contact. 

• If the Contact or Contact List window is active, C.A. T. will dial 
the number in the extension field if it is six or more digits long. 
If that field has fewer than six digits, C.A.T. will dial the num-
ber for the account. 

• If the Account or Account List window is active, C.A.T. will 
dial the phone number for the account. 

When you choose Dial from the Action menu, the following dialog 
box will appear: 

A ma1: 
714-555-8349 

( Dini J [ Option ] [ Cancel ] 
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Dle,-,Jiaeyou use Dial, click Option to set the dialer options. WlaCSJ~click Option, C.A.T. will show the following dialog: 

01-.1 Options: 
L1tnl Area Code: 1408 -------81 al for outside llne: 9, ~-------1 Long distance: 9,1-------

® Speaker (tone dialing) 
O Modem (tone dlnllng) 
O Modem (pulse dlnllng) ,•-o•K--•) [-c-a_n_c_e1"""') 

The information you enter into the three boxes is used as follows: 

• Local area code 

• Outside line 

• Long distance line 

If the number you wish to dial has 
the same local area code as the 
code supplied here, C.A.T. will 
skip the code when dialing. 
Further, C.A.T. will not prefix the 
number with the long distance 
data below. 

If you need to dial specific digits 
to access an outside line, enter the 
digit(s) in this box. C.A.T. will 
automatically dial for the outside 
line first. 

If you have a special code that 
you dial to access a long distance 
line, enter the code here. Include 
the digits needed to access an out-
side line. 

Dial offers three methods to dial. The Speaker option uses the 
Macintosh to generate tones. On some phones, the tones can substi-
tute for your pressing or dialing numbers on the phone. The Tone 
and Pulse options use the dialing capabilities of modem accessories 
to dial phone numbers. (Consult your modem manual for more 
information.) Select an option and click OK. 

Action Menu 

Dial Options 
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Name View This command is used to assign or change the name of a view. 

First select a view from the 
Views menu, then choose Name 
View from the Action menu. A 
dialog box will appear. 

Enter or change the title in the 
space provided and click OK. 
The title will appear in the Views 
menu and in the Account List 
window when that view is 
selected. 

Name Ulew: Enter 
ulew name, select 
color and click OK. 

QRed 
O Green 
Qcyan 
@Black 

QBlue 
O Yellow 
0 Magenta 

n OK B [ Cancel ) 

If you have a color monitor, you can optionally set the color for the 
view by clicking one of the choices supplied. Records in this view 
will be displayed in color. 

Make View Make View creates views of your accounts or contacts by matching 
your C.A. T. data against search criteria such as partial city, state, 
and zip code data. Make View searches for all accounts and con-
tacts that satisfy your criteria and displays them in the Account List 
as a new view. (For examples of using Make View, see "Managing 
Contacts" in chapter 3.) 

To make a view, select one of the views from the Views menu, then 
choose Make View from the Action menu and the following dialog 
box will appear: 

~ Make ulew: Enter crtterte; then cllck Start. I I start J 
(Q}N■-:HI .~ ~ 

Color. :0,-::R,-ed~--,:0,-::■,.,-lu-•----,::Oc-:&,-n_e_n___, [ Cancel 
4t ■laclc O Yellow O Cyen O Magenta 
Recount: 
City: 
State: 
Zip: 
RIIH: 

Country 
T■bla-2 

Table-5 
T■ble-4 

Title 
lauel 

Teble-5 
Tabla-6 
Table-7 
Teble-8 1--------11 Table-II 

. Tebla-12 
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· •. · · · · · · · 'iWindow, enter the name of the view. This name Title Field 
name in the Views menu. 

·using ,It color monitor, select a color. Each account in the Color Buttons 
)e displayed in this color. 

-}6dtsearch criteria in the appropriate fields. In the middle of Search Criteria 
,....._ you can enter account name, city, state, zip, and alias infor-
~ from your account records. 

la t.lle tower half of the box, you can enter codes from any of your 
leolmp'tables for accounts and contacts. 

,;f : ~---

You can use the following logic operators and modifiers: 

Operator Example Meaning 

(text only) ABC Starts with the letters 'ABC' 
• :ABC Exactly to 'ABC", note spaces 
> >ABC Greater than 'ABC' 
C cABC Lass than 'ABC' 
>= >=ABC Greater than or equal to 'ABC' 
c■ c:ABC Lass than or equal to 'ABC' 
? ?ABC Contains the letters 'ABC' 

ABC .. XYZ Range from 'ABC' to 'XYZ' 

C.A.T. interprets blank fields to mean that no selection criterion is 
specified and all accounts and contacts should be included. 
To find all records that have no values in a particular field, for exam-
ple, all records that are missing zip codes, enter the •-• operator 
only in the field. 

Modifier Example Meaning 

I 

AIBIC 'A' or 'B' or 'C' all pass the 88lee> 
tlon criteria. 

/ABC 
/:i,,,ABC 

Starts with 'A' or greater than 'N' 
or contains 'X' 
Does not start with 'ABC' 
Not greater than 'ABC' 

(For more information on the use of these operators and modifiers, 
sco 'Mllnaging Contacts' in Chapter 3.) 
Af~,Xp,!.J enter your criteria, click the Start button to begin the ( Start JI 
selection process. C.A. T. will find all of the accounts and contacts .... -1J 
that match your criteria and display them in Account List. 
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[ Clear ] Click the Clear button to clear all of the fields in the Make View 
------ dialog box for new entries. Note that Clear does not delete any cri-

teria previously saved. 

( Cir uiew ] Click the Cir view button to clear all accounts and contacts from 
the selected view. This allows you to create a new view by manual-
ly checking records in the Account List window. 

Merge Views Merge Views is used to work with more than one view at a time. 
This command helps you combine, extract, compare, or eliminate 
accounts and contacts from various views. 

When you choose Merge Views from the Action menu, the follow-
ing dialog box will appear: 

~ Merge Ulews: Select a mode 
~ and an operation. (see manual 

for eHDlanations) ~--- _;c..;.;.;.;;.;; _____ ~ 

MOOE 
@Set 
OMerge 

OPERATION 
® Work <= Current 
O Work <• Euent 

O Intersect O Current<= Work 
O Remoue O Current<• Euent I DK ) [ Cancel ) [ Clear Work 

If you are using the "Current <= Work" or "Current <= Event" oper-
ations, enter a title for the view to be created. The title will appear 
in the Views menu and in the title bar of the Account List window 
when the view is selected. 

Click to select a mode and an operation. The Mode controls how 
two views will be combined: 

Mode 

Set 

Merge 

Intersect 

Remove 

Explanation 

Repl~t:e one view with another. 

Merge one view with another to create combined view. 

Intersect to find common members of two views. 

Remove common members of one view from another. 
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Evmt 

Tie Work view la a transient view. Each member of 
the view has a check mark In the Work column of the 
Account List and Contact List windows. Normally, the 
Work view Is used to accumulate all new records and 
racords that have changed during the current session. 

The current view Is the last view selected from the 
Vlewa menu. Each member of this view has a check 
mark In the View column of the Account List and 
Contact List windows. You can cllck the Cancel 
button In the Merge View dialog box to return to the 
main screen and select a different view, If needed. 

The Event view Is the 11st of events currently dis-
played In the Events Snapshot window. 

The view to the left of the"<=" symbol is the view that will be cre-
ated as a result of the merge. 

After you make your selections in the dialog box, click OK. When Ii[ OK ]I 
the merge is complete, a dialog box will appear showing the number ll~liiiiiiiiiiiiiiiiiiiiiiiiiiil.,1 
of accounts in the new view. Click or press any key to continue. 

If you wish to clear all of the accounts in the Work view, click the 
Clear Work button in the Merge Views dialog box. C.A.T. will ask 
you to confirm the action. Click as appropriate. 

( Clear Work ] 

Set Codes is used to assign codes to more than one account or con- Set Codes 
tactat a time. This command allows you to enter a code for every 
account or contact in the current view. 

First, display the view to which the codes will be set, in the 
Account List window. 

Next. display the lookup table which contains the code you want. 
Click once to highlight the code, then choose the Set Codes com-
mand from the Action menu as shown below: 
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C.A.T. will ask you to confirm the action: 

~ Set Codes: Set the 'Industry' field to the 
~ 'Manufacturing' ualue for ~!! r~c:,uds in the 

current ulew. 
(
11(-!!!!DK!!!!!I!!!._, [ Cancel 

Click OK and the code will be linked for every account or contact 
in the view. (See "Managing Contacts" in chapter 3 for more exam-
ples of lookup tables and codes.) 

Clone Events Clone Events is used to create an event for more than one contact at 
a time. You can create an event record for every contact in the view 
currently displayed in the Account List window. 

First display the view of accounts and contacts to which this event 
should be cloned, in the Account List window. 

Then create the event to be cloned by choosing any event record 
and displaying it in the Event window. 
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The following dialog box will appear: 

A-.. Clone auent In data window 
~ for 1111 memben of the 

'Nat1on11I Accounts' ulew: 
MaH auant1 per day: I OK ] 

!sooo I 
[ Cancel ] 

Max events per day lets you set the daily limit of how many events 
you can handle. For example, if you have cloned 50 events that 
require follow-up calls but you can only make 10 phone calls a day, 
Oiiter •10• in the field shown above and C.A.T. will schedule 10 
caUa per day over a period of five work days for you. C.A. T. even 
lllCOpizes weekends so that no events will be scheduled on 
Saturdays or Sundays. However, it does not know your holidays. 

~OIC and a dialog box will appear showing the number of 
ctvents c::reated for all of the contacts (in the accounts) displayed in 
the cunent View. Click or press any key to return to the main 
~•. 
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Mail Merge is used to create letters for more than one contact at a 
time. This command allows you to create a form-letter event for 
every contact in the view currently displayed in the Account List 
window. Then you can print all of the letters at one time. (For an 
annotated example of creating, preparing, and printing form letters, 
see chapter 3, "Managing Activities.") 

Note that you must first create the letter activity using the New 
Form Letter command. 

Display or create the view which includes all of the accounts and 
contacts who will receive the letter, in the Account List window. 

Next create or display an event record in the Event window that 
shows the letter you wish to send for one member of the view. 

Then select the Mail Merge command from the Action menu as 
shown in the following screen: 

Hor..,-Pr-
lRflhttvl.aM 
... ,r-,CAMll2 
ATlN: lfflKHcpoHdt 

-1111:4 

►AIICCorp.wfflllo--•-•T-..,,-1D,l!11'1. 
You IA -'lly llrtftlMI lo et-. 

A dialog box similar to the following will appear: 

Click OK to confirm 
the action. 
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MBII Merge: Schedule euent 
in data window for all 
members of the 'California 
Recounts' ulew. Then use the 
PRINT commBnd to produce 
documents. 

([ OK )) Cancel 
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Appendix A: Import/Export 
CA.'f. .is designed for sharing information. You can import or 
...,..._ from or to spreadsheets, word processors, another 
~T. mer, or other databases. C.A.T. provides the support needed 
1tJ corporate users for merging and sharing of data among users and 
~ons. 

;• the Run Macro command to import and the Copy Records 
· · d to export data. 

Usera can import data from DOS databases such as PFS File, Lotus Import Data 
1-2-~. Q & A, Microsoft File, and dBase III Plus. 

ta the realm of Macintosh software, names, addresses and other 
information have been transferred to C.A. T. successfully from 
Yll~er Plus, OverVue, More, Omnis 3, Excel, Microsoft Works, 
l1Kl HyperCard. 

Data from IBM mainframes and Tandem computers, among others, 
bave also been imported to C.A. T. 

C.A. T. uses the import capabilities of Microsoft Excel to manipu- Via Excel 
JMIHlata. Once data is imported into Excel, a simple copy and 
·pure moves data into C.A.T. As a result, C.A.T. imports data from 
lilr P9JDPUter or application that supports the data requirements of 

• · · standard Excel spreadsheet. 

lollowing is a step-by-step procedure to import data into C.A.T. 
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Creating a Text File If your data is in FileMaker Plus, create a text file that Excel can 
load as follows: 

1. Choose Output To from the File menu 
2. Name the output file. 
3. CIiek New. 
4. Select the desired data fields In the Field List and Move 

them Into the Output Order column. You will be asked If you 
wish to Include or exclude calculation fields. 

5. CIiek Include. 
6. Select the Text button. 
7. Select the Unformatted Values button. 
8. CIiek Output. 

FileMaker Plus will create a Text file and save it to your disk. 

Loading Into Excel 9. In Excel, open the Text file you created In FlleMaker Plus. 
1 o. Choose Save As from the FIie menu. 
11. CIiek Normal. 
12. CIiek Save. 

Microsoft Excel will create a Normal file and save it to your disk. 
Your file is now ready for the cut-and-paste operations described 
below. 

Similarly, text files can be created for Excel from various 
Macintosh database products such as More, OverVue, MicroSoft 
File, 4th Dimension, Omnis 3, HyperCard, and MicroSoft Works. 

DOS Comma -delimited Flies Unlike Macintosh Normal and Text spreadsheet files which use a 
Tab to separate fields and a Return to separate records, IBM DOS 
spreadsheet files use commas to separate fields and a Return to sep-
arate records. 

Therefore, if you are transferring files from an DOS format to the 
Macintosh, save your file as a comma-delimited file. Then through 
a utility such as TOPS, Dayna file, or a file server that allows DOS 
and the Macintosh to share data, load the file into the Macintosh 
spreadsheet using the Open command. 

Preparing Your Data Once your data is in a spreadsheet, you must arrange the data fields 
to match the predefined data field formats of C.A.T. Start by 
importing account records into C.A.T. (e.g., contact, company, 
address, city, state, zip, phone, account number, notes). 
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T&11o dds, you must arrange your spreadsheet data field columns so 
that they ~spond to the data fields structure in C.A. T. 's Account 
window. If your data includes only one contact per account, this 
~~the only spreadsheet you will have to import into C.A.T. 

"l!lwfollowing is a sample Excel spreadsheet with account informa-
lieit. Note that the first name and last names are in two columns. 
You can use Excel to create a single field out of two. 

Format Date Options Macro Window 

The object of this exercise is to make the number and order of the 
data fields in the spreadsheet exactly match those of C.A.T. 
Therefore, you may have to move, add, or delete columns (e.g., add 
an Alias column to match the C.A. T. field) in order to make your 
spreadsheet column structure match C.A.T.'s data field structure. 

-~. you should review and clean up your data, removing 
cl)ipBcates, standardizing spelling, etc. 

t;~~%,'.;.',J'.'.'i·:j'. 

V."may leave individual data cells empty if there is no information. 

VOit must leave empty columns on the spreadsheet as required to 
mallCb C;A.;T. 's data field structure. For example, if you do not have 
pltoae numbers, you still need to reserve a column for phone numbers. 

Don't worry about the amount of data in your fields at this time. 
C.A. T. may have to clip off excessive data in a few fields, but you 
,..U find it easier to identify and edit such shortened fields in 
~T. than in the application in which the data was created. 
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Using A Spreadsheet In the spreadsheet, you can use the Delete command to delete a col-
umn, the Cut and Paste commands to move a column, or the Insert 
command to add a column. 

You can use the & operator to combine two columns into one. For 
example, if you stored the first name in column A and the last name 
in column B, you can combine the fields using the following formu-
la for the first row: 

:A1&" "&B1 

You can also use Excel formulas to break one column into multiple 
columns of data. For example, if you had entered the city, state and 
zip code as one line in cell Al: 

San Jose, CA 95129-1088 

You should use the following functions to split the information into 
separate columns. 

cell B1 contains: =SEARCH(",",A1,1) find the comma 
cell C1 contains: =SEARCH(",",A1, B1+2) find the 2nd space 

following the comma. 
cell CITY: 
cell STATE: 
cell ZIP: 

=MID(A1,1,B1-1) extract city 
=MID(A1 ,B1 +2,C1-B1-2) extract state 
=MID(A1 ,C1+1,LEN(A1)-C1) extract zip 

When you have finished arranging the spreadsheet columns to 
match C.A. T. 's account record, your spreadsheet should havenine 
columns (Contact- Company - Address -City - State - Zip 
Code - Phone Number - Allas - Comments/Notes). 

When you have finished arranging the spreadsheet columns to 
match C.A.T.'s Contact Record, your spreadsheet should have 
eleven columns (Contact - Company - Tltle - Lookup Table 1 O 
-- Lookup Table 11 -- Lookup Table 12 -- Mr./Mrs./Ms. -
Extension - Allas -- Mall Stop Number - Comments/Notes). 

Appendix A 



F_.Y,-19' lltlld to create a fmal data field column to tell C.A.T. to {Enter Button} 
enter the data in each row automatically: 

• FIQll, . ...- .. IHt vacant column In the spreadsheet, (the 10th 
Mlumn If you're entering Account records, or the 12th col-
umn If you're entering Contact records. 

• In th• top data cell of this column, type: {Enter} 

Nota that brackets { } must be used. 

• Place your cursor on this top data cell and select all the 
cells down to the level of your last record In the spread-
sheet. You may •Imply scroll down to the desired level or 
U88 the elevator/shift/click method of selecting. 

Do not •Imply select the entire column In the spreadsheet. 
You may get an "Out Of Memory" message. 

• Choose Fill Down from the Edit menu. 

The contents of the top cell will be replicated in each selected cell 
below it in the column. 

To move your spreadsheet data into C.A. T., you must first select the Copy Cells 
rows of data you wish to move and Copy them into the Clipboard. 
The Clipboard can handle approximately 200 records with com-
ments/notes or about 300 records without. If your data files exceed 
these limits, you can simply copy the maximum number of records 
the Clipboard will take and after you finish loading them into 
C.A.T., jot down the number of records that have actually been 
entered. This will tell you if and where you need to start your next 
copy cycle from the spreadsheet. 

Note: Do not attempt to Copy your spreadsheet to the Clipboard if 
your Macintosh is a message center for networking software such as 
InBox. You may not be able to copy to the Clipboard with the mes-
sage center running. Other memory intensive applications may 
pose similar problems. 
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When your spreadsheet files can be copied into the Clipboard, you 
are ready to import your data into C.A.T. 

1. Select the desired data cells in the spreadsheet. You may 
simply scroll down to the desired level or use the shift/click 
method of selecting. 

Note: Do not simply select the entire spreadsheet. That is, do 
not include all rows and all columns in your selection. You may 
get an "Out Of Memory" message. Select only data cells. 

2. Choose Copy from the Edit menu. 

Your spreadsheet data is now entered into the Clipboard. 

3. Choose Quit from the File menu. 

You will be offered a choice of saving formatted or unformatted 
values. 

4. Click Save Unformatted Values and click OK. 

You will be returned to the Macintosh desktop. 

5. Load C.A.T. 

If you are importing Account records, choose New Account 
from the Enter menu. 

If you are Importing Contact records, choose New Contact 
from the Enter menu. 

Depending on your selection, the Account window or Contact 
window appears. Make sure that the cursor appears in the 
Contact field of the Account window or in the Name field of the 
Contact window. Click in these fields, if needed. 

Run Macro 6. Choose Run Macro from the Edit menu. 

You will be asked to verify that you want C.A.T. to enter the 
contents of the Clipboard. 

@ RUN MACRO: Start C.R.T. data macro using 
· · contents of clipboard. 

Cancel 

7. Click OK. 
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lla,Mam will enter each record from the clipboard. Each 
raeortl. wiaappear momentarily in the window as it is automati-
caDy...-.«L lfa given data field is too long, you will be asked 
to allow C.A.T. to clip it to the appropriate length. If this hap-
pens, click once to continue. 

If you need to cancel Run Macro, click the mouse. 

· Note: Do not Save your data until you are sure where Run 
Macro stopped. Before you Save, open the Account List or 
Contact List window from the Show menu and jot down the 
number of records entered in the database. This will tell you if 
and where you need to start your next Copy and Run Macro 
cycle from the spreadsheet. This number appears in the Account 
List window in the upper right hand corner, and in the Contact 
List window in the upper right hand corner below the Phone 
Number box. It is helpful to remember that C.A.T. works with 
only one central database which you later divide into different 
"views." Therefore, successive data importation cycles will 
simply add data to the central database rather than creating new 
individual databases with different names. 

8. If the Imported data Is the start of a new database, choose 
"Save As ... " from the FIie menu, enter a name for your 
database, and cllck Save. 

If this is not your first data importation cycle:, choose Save from 
the File menu. 

9. Exit C.A.T. by choosing Quit from the FIie menu. 

You use the Copy Records command under the Edit menu to export Export Data 
records from C.A.T. to other applications. You can use Copy 
Records to pass to the clipboard: 

• a·single record, 
• an entire view, 
• all entries in an Events Snapshot window, 
• a set of related records, or 
• any combination of these records. 

From the clipboard, the records can be sent to: 

• .... . . C C'.A . . T. database, 
• •~fteet, 
• a for'~sing program, or 
• any 1pplic*-1lion that accepts tab-delimited files. 
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Selecting Records To use Copy Records, select the records to copy using any list win-
dow. For example, if you want to copy a single account, activate 
the Account List. Then click to highlight the account to copy and 
select Copy Records from the Edit menu. 

Choosing Options 

If you want to copy all events from Events Snapshot, activate 
Events Snapshot; identify and display only the events you want; 
(make sure no single event is highlighted by clicking a blank row if 
necessary); and choose Copy Records. 

Depending on which window is active, Copy Records displays a 
dialog of options. The options might include: 

• Use the C.A.T. format and insert commands in the data that tell 
the Run Macro command which window to use for which 
records. If you do not choose this option, records are copied 
using the tab-delimited format of a spreadsheet. 

• Include record notes with the data copied. 

• Include linked records with the record to be copied. For exam-
ple, if an account is selected, you can choose to pass all contact 
and event records as well. 

• Pass notes only, in the word-processing format. 

Click to select the options you need and click OK. The data is 
copied to the clipboard and ready for import into another product. 

C.A.T. to C.A.T. For example, to send information from one C.A.T. database to 
another: 

• Display the list of accounts to be copied in the Account List 
window. You can select a View showing the accounts you want 
to transfer. 

• Choose Copy Records from the Edit menu. The following dia-
log box will appear: 

A Copy 'Recount' to the clipboard. 

181 C.R.T. format (suitable for Run Macro) 
181 Include record notes. 
1811 nclude all contact and euent records. 

("'-•o•K•~-- [ cancel ) 
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• •lefoetdieC . .A.T. format option. This option transfers your data 
ilfafonnat that will allow it to be imported into another C.A.T. 
fileiy using the Run Macro command. Select the options to 
include notes, contact, and event records if you wish. Click OK. 

Your file is now on the Clipboard. If you are transferring files via 
•tronic media, you can first paste the Clipboard contents in a 
memo sheet. Send the memo sheet across the wire. At the receiv-
ing •~ copy and paste the records onto the Clipboard and use Run 
Maeri> to get the records into the receiving C.A.T. as follows: 

• Open the C.A.T. database to which the records will be copied. 
Click once to highlight its name in the Open command dialog 
box, then click Open. 

• Choose Run Macro from the Edit menu. 

• C.A.T. will ask you to confirm the action. Click OK. 

The names, addresses, notes, etc. will be copied into the receiving 
C.A.T. database very rapidly. It takes approximately 15-20 minutes 
to do 200 records. 

From the Events Snapshot window, you also have the option of 
copying only your notes into a word-processing application: 

• Display the events to be copied in the Events Snapshot window. 

• Choose the Copy Records command from the Edit menu. Select 
the "Only copy notes ... " option and click OK. 

~ Copy 'list of Euents' to the clipboard. 

D C.R.T. format (suitable for Run Macro) 
D Include record notes. 
fgl Only copy notes for word processor. 

Cancel ) 

• Choose Quit from the File menu. 

• Load the word-processing application and choose Paste from the 
Edit menu. 

• Make your changes and print with your favorite word processor. 

Import/Export 

C.A. T. to Word Processor 
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C.A. T. to Spreadsheet Using the same instructions, you can copy any data from C.A.T. to 
a spreadsheet: 

A-10 

• Display the records to copy in a list window. 

• Choose Copy Records from the Edit menu. Uncheck the 
"C.A.T. format ... " option and click OK. 

• Choose Quit from the File menu. 

• Load the spreadsheet application and choose Paste from the Edit 
menu. 

The records are copied to the spreadsheet. Each row shows one 
record and each column shows one field. 

Sharing Data C.A.T. makes it easy to share data. The Copy Records and Run 
Macro commands make sending and receiving records as easy as 
"copy and paste." 

Sales Management 

Special features in C.A.T. automatically insert preprogrammed 
commands that tell the receiving C.A.T. database to place all the 
relational records in the right place and establish the proper links 
among records. 

This sharing feature is very useful for people who work in a group 
or in departments that support common clients. While each person 
could be working with various contacts, they can pass files back 
and forth so that all the efforts are synchronized. 

Consider how the import arid export features in C.A.T. can be applied to 
a decentralized sales operation. 

To service customers better, sales departments often rearrange terri-
tories. The biggest challenge is to maintain continuity. For exam-
ple, user A can pass all accounts in New York to user B when terri-
tory responsibility changes. A creates a New York view in his 
C.A.T., issues a Copy Record command, passes the data to user B 
through any electronic mailbox. User B pastes the records into 
another C.A.T. database. The records may include all phone notes, 
letters, and meeting notes for the accounts and contacts in New 
York. 
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Using these basic "copy and paste" operations, a company can col-
lect leads at a central site, dispatch the leads to branch offices, and 
have individual representatives follow up, all with minimal entry of 
data. Using the Make View command, the leads can be grouped by 
geography; and the leads are passed to the appropriate offices. The 
company saves money by lowering data entry while enhancing the 
level of service on leads. 

Conversely, branch offices can generate leads and send them in for 
central mailings, using the same "copy and paste" operation. 

With C.A. T, the user has the information for sales forecasting. 
C.A.T. users can prepare a list of events (such as a forecast by 
client), copy the data to the clipboard and paste the information into 
a spreadsheet. The data can then be massaged, analyzed, or 
graphed using the capabilities of a spreadsheet. 

Using this feature, a company can consolidate reporting electroni-
cally. Individual users can prepare reporting requirements in 
C.A.T., copy the report to the clipboard, and send the report. 

There the reports are consolidated at a central site by pasting each 
electronic memo into a spreadsheet. The data can then be analyzed, 
subtotaled, and graphed for fast reporting of results from remote 
offices. 

The power of C.A.T. works for groups as well as for individuals. 
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Appendix B: 
Utwences For Preset Text 
l" 

C.A. T. provides the following References which can be used to 
simplify your preparation of correspondence and reports. 
References may only be used in the Note field of the Activity 
window and must be entered between markers. (See "Managing 
Activities" in Chapter 3 for usage examples.) To enter references, 
just type the Hot Keys shown. 

Reference Hot Keys Represents 

Option. (period) Beginning of Text Block 
Option , (comma) End of Text Block 
Option y Account Name 
Option p Account Number or Alias 
Option 5 City, State, and Zip Code 
Shift Option = Street Address 
Option m City 
Option d State 
Option w Zip code 
Option I Mail Stop 

(lower-case letter "I") 
1:21 Shift Option p Account Phone Number 

i Option z Contact 's Full Name. 
Option' (apostrophe) Last Name 
Option o First Name 

MB 
(lower case letter "o") 

Option 1 (number "1 ") Contact's Alias 
Shift Option I Phone Extension 

mm) Option v Salutation. 
Tl Option f Date of Selected Event. a Option X Time of Selected Event. 

Option j Current date from 
Macintosh clock. 

fiiil Option\ Date of the event preceeding 
the selected event. 
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Account Information 

Contact Information 

Correspondence 
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Lookup Tables 

B-2 

The following references are used to insert lookup codes in the 
Note field of event records. The first eight references are lookup 
codes from the Codes window; the last four are from the Contact 
window. Since each Lookup Table is custom defined, the meaning 
of each table depends on your usage. 
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Option - (hyphen) 
Shift Option - (hyphen) 
Option [ 
Shift Option [ 
Option] 
Shift Option ] 
Option I 
Shift Option v 
Option r 
Option g 
Option 2 
Option e 



To create your own logo, yo need a Macintosh utility program 
called "Resource Editor". If you do not have this utility, check with 
your loc:al dealer. 

Load the Resource Editor and your C.A.T. Work Disk. Double 
click on the Resource Editor icon and a dialog box will appear with 
multiple filenames displayed. Double-click on the "C.A. T." 
program filename. 

A window titled "C.A.T." will appear, also with multiple filenames 
displayed. Double-click on "ICON". A window titled "Icons from 
C.A. T." will appear with three items as shown below: 

!DI Icons from C.H.T. Uersion 1. 

-- tQ 
~ ~ --

(257) (256) 

0 

(The icons have been labelled for your convenience.) You will: 

• Edit the icon labeled "256" to create a Single logo or 

• Edit "256" and "257" to create a Double logo. 

Doublo-click to open "256" as shown in the following illustration: 

Icons from C.H.T. Uersion t. 

(257) (256) 
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A window titled "Icon ID= 256" will appear with the C.A.T. logo 
in it: 

§0§ I con ID • 256 from C.R.T. l.lerslon 1.0 

••• • • • • • •• • •• • • • • • • • • • ••• • •• .11.11. •• A • • • • • • • • • • • • • • ••• •••••••a•••••••••• ••••••••••••••• ••••••••••••••••• •••••••••••••••••• 

The area for creating your logo is 32 dots wide. A printed image is 
3/8" wide. Click with the mouse to remove the C.A.T. logo and 
create your own logo pixel by pixel. An actual-size image of your 
design will appear on the right side of the window as you work. If 
you wish to create a double logo, double-click to open "257" and 
complete your design. The combined image of "256" and "257" is 
3/4" wide. 

When you are ready, close the "C.A.T." window and you will be 
prompted to save. Click "Yes", then choose the Quit command 
from the File menu. Your logo will appear in the upper right comer 
of printed reports. 

Creating A Logo 



· ·. · .. . Ix D: 
iard Commands 

....,Commands Keys to use 
(>pen CmdO 
Save CmdS 
Print ... CmdP 
Quit CmdQ 

Run Micro CmdR 
Cut CmdX 
Copy CmdC 
Paste CmdV 

New Event Cmd0 
New Account Cmd 1 
Codes Cmd2 
New Contacts Cmd3 

Activity Class Cmd4 
New Activity CmdS 
Tactics Cmd6 

Accounts List Cmd7 
Contacts List Cmd8 
Event Snapshot Cmd9 
Calender Cmd' 
Activity List Cmd-
Status Cmd= 

lock Cmdl 
Make View CmdM 



Other Commands Keyboard Extended Keyboard 
Window Commands Commands 

Entry windows CmdG Home 

Entry windows CmdU PgUp 
Lookup Table Cmd D PgDn 
Contact List 

All windows CmdW End 

All windows Cmd? Help 

Entry windows only Cmd E Enter 

Entry windows only Cmd K Clear 

Extended keyboard commands available for Macintosh II and SE. 
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When you set up a new C.A. T. database and save your entries for 
the .first time, two files will be created: 

• A Data file which contains all account, contact, activity, and 
event records; 

• A Notes file which contains the addresses of all accounts and all 
of the entries made in Note fields. 

C.A. T. Files 

When you create a new C.A. T. database, the default names will be Renaming Flies 
"Untitled" and "Untitled-NOTES." If you choose to rename these 
files, keep in mind that they MUST have the SAME NAME in 
order for information from one to be tied to the other automatically 
when you load. The first part of the Notes filename must be the 
same as the Data filename followed by "-NOTES". 

If you change the name of your data file and forget to change that 
of the notes file, C.A.T. will let you know that a matching Notes 
file could not be found when loading. You will be given the oppor-
tunity to load a Notes file with a different name. When you save 
and exit, C.A.T. will prompt you to change the name of the Notes 
file so that it matches the name of the Data file. 

It is very important to keep track of both files to insure that your 
notes will appear in the correct Note field for each account, contact, 
activity, and event record. 

H you lose your Notes file by accident, all of the information Lost Notes Flies 
entered in Note fields as well as the the addresses of your account 
records will be gone. However, the Data file will remain intact. 

When backing up, be sure to make copies of both files. The larger Backup Your Data 
yom (ilu. tbe more likely the files can be corrupted due to disk 
media problems. Media is generally 99.97% reliable, but unfortu-
·118tCly never 100%. 
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Using Multiple Disks 

Out of Memory 

E-2 

When you first begin to use C.A. T, the two files can reside on the 
same disk and C.A.T. will automatically load both. But as your 
database grows, you may have to store your Notes file on a separate 
disk. C.A.T. will first try to find the Notes file with the same name 
on the same disk. If a Notes file is not found, C.A.T. will prompt 
you to load one. You can then direct C.A.T. to the second disk to 
load the Notes file. 

To move the Notes file to a separate disk, simply drag the file to a 
new disk. Then remove the Notes file from the original disk by 
dragging it to the "Trash". 

Periodically check the Status window under the Show menu. As 
free memory drops below 10,000, you need to either upgrade your 
system by adding more memory or re-use old account and contact 
records when you need new ones. In other words, replace the old 
with the new. 
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Glossary 

account: A record entered in 
C.A. T. to store the names and 
addresses of companies or indi-
viduals. 

active window: The frontmost 
window on the desktop. 

activity: A record entered to 
store information about any sub-
ject matter that you wish to keep 
track of in C.A.T. Simple activ-
ities could be letters, phone 
calls, and meetings. Significant 
activities could be orders, con-
tracts, or proposals. 

activity class: A general head-
ing for grouping different types 
of activities. Think of activity 
classes as file drawers, and 
activities as folders in each 
drawer. 

auto-dial: The phone symbol in 
C.A.T. that enables you to dial 
via a modem or equivalent 
device. 

back up: To make an extra 
copy of your files on disk in 
case the original is lost or dam-
aged. 

backup disk: A disk on which 
you keep extra copies of your 
files for safe keeping. 

button: Part of a dialog box or 
window that is clicked to per-
form certain actions. 

clairvoyant field: In C.A.T. 
windows, a heavily outlined 
field used to locate record 
names. 

clairvoyant search: A method 
used in C.A.T. to select and link 
records. When the first letters 
of a name are typed in a clair-
voyant field, C.A.T. displays 
possible matches. 

click: To position the pointer 
on something, press and quickly 
release the mouse button once. 

cloning: A feature in C.A.T. 
used to create event records for 
more than one account or con-
tact at a time. 

close: To clear a window from 
your desktop by clicking the 
close box. 

close box: The little square on 
the left side of the title bar of a 
window. Click in it to close the 
window. 

command: An action for 
C.A.T. or the Macintosh to per-
form when selected. 

contact: A record entered in 
C.A.T. to store the full names of 
individuals and other individual-
specific information. Every 
contact must be linked to an 
account. 
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database, relational: A system 
which stores information in mul-
tiple files which are linked 
together. 

dialog box: A box that appears 
on the screen with options or 
messages for you. 

disk: The magnetic medium on 
which the Macintosh stores 
information. Macintosh uses a 
3.5" floppy disk. 

dossier: A history of an account 
which can be printed as a report. 

double-click: To position the 
pointer on something, press and 
release the mouse button twice 
in quick succession without 
moving the mouse. 

drag: To position the pointer on 
something, depress the mouse 
button, and move the mouse; 
then release the button. 

echo field: In C.A.T. windows, a 
dot-lined field where record names 
are displayed when you type in the 
adjacent clairvoyant field. 

entry window: C.A.T. has two 
types of windows, one for dis-
playing and the other for enter-
ing data. Most entry windows 
are characterized by a solid 
black strip across the top of the 
window. Certain entry win-
dows, however, are dialog 
boxes. 

event: A record entered in 
C.A.T. to store information 
about a specific activity with a 
specific contact on a specific 
date and time. 

G-2 

export: Copy C.A.T. records 
and make them available for 
other applications or another 
C.A.T. user via the Clipboard. 
See also Sharing. 

Finder: A Macintosh tool on 
the desktop to manage docu-
ments and applications, and to 
access and keep track of infor-
mation on your disks. 

list window: C.A.T. has two 
types of windows, one for dis-
playing and the other for enter-
ing data. List windows display 
records and are characterized by 
six parallel lines across the top 
of the window. 

lock: An action that protects 
your C.A.T. database from unau-
thorized use. 

lookup code: Any attribute that 
you wish to assign to distinguish 
one account or contact from 
another.· 

Goto arrow: A C.A.T. symbol 
to help you navigate among vari-
ous windows. Clicking a Goto 
arrow beside a field displays 
related windows. 

lookup table: A set of lookup 
highlight: To select and display codes. 
an item in reverse video. 

hot keys: Keys on the keyboard 
that you press to enter references 
for preset text. 

I-beam: A blinking cursor on 
screen used for text entry. 

icon: A graphic representation 
of an object, concept, or mes-
sage. 

import: To enter data into 
C.A.T. via the Clipboard. 

initialize: To prepare a disk for 
use on the Macintosh. 

insertion point: The spot in a 
field where data is entered (by 
positioning the I-beam and 
clicking). 

link: The relationship between 
records in C.A.T. (e.g. a contact is 
linked to its account; an event is 
linked to a contact and activity). 

Glossary 

macro: Instructions embedded 
in computer-understood form 
telling the computer program to 
perform certain functions auto-
matically. 

memory: The place in the 
Macintosh where information is 
stored temporarily. 

menu: A list of commands that 
appears when you click on a 
menu title in the menu bar at the 
top of the screen. 

mouse: A small device that you 
roll on a flat surface to move the 
pointer on the screen. 

Next button: A diamond-
shaped box that lets you review 
records. Clicking the bottom of 
the diamond displays the next 
record; clicking the top displays 
the previous record. 

notes: Any information that you 
wish to record in a Note field in 
C.A.T. windows. 



·a window by 
on an icon or 

~.aeommand from a 
~ display a window. 

,,c .'., ., . 

,...d: A string of charac-
ters dllt you enter to access a 
locked C.A. T. database. 

,._: A small shape on the 
scroea that tracks the movement 
of the mouse. 

preset tactic: A preliminary or 
follow-up activity which can be 
set up in advance so that when-
ever a primary activity is sched-
uled, the tactic activity will be 
scheduled as well. This feature 
helps you create a tickler file. 

preset rate: This is the hourly 
rate set up in advance in the 
Tactics window to let you com-
pute billable amount for time 
spent on a certain task. 

preset text: Any text that you 
wish to set up in advance 
(between markers) in the Notes 
field of the Activity window 
(i.e., the contents of a form letter). 

priority box: This is a status 
box on the left of the Account 
List, Contact List, and Events 
Snapshot windows. It lets you 
prioritize your accounts, con-
tacts, and tasks. 

RAM: Random Access Memory. 
The memm-y inside the Macintosh 
that can be directly accessed by the 
computer. RAM is only a tempo-
rary working place while the com-
puter is on. 

records: Information that you 
enter in C.A.T. is stored as 
records, one for each account, 
contact, activity, and event. 

recur: To schedule a periodic 
event indefinitely into the future 
(e.g. monthly staff meeting). 

references: Symbols that you 
can enter by pressing Hot Keys. 

save: To store information on a 
disk. 

save as: To save a file to disk 
by a different name. 

scroll: To use the scroll bar or 
arrows to view different parts of 
a window's contents. 

scroll box: The white box in a 
scroll bar. When dragged by the 
mouse, it is used to view differ-
ent parts of a window's contents. 

select: To choose an item or 
option. 

sharing: Passing information 
among C.A.T. users and among 
applications. 

size box: A box in the lower 
right corner of windows used to 
resize them by dragging with the 
mouse. 

to-do box: This is a status box 
in C.A.T. to let you distinguish 
completed (done) tasks and 
those still "to do." 

view: A list of accounts or con-
tacts that you create to organize 
and display data on-screen. 
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window: Windows display 
information for you to view. 
Windows can be opened, closed, 
resized, and moved around on 
the screen. 

work box: The work box (on 
the left of the Account List, 
Contact List, and Events 
Snapshot windows) is checked 
automatically by C.A.T. when 
you work with an account or 
contact. All work-box checks 
disappear when you save to disk. 

zoom: When you click on a 
highlighted record in a list win-
dow, you zoom from one level 
of detail to the next (i.e., a win-
dow opens displaying further 
information about the highlight-
ed record). 
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. .:S.e Next button 
~_,-~0£. ~ 

' ''·· See'Goto arrow 
1:;'1 ,, See Recur f s,, Events Snapshot 

See Dial . m See calculator 

Legend: Bold for Commands 

-A-
About C.A.T. 2-1 
Account List 5-35, 2-7 

copying records 5-9 A-7 
deleting records 5-12 
finding records 3-1, 5-20 
naming view 3-3 5-48 
printing 4-13, 5-3 
selecting view 3-2, 2-8 
sorting 4-14 
views 3-1, 2-8 
zooming 2-6, 2-9 

Account Lists (Edit) 5-17 
setting options 4-13 

account record 
address field 5-24, 2-18 

' alias field 5-24, 2-18 
.·~eqmpanies 5-24, 2-18 

Miadwiduals 5-24, 2-18 
. ,,., ... 2-19 
,.c .... S-24 
_,. fields 3-16 , 5-25 
eoaatof 5-44 
dellltition of 2-4 

.• ...... S-25 
ditp)aying 2-5, S-35 

entering 2-16 
finding 2-6 
lookup codes See Codes 
name field 5-23 
note field 5-24 
phone number field 5-23 
searching 2-6 
views 3-2 

Action Menu 5-45 
Activity Class 5-29 

choosing 2-12, 3-21 
naming 3-24 

Activity List 5-43 
classes 3-21 
copying records 5-9 
deleting records 5-12 
printing 4-28 
zooming 2-10 

activity record 
alias field 5-29 
changing 3-25 
class buttons 5-29, 3-24 
creating 2-20, 3-25 
count of 5-44 
definition of 2-4 
deleting 5-25 
description field 5-30 
entering 3-25 
finding 2-12 
linking 2-12 
note field 5-30 
preset rate 3-34, 5-32 
preset tactics 3-32, 5-31 
preset text 3-25 
searching 2-6, 2-9 
tactics See Tactics 
types 3-21 

addition 3-46 
aliases 

account 5-24 
activity 5-30 

Index 1-1 



contact 5-27 
search using See Preferences 

aligning See report format 
amounts 

in Amount field 3-34 
in Note field 3-44 

and operator 3-7 
appending files See import 
arithmetic functions 3-46 
arrow, Goto 2-6, 5-25 
at@ Symbol 3-46 
auto-dial See Dial 
automatic entry 

activity 3-35, 5-13 
codes 3-18, 5-13 

-B-
backing up data 1-2 
Backup Disk 1-2 
billable time See elapsed time 
boilerplate text See preset text 
brackets {} A-5 
buttons 

Goto 2-6 
Last 3-42 
Next 3-42 

-C-
calculator 3-39 

button 5-22, 3-44 
Cale 5-22 
formula 3-46 
totals in Note field 3-45 

Calendar 5-42 
current date 3-39 
using 2-13 , 3-39 
Today button 5-42 
zooming 2-10, 5-42 

Calendar Options 5-15 
setting options 4-16 

cancel 

1-2 

macros 5-11 
Merge 5-50 
Print 5-3 

printing in progress See 
Command. (period) 

changing 
accounts 2-19 
activity classes 3-24 
activity 3-25 
activity tactics 3-32 
contacts 2-20 
events 3-42 
filenames E-1 
lookup codes 5-33 
preset text 3-29 
status of events 5-22 
views 3-3 

check mark 3-3 
clairvoyant fields 2-16, 5-23 

definition 2-7, 2-10 
linking 2-12 
searching 2-6 

Clear 5-12 
Clear button 

in Account 5-24 
in Activity 5-30 
in Contact 5-27 
in Event 5-22 
in Make View 3-5 
in Set Format 5-6 

clearing 
current view 3-5 
work view 3-3 

clipboard A-5 
Clone Events 5-52 
Cloning 3-30 

max events per day 5-53 
Close Box 2-7 
code records See Lookup Table 

changing 5-33 
count 5-44 
deleting 5-32, 3-16 
entering in Account 3-16 
entering in Contact 3-16 

Codes> 5-25, 3-14 
color 3-5, 3-41 
column headings 4-13, 4-3 

Index 

column width 5-6 
combining information See 

import, export 
Command-. (period) 2-21, 3-25 
company name and address 

printing 4-1 
setting yours 5-33 

comparison operators 3-7 
converting 

database A-8 
spreadsheet A-10 
word processor A-9 

Contact List 
copying records 5-9 
deleting records 5-12 
selecting account 2-9 
printing 4-13 
zooming 2-9 

contact record 
account link 2-19, 5-24 
adding to views 3-4 
alias field 5-27, 2-19 
changing 2-20 
clearing 5-27 
code fields 3-15, 5-25 
count of 5-44 
definition of 2-4 
deleting 5-28 
displaying 2-9 
entering 2-19 
finding 2-9 
lookup tables See codes 
mail stop field 5-26 
name field 5-26, 2-19 
note field 5-26, 2-19 
phone extension field 5-26, 

2-19 
removing from views 3-3 
salutation buttons 5-27 
searching 2-9 
title field 5-27 
views 3-2 

country codes 3-14 
Copy 5-12 



-9 

ew ... 

-7 
-7 
2-23 

.T A-8 
A-10 

r A-9 

w 2-8, 3-3, 3-11 
3-5 

... ·• r size 5-4 
· · S-12 

.))... . 

damaged files E-1 
database S-1 
•entry field 2-16 
•range 

setting 3-39 
118ing 3-39 .. 

;.:. · •to-entered 4-24 
current on Calendar 5-20 
on events 5-20, 3-39 
selecting on Calendar 2-13 

. "t:r .today'~ date 2-23 
{--button 
" accounts 5-25 

~, . .ccivides 5-30 
S-32 

5-28 
5-22 

' s 3-45 

-E-
early bird 5-13 
echo fields 2-16 
Edit Menu 5-9 
elapsed time 3-48, 5-22 
Enter Menu 5-19 
entering 

accountcodes 5-25 
accounts 2-18 
activities 2-20 , 3-25, 5-30 
amounts 3-24 
contact codes 3-27 
contacts 2-19, 5-26 
events 2-23, 5-19, 5-22 
preset rates 3-24 
preset tactics 3-32 
preset text 3-25 

entry window 2-5 
equipment 1-1 
event list See Events Snapshot 
Event List Options 5-15 

setting options 4-14 
event record 2-11 

activity field 5-21 
amount field 5-22 
changing 3-42 
cloning 5-52 
contact field 5-20 
count of 5-44 
date field 5-20, 3-39 
definition of 2-4 
deleting 5-22 
displaying 3-42, 2-11 
Done button 5-22 
entering 2-23 
finding 3-42 
linking 2-12 
note field 5-21 
posting See Enter 
Push 5-22 
recurring 3-50, 5-21 
status of 3-41 
time field 5-20 
to-do status 3-41 
XCHG 5-22 
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Events Snapshot 3-39 
copying records 5-9 
deleting records 5-22 
printing 3-40, 4-21 
selecting events 3-40, 2-10 
zooming 2-12 

exact match(=) 3-7 
example files See Sample Files 
Excel A-2 
exchanging data See import, 

export 
exiting C.A.T. 5-7 

saving 5-2 
without saving data 5-7 

export data A-9, 5-9 

-F-
field 

file 

address 5-24,2-18 
changing 2-19 
city 5-24, 2-18 
code 5-25 
computed 3-45 
copying, see Copy 
country 3-14 
date 2-13 
deleting See Cut 
font See report format 
state 5-24, 2-18 
text 2-21, 3-28 

closing See Open, New 
opening 5-2 
quitting 5-7 
saving 5-2 

file conversion See Import 
File Menu 5-1 
filenames 5-1 
files 

1-4 

data 1-1 
existing 2-15 
new 5-1 
note E-1 
program 1-1 

find 
account 5-23 
activity 5-30 
contact 5-26 
event See Events Snapshot 

follow-up activities See Tactics 
fonts See also Set Format 

on LaserWriter 4-2 
on reports 4-2 

form letter 
creating 3-29, 2-24, 5-28 

See also New Form Letter 
using 2-21 , 3-29 

formatting reports See report 
format 

formulas 3-46 

-G-
greater than (>) 3-7 
greater than or equal to (>=) 3-7 
Goto button 

definition 2-6 
use 5-21 

-H-
hardware requirements 1-1 
hard disk 1-2 
help: 408-246-8020 
Help See under Apple Menu 
hiding records 3-41 
highlighting 2-7 
hot keys B-1 

-1-
ImageWriter 4-2 

labels 1-1, 4-2 
draft mode 4-2 

import 5-11, A-1 
index 1-1 
installation 1-2 

-J-
joining files A-8 
justification See report format 

Index 

-K-
keyboard commands D-1 

-L-
labels 4-11 
Label Options 4-11, 5-18 
landscape printing See Page 

Setup 
LaserWriter 4-2 
less than ( <) 3-7 
less than or equal to(<=) 3-7 
Letter Options 4-24, 5-16 
letters 

batch printing 3-31, 4-24 
form letter 2-21 
options 4-24 
printing one 4-24 
printing Today's only 3-31, 

4-24 
standard letter 3-28 

linking 2-12, 3-17 
List windows 2-5 
loading 

C.A.T. 2-15 
existing files 2-15 
new files 2-15 
Quick Start file 2-15 
Sample file 2-3, 5-2 

Lock 5-45, 5-34 
logical operators 3-7 
logo C-1, 4-1, 5-33 
lookup codes See Codes 
Lookup Table 5-32 

accountcodes 3-14,5-32 
contact codes 3-14 
copying records 5-9 
count of 5-44 
deleting codes 3-16, 5-12 
naming table 3-16, 5-32 
printing 4-27 
searching on See Make View 

-M-



Macro 
See labels 

~-54 
3-30 

,:-- 3-30 
V•c ;~,f ....... &CCOUnt list 3-30 
· .. • .. · "',,._.. power marketing 3-51 

...._ View 5-48 
button 3-5 
eumples 3-6 , 3-11 

memory available 5-44 
memos 

options 4-24 
printing 3-3 , 4-24 

merge files A-8, 3-9 
merge print See mail merge 
Merge Views 3-9 to 3-13 

example 3-42 
modes 3-9 
modifiers 

and 3-7 
not equal to 3-7 

month function 3-39 
multiple files E-1 
multiply 3-46 

-N-
Naae View 5-48, 3-2 
aetworkA-1 
New Account 5-23 
New Activity 5-29 

· t(-;C.tact 5-26 
Effllt 5-19 
POl'ID Letters 5-28 
'S-1 

5-24 
dow 5-30 

. w 5-27 
. 5-21 
3-31, 4-24 

notes file E-1 

-0-
on-screen Reports 4-5, 5-4 
Open 5-2 
operators 3-7 

options (print) 
account 4-13 
calendar 4-16 
dossier 4-6 
event list 4-14 
labels 4-11 
letter 4-24 

Options 5-33 
company address 5-33 
company name 5-33 
logo type C-1, 4-1, 5-33 
user name 5-33 
user password 5-33 

orders 3-47 

-P-
Page Setup 5-4 
Password 5-33 

user 5-33 
system 5-34 

Paste 5-12 
phone number 

on Account window 5-23 
on Contact window 5-26 
on Event window 5-20 

Pop button 5-22 
posting See entering 
power marketing 3-51 
Preferences 5-13, 2-17 
preset rates 3-34 
preset tactics 3-32 
preset text 3-25 

changing 2-24 
markers 2-21, 3-25 
references 3-27, B-1 
text blocks 2-21, 3-25 

primary activity 3-32, 5-31 
Print 5-3 
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font, size & style 4-3 
options 4-4 
reports 4-13 
to screen 4-5 

printing 
cancelling 4-5, 4-2 
form letter in batches 3-31, 

4-24 
problems 4-5 
reports See reports 
starting with current account 

5-14 
starting with current event 

5-14 
program file 1-2 
priority 3-3, 3-40 
projects 3-22 
Push 5-22 

-Q-
quotations 3-47 
Quit 5-7 

-R-
RAM 5-44 
range( .. ) 3-7 
rate 3-34 
Recur button 3-50, 5-21 
ratio 3-34, 5-31 
recurring events 3-50 

cancelling 5-21 
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